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Notice

The information contained in this document is subject to change without
notice.

Hewlett-Packard makes no warranty of any kind with regard to this mater
including, but not limited to, the implied warranties of merchantability and
fitness for a particular purpose. Hewlett-Packard shall not be liable for err
contained herein or for incidental or consequential damages in connectio
with the furnishing, performance, or use of this material.

Hewlett-Packard assumes no responsibility for the use or reliability of its
software on equipment that is not furnished by Hewlett-Packard.

This document contains proprietary information which is protected by
copyright. All rights are reserved. No part of this document may be
photocopied, reproduced, or translated to another language without prio
written consent of Hewlett-Packard Company.

Restricted Rights Legend

Use, duplication, or disclosure by the U.S. Government is subject to
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technic
Data and Computer Software clause at DFARS 252.227-7013 for DOD
agencies, and subparagraphs (c)(1) and (c)(2) of the Commercial Comp
Software Restricted Rights clause at FAR 52.227-19 for other agencies.

Hewlett-Packard Company
Santa Rosa Systems Division
1400 Fountaingrove Parkway
Santa Rosa, CA 95403-1799, U.S.A.

Microsoft® and Windows NT® are U.S. registered trademarks of Microso
Corporation.

© Copyright Hewlett-Packard Company 1999
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Warranty

Certification Hewlett-Packard Company certifies that this product met its published
specifications at the time of shipment from the factory. Hewlett-Packard
further certifies that its calibration measurements are traceable to the
United States National Institute of Standards and Technology (NIST,
formerly NBS), to the extent allowed by the Institute’s calibration facility,
and to the calibration facilities of other International Standards
Organization members.

Warranty This Hewlett-Packard system product is warranted against defects in
materials and workmanship for a period corresponding to the individual
warranty periods of its component products. Instruments are warranted f
period of one year. During the warranty period, Hewlett-Packard Compa
will, at its option, either repair or replace products that prove to be defect

Warranty service for products installed by HP and certain other products
designated by HP will be performed at Buyer’s facility at no charge within
HP service travel areas. Outside HP service travel areas, warranty servic
will be performed at Buyer’s facility only upon HP’s prior agreement and
Buyer shall pay HP’s round trip travel expenses. In all other areas, produ
must be returned to a service facility designated by HP.

For products returned to HP for warranty service, Buyer shall prepay
shipping charges to HP and HP shall pay shipping charges to return the
product to Buyer. However, Buyer shall pay all shipping charges, duties, a
taxes for products returned to HP from another country.

HP warrants that its software and firmware designated by HP for use with
instrument will execute its programming instructions when properly
installed on that instrument. HP does not warrant that the operation of th
instrument, or software, or firmware will be uninterrupted or error free.

LIMITATION OF WARRANTY. The foregoing warranty shall not apply
to defects resulting from improper or inadequate maintenance by Buyer,
Buyer-supplied software or interfacing, unauthorized modification or
misuse, operation outside of the environmental specifications for the
product, or improper site preparation or maintenance.

NO OTHER WARRANTY IS EXPRESSED OR IMPLIED. HP
SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OR
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
HP E7415A Measurement Guide iii
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EXCLUSIVE REMEDIES. THE REMEDIES PROVIDED HEREIN ARE
BUYER’S SOLE AND EXCLUSIVE REMEDIES. HP SHALL NOT BE
LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, OR
CONSEQUENTIAL DAMAGES, WHETHER BASED ON CONTRACT,
TORT, OR ANY OTHER LEGAL THEORY.

Assistance Product maintenance agreements and other customer assistance agree
are available for Hewlett-Packard products.

For assistance, call your local Hewlett-Packard Sales and Service Office
(refer to “Service and Support”).
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Service and Support

Any adjustment, maintenance, or repair of this product must be performe
by qualified personnel. Contact your customer engineer through your loc
HP Service Center. You can find a list of HP Service Centers on the web
http://www.tmo.hp.com/tmo/contacts/English/servicecenters.html

If you do not have access to the Internet, one of these HP Centers can d
you to your nearest HP representative:

United States: Hewlett-Packard Company
Test and Measurement Call Center
PO Box 4026
Englewood, CO 80155-4026
(800) 452 4844 (toll-free in US)

Canada: Hewlett-Packard Canada Ltd.
5150 Spectrum Way
Mississauga, Ontario L4W 5G1
(905) 206 4725

Europe: Hewlett-Packard European Marketing Centre
Postbox 999
1180 AZ Amstelveen
The Netherlands
(31 20) 547 9900

Japan: Yokogawa-Hewlett-Packard Ltd.
Measurement Assistance Center
9-1, Takakura-Cho, Hachioji-Shi
Tokyo 192, Japan
(81) 426 56 7832
(81) 426 56 7840 (FAX)

Latin America: Hewlett-Packard Latin American Region Headquarters
5200 Blue Lagoon Drive, 9th Floor
Miami, Florida 33126, U.S.A.
(305) 267 4245
(305) 267 4288 (FAX)

Australia/New Zealand: Hewlett-Packard Australia Ltd.
31-41 Joseph Street
Blackburn, Victoria 3130
Australia
1 800 629 485 (toll-free)

Asia-Pacific: Hewlett-Packard Asia Pacific Ltd.
17-21/F Shell Tower, Times Square
1 Matheson Street, Causeway Bay
Hong Kong
(852) 2599 7777
(852) 2506 9285 (FAX)
HP E7415A Measurement Guide v
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Guard your Data

WARNING The WARNING notice denotes a hazard. It calls attention to a procedure, 
practice, or the like, that, if not correctly performed or adhered to, could result 
in loss of important data. Do not proceed beyond a WARNING notice until the 
indicated conditions are fully understood and met.

CAUTION TheCAUTION notice denotes a hazard. It calls attention to an operating
procedure, practice, or the like, which, if not correctly performed or adher
to, could result inincorrect measurement results or loss of data. Do not
proceed beyond aCAUTION notice until the indicated conditions are fully
understood and met.
vi HP E7415A Measurement Guide
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Typeface Conventions

Italics • Used to emphasize important information:
Use this softwareonly with the HP xxxxxX system.

• Used for the title of a publication:
Refer to theHP E7415A Measurement Guide.

User Entry • Used for examples of programming code:
#endif // ifndef NO_CLASS

Path Name • Used for a subdirectory name or file path:
Edit the file usr/local/bin/sample.txt

Computer Display • Used to show messages, prompts, and window labels that appear on
computer monitor:

The Edit Parameters window will appear on the screen.

• Used for labeled keys on computer keyboard or for text you will enter
using the computer keyboard:

PressReturn .

• Used for menus, lists, dialog boxes, and button boxes on a computer
monitor from which you make selections using the mouse or keyboar

Double-clickEXIT to quit the program.

• Used to specify a filename:
Selectfilename and pressOK.
HP E7415A Measurement Guide vii
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1 Introduction

This Guide has been written to assist you in designing products that mee
current international emissions standards at a precompliance level.

The Role of
Precompliance in the
Product Development
Cycle

Strict compliance standards for electromagnetic emissions are now appro
throughout most of the world. Designing a product to meet these standar
does not need to greatly increase your costs as long as you design your
product with these standards in mind.

It is important to have a strategy that will help you test for potential EMI
problems throughout the product development cycle, as well as equipme
and processes in place that will allow you to observe how close you are t
compliance at any given time in the development cycle.

The processes described in this Guide are designed to help identify EMI
problems during all phases of product development and to provide an
inexpensive way to test for compliancebeforeyou start the much more
costly, final compliance testing.
HP E7415A Measurement Guide 1-1
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How to Use This
Manual

This guide contains flowcharts and associated procedures for making
conducted and radiated precompliance measurements. It is recommend
that you use the flowcharts as a guide to making typical measurements.
Refer to the sections within each chapter for detailed explanations on
performing the flowchart procedures.

NOTE The order of the sections within each chapter follow the flowcharts.

Included within this guide are the following chapters outlining measureme
procedures:

• Chapter 2, “Conducted Emissions Example” – Step-by-step procedu
for setting up and performing precompliance conducted emissions
measurements.

• Chapter 3, “Radiated Emissions Example: Shielded Room” –
Step-by-step procedures for setting up and performing precomplianc
radiated emissions measurements in a shielded room environment.

• Chapter 4, “Radiated Emissions Example: Open Area Test Site” –
Step-by-step procedures for setting up and performing a compliance
precompliance radiated emissions measurements on an open area t
site.

In addition, the following chapters are included to serve as a reference fo
particular tasks, terminology, and regulations:

• How Do I...?

• Glossary of EMC Terms

• Appendix A, Determining your Regulation Requirements

The HP E7415A EMI Measurement Software is shipped with the followin
documentation:

• Getting Started Guide

• HP E7415A Measurement Guide

• Online Quick Tour (found in the HP E7415A software under the Help
menu)

• Online Help System (found in the HP E7415A software under the He
menu)
1-2 HP E7415A Measurement Guide
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2 Conducted Emissions Example

In This Chapter…

• Conducted Process Flow Chart, page 2-3
Shows the process flow for typical conducted emissions measureme

• Configure Test Equipment, page 2-6
Describes the physical layout of test equipment and the EUT

• Select Test Setup, page 2-9
Explains the process for opening test setups

• Modify Setup, page 2-11
Lists the test setup parameters associated with each test setup
(equipment setup, signal path definition, signal list setup, etc.) and
points to procedures to modify parameters

• Determine Receiver Settings, page 2-13
Explains the procedure to preview the EUT conducted emissions and
look for IF and RF overload conditions

• Gather EUT Signals Using the Peak Detector, page 2-23
Explains the process to generate sweep traces

• Create EUT Frequency List, page 2-29
Explains the procedure to create a signal list (peak detected signals
meet a user-defined criteria) from the traces

• Measure Process, page 2-31
Explains the procedures for making quasi-peak (and average)
measurements

• Save Test Data, page 2-34
Explains the procedure to save test setups and test data
HP E7415A Measurement Guide 2-1
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This chapter presents an example of how to prepare for and execute a
conducted emissions test, create a report, and save the data.

Conducted emissions testing focuses on signals present on the power m
and signal paths that are generated by the EUT (equipment under test).
conducted signals are measured with a regulatory-defined transducer, a
LISN (line impedance stabilization network).

A common source of conducted emissions are switch-mode power supp
which produce both narrowband and broadband signals, the former from
switching frequency, the latter from the sharp rise and fall of the switch.
Conducted emissions from these types of sources usually are highest in
lower end of the 150 kHz to 30 MHz band.

The regulatory limits specify the maximum EUT emission amplitudes
expressed as the voltage (dBµV) measured on predefined lines. Two types o
detectors are defined for measurements: Quasi-Peak and Average. The
applicable regulation specifies the limits and the detector associated with
limit. (Some regulations specify a Quasi-Peak and Average limits, others
specify a Quasi-Peak limit only.)

Conducted emissions measured byeach detector must be below the
corresponding limit. The frequency range for these measurements is
typically 150 kHz to 30 MHz.

Metallic surfaces near the EUT will introduce coupling effects which vary
test results. Therefore, the regulations also specify the physical layout of
test setup including separation distance of the test items, non-metallic ta
and vertical conductive surface behind the EUT setup.

A typical layout for desktop devices is shown in Figure 2-1.
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Figure 2-1 Desktop Setup for Conducted Emissions Testing

Conducted Process
Flow Chart

Figure 2-2 on page 2-4 is a flow chart that shows the process for making
measurement of conducted emissions.

The sections within this chapter closely follow the flowchart.
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Figure 2-2 Precompliance Measurement of Conducted Emissions
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Determine Applicable Regulations

Determine the regulations to which you must comply.

For more information on EMC regulations and determining which
regulations apply to your measurement, see Appendix A, “Determining yo
Regulation Requirements”.
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Configure Test Equipment

The equipment used in the test is configured according to regulatory
requirements, such as EN55022 Class B. Refer to the applicable regulat
for specific configuration information. The regulation typically specifies th
test environment, receiver characteristics, and transducer characteristics
compliance test. If you do not know what regulation is applicable for you
product, see Appendix A, “Determining your Regulation Requirements”.

The EUT is normally exercised in a way that represents its typical usage,
interconnect cables, if they are present, are oriented to maximize the
emissions.

The basic configuration for a commercial conducted emissions measurem
consists of a PC with the HP E7415A software, a Line Impedance
Stabilization Network (LISN), a transient limiter (optional), cables, and a
receiver. The EUT receives its power through the LISN and any conducte
emissions from the EUT are routed to the receiver by the LISN.

Typical Equipment

Equipment Type

PC with the HP E7415A software See HP E7415A Getting Started Guide or the 
readme.txt file for PC requirements.

Receiver HP 85422E

HP 8542E

HP 85462A

HP 8546A

HP 859xEM

HP E740xA

HP-Simulator (included with the E7415A 
software used to simulate test data)

Transient Limiter HP 11947A

Line Impedance Stabilization Network (LISN) HP 11967C

HP 11967D

HP 11967E

Cables  As Needed
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Figure 2-3 illustrates the basic test configuration for conducted emission
testing.

Figure 2-3 Basic Conducted Emissions Test Configuration

Equipment Setup

CAUTION To prevent damage to the receiver from power line switching transients:

• Disconnect the receiver input (from the LISN or current clamp output
prior to connecting or disconnecting the mains to the EUT or prior to
turning the EUT on or off, or prior to placing a current clamp around a
EUT mains.

• If you are using a switchable LISN, disconnect the receiver input (from
the LISN output) prior to switching the LISN between lines.

WARNING For your safety, the LISN should be adequately earth grounded. Large leakage 
currents flow through the internal filter capacitors causing a potential shock 
hazard. To prevent injury, follow all precautions provided by the manufacturer 
of the LISN.

TRANSIENT
LIMITER

Power to EUT

EQUIPMENT
UNDER TEST

comcond

LINE IMPEDANCE
STABILIZATION NETWORK
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Power
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RECEIVER
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Connect the equipment as follows:

About the LISN The LISN performs several important functions.

• It helps filter incoming power from the ac mains and prevents any no
on the lines from reaching the EUT.

• It routes conducted emissions from the EUT to the receiver.

• It presents a defined 50-Ω impedance to the receiver, allowing calibrate
measurements.

• It allows you to measure both the EUT line and the neutral lines
independently.

About the Limiter During conducted emissions testing, a transient limiter can protect the
receiver input from damage caused by high-level transients from line
impedance stabilization networks (LISNs) or current clamps. Some receiv
have limiter diodes placed before the first converter and the preamp to h
protect both elements.

To provide additional protection to the receiver’s input when performing
conducted emissions, the use of an external (HP 11967A) transient limite
strongly recommended.

Procedure Comment

1 Connect the power cord of the EUT to the 
LISN.

The LISN provides a known RF impedance 
(50 Ω) to any emissions from the EUT.

2 Connect the LISN to the power mains 
supply.

3 Connect the emissions output port of the 
LISN to the transient limiter.

The LISN emissions output port is often labeled 
with “Monitor” or “50 Ω”.

4 Connect the r eceiver INPUT to the 
transient limiter
2-8 HP E7415A Measurement Guide
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Select Test Setup

Common test setups have been included with the HP E7415A applicatio
When you first open the application theNew Test: Select a Test Setup dialog box
appears, allowing you to select the regulation to which you normally test

After you have selected a test setup, limit lines for the selected regulation
displayed on the graph.

Selecting a Test Setup To select a predefined or previously saved test setup follow these steps:

Procedure 2-1 How to Select a Test Setup

Step Procedure Comments

1 Open the Select Test 
Setup dialog box.

• Open the HP E7415A application.

OR

• If the application is currently open, from the main 
menu, click File > New.

• Select New  to open an existing test setup without data. 

• Select Open  to open an existing test setup and data. 

2 Select a set of 
compliance regulations

1 From the Folder:  combo box, select the desired 
regulation folder.

2 Select the regulation to which to test.

3 Click OK.

• There are various folders under which are related 
compliance regulations, for example EN 55022 Test 
Setups .

• For example, EN 55022 Class B C onducted .
HP E7415A Measurement Guide 2-9
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Does Setup Require Modification?

Determine if the selected test setup requires modification for your particu
test equipment (receiver, LISN, cables, limiters, etc.), limit line definitions
and ambient list. To view the test setup by selectSetup > Show Setup .

A test setup is composed of the software settings required to perform a t
These software settings include items like limit lines, equipment to be us
correction factors, band settings and report output (see “Test Setup
Parameters” on page 2-11 for a more comprehensive list). The software
comes with several example test setups.

NOTE The most common modifications involve editing equipment setup
information, such as the equipment used in a test and associated correc
factors. Note that the default equipment setup information contains
characteristic correction factors for common test equipment. You will wan
to modify these correction factors or create new ones for your specific
equipment for greatest amplitude accuracy.

If your test setupdoesrequire modification, continue to “Modify Setup” on
page 2-11 which includes a complete list of the modifiable test setup
parameters.

If your test setupdoes notrequire modification, skip to “Configure Test
Equipment” on page 2-6.

The following test setup parameters are particularly important, dependin
upon your test equipment and applicable regulations:

• Limit Lines

• Signal Path (equipment selected including corrections)

NOTE The active signal path (including correction factors) within the HP E7415
application must correspond to your physical test equipment layout.

• Equipment Corrections

• Graph Settings

• Signal List Settings (list columns)

• Receiver Settings (for Sweep and Measure)
2-10 HP E7415A Measurement Guide
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Modify Setup

The HP E7415A application comes with several example test setups. Th
test setups can be modified to meet your specific test requirements. As a
option, you can create a new test setup by defining the required test
equipment, limit lines, and ambient list.

Test setups can be saved for future use (see “Saving Test Setups” on
page 2-12). Test setups may be added to an existing test setup folder or i
newly created test setup folder.

Steps for Modifying Test Setups

The following are the general steps for modifying an existing test setup:

1. Select a test setup (see “Selecting a Test Setup” on page 2-9)

2. Determine if the selected test setup meets your requirements (see “D
Setup Require Modification?” on page 2-10)

3. Modify the test setup as necessary (see appropriate Chapter 5, “How
I...?” procedure)

4. Save the modified test setup (see “Saving Test Setups” on page 2-12

Test Setup Parameters

When creating a test setup you may change and save the following
parameters to accommodate your specific test needs or requirements (re
to Chapter 5, “How Do I...?”, at the indicated page number for applicable
“Customize Graph and Trace Data” on page 5-57modification procedure

• Limit Lines
See “Use Limit Lines” on page 5-7

• Equipment Setup
See “Add and Setup Test Equipment” on page 5-15

• Signal Path
See “Use Signal Paths” on page 5-25

• Ambient Lists
See “Use Ambient Lists” on page 5-27

• Graph Settings
See “Customize Graph and Trace Data” on page 5-57

• Signal List Settings
See “Customize Signal Lists” on page 5-46
HP E7415A Measurement Guide 2-11
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• Sweep Settings
See “Setup and Perform Sweeps” on page 5-34

• Measure Settings
See “Make Measurements” on page 5-40

• Report Settings
See “Generate Reports” on page 5-44

• Receiver Settings
See “How to Add and Setup a New Receiver” on page 5-16

After modification and saving of test setup parameters, these parameter
become defaults for the associated test setup.

Saving Test Setups To save a test setup follow these steps:

Procedure 2-2 How to Save a New or Modified Test Setup

Step Procedure Comments

Save the test setup. 1 From the menu bar, select File > 
Save As Setup... .

2 In the Save Test Setup  dialog box, select the 
desired folder from the Folder: combo box or 
within the Folder: combo box type a new folder 
name.

3 In the Setup Name:  text box, enter in a name for 
your setup. 

4 (Optional) Enter a description for your test setup 
within the Description:  text box.

5 Click Save.

• The Save Test Setup  dialog box is displayed.

• To later access the new setup, select File > New. 
Select the folder and highlight the setup name, then 
click OK.
2-12 HP E7415A Measurement Guide



Conducted Emissions Example
Determine Receiver Settings

m
and
hen

aved
ns

nts
dent

d.

re
e

er
ath
the
Determine Receiver Settings

The receiver settings will alter the receiver noise floor anddynamic range.

It is important to find the settings that will allow proper testing within the
frequency range of the applicable regulation.

Before measurement sweeps can be taken with the software, the optimu
receiver settings for performing the measurements must be determined
set in the software Several receiver parameters may be set by the user w
performing sweeps with the software. These settings, once set, may be s
within the context of a test setup for easy reuse. The sweep setting optio
are listed below (refer to the How Do I... chapter for definitions):

• Resolution Bandwidth
• Video Bandwidth
• Reference Level
• Attenuation
• Sweep Time
• Segment Size
• Stop/Start Frequencies
• Segment Overlap
• Dwell Time
• Detector (Peak/Quasi-Peak/Average)

Some settings may need to be set according to a regulation’s requireme
(e.g. resolution bandwidth) and some settings may need to be set depen
on the equipment you have in the signal path you are measuring (e.g.
start/stop frequency may depend on a current clamp or LISN’s useful
frequency range).

Noise Floor to Limit
Line Separation

Prior to performing measurements sweeps, you will want to optimize the
receiver settings to obtain the best noise floor to limit line separation (how
far the noise floor is below the limit line) without encountering RF overloa

NOTE When varying attenuation and preamplification, always check to make su
that you do not encounter RF overload with the new settings. Refer to th
manual for your receiver for instructions to check for RF overload.

To do this, you will need to take a sweep with the HP E7415A software to
measure the receiver’s noise floor to limit line separation using the receiv
settings that you wish to use during the EMC test. The software’s signal p
definition should be the same as the signal path that will be used during
test. With the application, the noise floor of the receiver should then be
HP E7415A Measurement Guide 2-13
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measured with the receiver (or external preamplifier if one is defined in th
signal path) terminated.

If the measured noise floor to limit line separation is not adequate, then t
following receiver settings may require modification:

• Input Attenuation
Increasing the attenuation increases the receiver noise floor and
decreases the noise floor to limit line separation.
Decreasing the attenuation decreases the receiver noise floor and
increases the noise floor to limit line separation.

• Reference level
Increasing the reference level in some settings can decrease the limit
to noise floor separation.
Decreasing the reference level in some settings can increase the lim
line to noise floor separation.

• Preamplification with a low noise figure preamplifier (internal or
external)
Adding preamplification decreases the receiver corrected noise floor
increases the noise floor to limit line separation.
Removing preamplification increases the receiver corrected noise flo
and decreases the noise floor to limit line separation.
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Procedure 2-3 How to Check for Adequate Noise Floor to Limit Separation

Step Procedure Comments

1 Setup test equipment. 1 Disconnect the RF input to your receiver.

2 Terminate the RF input on your receiver. • Use the appropriate terminator for your 
receiver.

2 Select the signal path.  Choose the path including all cable loss, 
transducer and receiver corrections.

3 Set the Sweep parameters within the 
HP E7415A software.

1 In the side bar, click the Test  button, then click 
the Sweep  icon.

2 Modify the Start Frequency  and the 
Stop Frequency values if required.

• The Sweep  dialog box can be opened by 
right-clicking the graph area, then 
selecting Sweep.

• The Start and Stop frequencies are 
automatically set to the frequency range 
of the selected regulation, for example 
.15 MHz and 30 MHz respectively. 
The frequency range can be modified to 
meet your specific requirements.

4 Name and define the trace. 1 In the Output Trace  combo box, type a trace 
name (for example, Noise Floor ).

2 Click on the color bar and select a color for the 
trace. 

3 Click OK to close the color palette.
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5 Check noise floor. Run sweep by clicking Run  in the Sweep  dialog 
box.

If the noise floor to limit line separation is not 
adequate go to “How to Adjust Receiver Settings” 
on page 2-17.

If the noise floor to limit line separation is ok go to 
the next step.

6 Note test configuration and receiver 
settings.

1 Note the signal path (for example, is external 
limiter used) and the receiver settings 
(attenuation, reference level and internal 
preamplifier states).

2 Go to “Check for and Remove RF Overload” on 
page 2-21.

• This signal path and receiver settings will 
be used in the next step when checking 
for RF overload.

Procedure 2-3 How to Check for Adequate Noise Floor to Limit Separation (Continued

Step Procedure Comments
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Procedure 2-4 How to Adjust Receiver Settings

Step Procedure Comments

1 Adjusting the receiver settings to 
improve the noise floor to limit line 
separation.

If the noise floor to limit line separation is not 
adequate you may try changing the following:

1 Reduce the receiver input attenuation

• This may be done by changing the attenuation 
setting in the Sweep  dialog box under the 
Receiver Settings  tab.

2 Turn on the internal preamplifier if the receiver 
you are using has one.

• This may be done by checking the
Receiver PreAmp  check box in the Sweep  
dialog box under the Receiver Settings  tab.

3 Lower the receiver reference level setting.

• This may be done by changing the Ref Level 
setting in the Sweep  dialog box under the 
Receiver Settings  tab.

4 Add an external preamplifier.

• Run a new sweep after every change to 
determine its effect on the noise floor. 
When the noise floor to limit line 
separation is adequate, continue to step .

.

• If an external preamplifier is used, an 
external attenuator may also be required 
to check for RF overload.

• Add the external preamplifier (with proper 
correction factors) to the active signal 
path (See “How to Add and Setup a 
Transducer (The procedure is similar for 
any other non-receiver test equipment)” 
on page 5-18).

2 Note test configuration and receiver 
settings.

Note the signal path (for example, is external 
preamplifier used) and the receiver settings 
(attenuation, reference level and internal 
preamplifier states).

• This signal path and receiver settings will 
be used in the next step when checking 
for RF overload.
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NOTE It may be necessary to segment the frequency range of the applicable

regulation (performing multiple sweeps) to adequately adjust for noise flo
and overload conditions.
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Preview EUT Emissions

It is recommended that you preview the EUT emissions prior to beginning
EMI test. This allows you to determine quickly whether or not there are
obvious areas of failing emissions that may need to be addressed, and if
receiver sweep settings are set appropriately.

Previewing emissions also provides a way to vary the operating state of
EUT and EUT cable orientations to determine which states or orientation
may cause emission levels to increase.

Use the following procedures to preview EUT emissions:

1. Preview the EUT emissions

2. Detect and correct overload conditions

NOTE Refer to the appropriate User Manual for your receiver as needed.

Procedure 2-5 How to Preview Radiated EUT Emissions

Step Procedure Comments

1 Disconnect receiver INPUT from 
LISN.

• Disconnect the receiver INPUT from the 
transient limiter or LISN.

• Caution: Failure to carry out this step 
may result in damage to the receiver.

2 Connect EUT to LISN and turn EUT 
power On.

• Connect the EUT to the LISN and then turn EUT 
power On.

• This step should be carried out with the 
receiver disconnected.

3 Select signal path. Choose the active signal path from the Signal Path  
drop down box in the Receiver  tool bar.

• Click View > Tool bar > Receiver Bar  to 
enable the Receiver Bar.

4 Set up the receiver. 1 Connect receiver INPUT to the transient limiter 
or LISN output.

2 Set the Receiver in Local mode by clicking L on 
the Receiver Bar (top right-hand corner).

3 Set the receiver frequency range to the 
operating range for the signal path.

• Clicking L sends the total signal path 
correction and the active limit lines to the 
receiver.

5 View EUT emissions. 1 Vary the operating state of the EUT while 
monitoring the receiver display, to determine 
which EUT state to use for your test.

2 Set the receiver preamplifier state, reference 
level, and attenuation level as noted in the 
“Determine Receiver Settings” process.

6 Check for RF overload. 1 Check for RF overload conditions.

2 Correct for RF overload if necessary.

3 Note the receiver settings; these will be used as 
the initial receiver settings during the following 
measurements.

• See Check and Remove RF Overload on 
page 3-18 for more information on 
detecting and correcting overload 
conditions.
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7 Display the receiver trace data in the 
E7415A graph area.

• From the Application Test menu, select 
Get Receiver Trace.

• Tip: You can also simply click the Get 
Receiver Trace icon in the Receiver Bar.

8 Check for obvious failing emissions. 1 Compare the signal levels with the limit line on 
the HP E7415A graph or directly on the receiver.

2 If there are obvious failing signals go to 
“Generate Reports” on page 5-44.

3 If all signals are below the limit line, go to 
“Gather EUT Signals Using the Peak Detector” 
on page 2-23.

• If prescanning emissions directly on the 
receiver, it may be useful to enable 
Max Hold on the receiver trace.

Procedure 2-5 How to Preview Radiated EUT Emissions

Step Procedure Comments
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Check for and Remove
RF Overload

Since ambients are not present in a shielded room, high-level EUT emiss
are the most common cause of RF overload.

Overload Conditions

Some signals within the measured frequency span may cause an overlo
condition. Prior to making measurements, determine that the receiver is
in an RF overload condition.

RF Overload Detection and Correction

RF overload occurs when the energy level at the input mixer of the receiver
exceeds the mixer’s linear operating range. This means that the mixer is
compression, which can cause amplitude measurement errors.

NOTE Refer to the appropriate User Manual for your receiver as needed.

Procedure 2-6 How to Identify and Remove RF Overload Conditions

Step Procedure Comments

1 Set up the receiver. 1 Set the receiver in Local mode by clicking L on 
the receiver toolbar.

2 Set the frequency range of the receiver.

3 Set the receiver ref level, attenuation, 
preamplifier enable, etc. as noted in the 
“Determine Receiver Settings” on page 2-13.

• The receiver is put into local mode and 
continuous sweep. The trace is corrected 
for the active signal path, and the limit line 
is displayed. This allows the user to 
interact directly with the receiver.

• Set to the frequency range of the 
regulation to which you are testing.

• Refer to appropriate hardware manual.

2 Determine if the receiver is in 
overload condition.

Refer to receiver manual.

3 Remove the RF overload. If an RF overload exists, remove the RF overload 
(usually by increasing the receiver’s input 
attenuation) and record the revised settings. 
Refer to receiver or analyzer manual.

 

4 Change sweep and measure receiver 
settings.

Enter revised settings into sweep and measure 
dialog box receiver settings.

• See “Setup and Perform Sweeps” on 
page 5-34 and “Make Measurements” on 
page 5-40.
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Recheck Noise Floor After correcting for RF overload conditions, recheck the noise floor to
ensure that the noise floor to limit line separation is adequate.
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Gather EUT Signals Using the Peak Detector

In this section, the analyzer’s peak detector is used to measure the EUT
emissions over a user-specified frequency range. An emission trace is th
displayed on the applications graph window.

This graph of EUT emissions, measured using the peak detector, may be
final result in a compliance or precompliance EMI measurement process
all of the signals measured are below the appropriate limit line.

In this step you will develop a graph of the EUT emissions from a single
LISN output line.

The following equipment is used in this example:

• E7415A EMI Measurement software

• HP E7400A-Series EMC Analyzer

• HP 11970D (10A) LISN

• HP 11947A Transient Limiter
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Procedure 2-7 How to Gather EUT Signals

Step Procedure Comments

1 Connect the LISN output line. • Connect the LISN output line to be measured, to 
the receiver INPUT.

• To prevent damage to the receiver, 
remember to obey the CAUTION outline 
in “Configure Test Equipment” on 
page 2-6.

2 Adjust the graph reference level. 1 Double click the graph to open the 
Graph Settings  dialog box.

2 Set the graph reference level and Start/Stop 
frequencies to those determined during the 
procedure “Preview EUT Emissions” on 
page 2-19.

3 Click OK to close the Graph Settings  dialog 
box.

• The Graph Settings dialog box can be 
opened from the menu bar 
(Setup > Graph Settings)

• Graph Settings  and Title  can be 
modified after the sweep has been taken 
for improved appearance.
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3 Set the Sweep parameters. 1 In the side bar, click the Test  button, then click 
the Sweep  icon.

2 Modify the Start Frequency  and the 
Stop Frequency  values if required.

3 Set Dwell for  to 1 sweep.

• The Sweep  dialog box can be opened by 
right-clicking the graph area, then 
selecting Sweep.

• The Start and Stop frequencies are 
automatically set to the frequency range 
of the selected regulation, for example 
0.15 MHz and 30 MHz respectively. 
The frequency range can be modified to 
meet your specific requirements.

• Tip: Increase the Dwell for  values to 
capture intermittent signals or signals with 
slow cycle times. For example if the EUT’s 
operating state has a 10 second cycle 
time, set Dwell for  to >10 seconds.

Procedure 2-7 How to Gather EUT Signals (Continued)

Step Procedure Comments
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4 Name and define the trace. 1 In the Output Trace  combo box, type a trace 
name (for example, LISN Line 1).

2 Click on the color bar and select a color for the 
trace. 

3 Click OK to close the color palette.

• For example, select blue (default) for LISN 
Line 1.

5 Set up the receiver. 1 Open the Receiver Settings  tab within the 
Sweep dialog box.

2 Set the receiver settings (Ref Level, Attenuation, 
internal receiver amplifier, if applicable) as noted 
in “Preview EUT Emissions” on page 2-19.

• It may be necessary to segment the 
frequency range of the regulation to which 
you are testing and enter different 
attenuation values for each segment 
(performing multiple sweeps) to account 
for overload conditions, see “Determine 
Receiver Settings” on page 2-13.

• Auto All  sets the receiver settings to the 
receiver defaults for the specific CISPR 
band. 

Procedure 2-7 How to Gather EUT Signals (Continued)

Step Procedure Comments
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6 Start the sweep. • Click Run  to start the sweep.

• The receiver is in remote mode, and the 
software is taking a sweep from 150 kHz 
to 30 MHz. 

• You can monitor the status of the sweep in 
the status bar of the application window; 
you also can view the trace as it is 
updated on the graph.

• The sweep can be paused or aborted 
from the Sweep Control dialog box which 
appears during the sweep.

Procedure 2-7 How to Gather EUT Signals (Continued)

Step Procedure Comments
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Are EUT Signal Peak Values Higher than the
Average Limit?

In this section, you will compare your signal trace to the average limit line

Procedure 2-8 How to compare your signal peak values to the average limit line

Step Procedure Comments

1 Compare the Peak trace to the 
average limit.

• Visually observe the peaks of the trace in the 
application graph window.

•  If any of the signals is above the limit, you 
will need to continue with “Create EUT 
Frequency List” on page 2-29.

2 Create a Report. • Refer to “How to Create a Snapshot Report” on 
page 5-44 and “How to Create a Custom Report” 
on page 5-45.

• If you want to rearrange, add or delete 
columns in you list before creating a 
report, refer to“Customize Signal Lists” on 
page 5-46.

3 Repeat the test process for each line 
to be tested.
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Create EUT Frequency List

If you have EUT emissions that are above the limit (or margin, if set), you
can extract signal frequencies from the trace data and place them in a si
list table. The signal list data can then be used to make additional
measurement.
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Procedure 2-9 How to Generate EUT Frequency List

Step Procedure Comments

1 Open the Add Peaks to List dialog 
box.

• In the side bar, click on the Add Peaks to List  
icon.

• Or, right-click the graph area and select 
Add Peaks to List .

2 Select and add signals. 1 In the Add Signals from  area, select the 
trace(s) that have signals above the limit line.

2 In the Compare to  area, choose the limit line to 
which to compare each signal. 

3 Set Peak Excursion  to 10 dB (default setting).

4 Click Add .

• EN 55022, Class B Conducted Average.

• In general, the larger the excursion value, 
the fewer signals will be captured. The 
smaller the excursion value, the more 
signals will be captured.

• If the peak excursion value is set too low, 
noise will be captured and interpreted as 
a signal. It is best to select peak excursion 
values high enough so as not to capture 
noise, but low enough to ensure that you 
capture the signals of interest.
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Measure Process

The Add Peaks to List operation added the signals meeting the signal crit
to the signal list. For this example the following headings (along with
Frequency, Trace Name etc.) have been selected for the signal list:

• Peak dBuV
The measured peak value

• QP dBuV
The measured quasi-peak value

• Avg dBuV
The measured average value

• Delta Pk-QP Limit dB
Difference between the measured peak and the quasi-peak limit (pos
for signals below the limit; negative for signals above the limit)

• Delta Pk-Avg Limit dB
Difference between the measured peak and the average limit (positiv
for signals below the limit; negative for signals above the limit)

• Delta QP-QP Limit dB
Difference between the measured quasi-peak and the quasi-peak lim
(positive for signals below the limit; negative for signals above the lim

• Delta Avg-Avg Limit dB
Difference between the measured average and the average limit (pos
for signals below the limit; negative for signals above the limit)

Measure Signals At this point, the E7415A software has performed a measurement with th
peak detector only. It may be necessary to measure signals with the
quasi-peak and average detectors as well (as defined in the regulation to
which you are testing).

NOTE If EUT emissions are below the average limit line (if applicable) when
measuring with a peak or quasi-peak detector, then there is no need to m
a second measurement with the average detector. (That is, the EUT pas
the average limit since measurements with the average detector will be a
below the peak and quasi-peak levels.)

Use the following procedure to measure signals with the quasi-peak dete
The procedure to measure signals with the average detector is similar.
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Procedure 2-10 How to Measure Signals with the Quasi-Peak Detector

Step Procedure Comments

1 Select the signals to be remeasured. • In the signal list, click and drag the row header 
(the left column) to highlight the signals that have 
a peak value within the limit margin.

• In this example, the signal list displays 
only the signals above the limit lines. 
Select all the signals within the signal list 
by clicking the upper left corner of the 
signal list.

• All of the signals with a peak above the 
margin will be selected, allowing them to 
be measured with the quasi-peak and 
average detectors.

2 Open the Measure dialog box. • In the side bar, click the Measure  icon.

3 Set measurement options. 1 In the Measure From List  area, click the 
Measure selected signals  option.

2 In the Detectors  area, check the detector(s) to 
use.

• If you know that some of the EUT signals 
are intermittent, increase the dwell time to 
compensate.

• In this example, each signal is 
remeasured using the peak and 
quasi-peak detectors (the average 
detector could also be selected). The 
Peak column is updated with new values 
acquired with greater frequency accuracy 
(lower frequency uncertainty). The QP 
(Quasi-Peak and Average) data are 
added to the signal list table. The “Delta” 
columns are updated with data.

4 Run the measurement. • Click Run  to begin the measurement.
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Evaluate Measurement Results

Sort Signals and
Evaluate Results

The signals can be sorted within the signal list by ascending or descendi
order of any signal list column. Use the following procedure to sort the
signal list by delta-to-limit value and then evaluate the results.

Procedure 2-11 How to Sort Signals by Delta-to-Limit Values

1 Sort the signal list by highest peak 
amplitude.

• In the signal list area, double-click on a 
delta-to-limit column header (for example, Delta 
QP-QP dB) to sort the signal list by highest 
amplitude.

• Double clicking once will sort the data in 
ascending order, double clicking again will 
sort the data in descending order.

• You can now easily determine the margin 
for the signal within the signal list. 
Signals below the limit line will have 
negative values; signals above the 
relative limit line will have positive values.

2 Evaluate the results. • Use the flowchart (Figure 2-2 on page 2-4) to 
determine if the signals you have measured 
pass or fail.

• That is, they are above the limit line 
margin.

3 Create a Report. • Refer to“How to Create a Snapshot Report” on 
page 5-44 and “How to Create a Custom Report” 
on page 5-45.

• If you want to rearrange, add or delete 
columns in you list before creating a 
report, refer to “Customize Signal Lists” 
on page 5-46.
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Save Test Data

The current test (test setup with test data) can be saved for use at a later

The following test parameters and test data are associated with each tes
will be saved:

• Test Header Information

• Selected Limit Lines

• Equipment

• Equipment Setup (including corrections)

• Signal Path

• Graph Settings

• Signal List Settings

• Sweep Settings

• Measure Settings

• Trace Data

• Add Peaks to List Settings

• Signal List Data

• Report Settings
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Procedure 2-12 How to Save a Test Setup with Data

Step Procedure Comments

1 Save the test setup and data. 1 From the menu bar, select File > Save As... .

2 In the Save As dialog box, select a destination 
folder and enter file name for the saved test 
setup and data.

3 Click Save.

2 Recall the saved test setup and data. • To access the test, select File  > Open  from the 
menu bar, then double-click on the file name.
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3 Radiated Emissions Example: Shielded
Room

In This Chapter…

• Radiated Process Flow Chart Example: Shielded Room, page 3-2
Shows the process flow for typical radiated precompliance
measurements performed in a shielded room

• Configure Test Equipment, page 3-5
Explains the configuration of the test equipment (shielded room,
receiver, transducer and so on) and EUT

• Select Test Setup, page 3-7
Lists the test setup parameters associated with each test setup
(equipment setup, signal path definition, signal list setup, and so on) a
points to procedures to modify parameters

• Determining the Receiver Settings During a Sweep, page 3-11
Explains how to optimize your receiver settings for performing
measurements.

• Preview EUT Emissions, page 3-16
Explains the procedure to preview the EUT emissions and check for
and RF overload conditions

• Gather EUT Signals Using the Peak Detector, page 3-19
Explains the process to generate sweep traces for various turntable
antenna tower positions

• Generate EUT Signal List, page 3-27
Explains the procedure to create a signal list (peak signals that meet
user-defined criteria) from the traces

• Maximization and Measure Process, page 3-29
Describes a procedure for maximizing EUT emissions, and for makin
quasi-peak measurements.

• Generate Reports, page 5-44
Explains the procedures for creating quick reports (snapshots) and
comprehensive reports

• Open and Save Test Setups, page 5-2
Explains the procedure to save test setups and test data
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Introduction

Even if you have access only to a small shielded room, you can still make
valuable measurements of your device. Emissions signals found in the s
chamber can save you a great deal of time on an open area test site (OA
by providing valuable information about the EUT emissions.

Radiated Process Flow
Chart Example: 
Shielded Room

Figure 3-1 on page 3-3 is a flow chart that shows an example process fo
making measurements of radiated emissions in a shielded room.

As you become familiar with the software, you may discover other metho
of testing better suited to your specific application.
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Figure 3-1 Precompliance Measurement of Radiated Emissions in a Shielded Room
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Determine Applicable Regulations

Determine the regulations to which you must comply. If you do not know t
applicable regulation for your product, see Appendix A, “Determining you
Regulation Requirements”.
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Configure Test Equipment

The equipment used in the test is configured according to regulatory
requirements, such as in EN55022 Class B. Refer to the applicable
regulation for specific configuration information. The regulation typically
specifies the test environment, receiver characteristics, and transducer
characteristics for a compliance test.

In most radiated emissions tests, antenna height and polarization is varie
and the equipment under test (EUT) is rotated to find the configuration
resulting in the maximum measured signal amplitude.

The EUT is normally exercised in a way that represents its typical usage
interconnect cables, if they are present, are oriented to maximize the
emissions.

Typical Equipment

A typical radiated EMI measurement setup is shown in Figure 3-2.

Equipment Type

PC Controller with the HP E7415A software See HP E7415A Getting Started Guide or the 
readme.txt file for PC requirements.

Receiver HP 85422E

HP 8542E

HP 85462A

HP 8546A

HP 859xEM

HP E7400A Series

HP-Simulator (included with the HP E7415A 
software to simulate test data)

Preamplifier HP 11909A

Biconical Antenna HP 11966C

Log Periodic Antenna HP 11966D

Bilog Antenna HP 11966P

Antenna Tripod HP 11968C

10 Meter coax cable HP 11966L
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Figure 3-2 CISPR Radiated-Emissions Test Setup

The Shielded Room A shielded room is a chamber made with conductive walls, floor, and
ceiling. Though typically made of welded or bolted sections of steel,
shielded rooms can also be made of wire mesh, or even conductive
wallpaper. Generally, the EUT is placed inside the room with the antenna
The rest of the test equipment is typically located outside the room.
(Shielded rooms are also often used to perform conducted emission
measurements.)

Shielded rooms provide a quiet, ambient-free environment and protectio
from the weather at a moderate cost. The major drawback of shielded ro
is that, since the surfaces are conductive, EUT signals can experience
multiple reflections and resulting standing waves within the chamber. Th
room resonances can cause extremely large variations in the amplitude o
measured signals, depending on the size of the room and location of the E
and antenna within the room. Often anechoic material is applied to the w
and floors of a shielded room to minimize the effects of these reflections

The signals measured within the shielded room can be used at an OATS
facilitate the identification of EUT signals.
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Select Test Setup

Common test setups have been included with the HP E7415A applicatio
When you first open the application theNew Test: Select Test Setup dialog box
appears, allowing you to select the regulation to which you normally test
After you have selected a test setup, limit lines for the selected regulation
displayed on the graph.

Selecting a Test Setup To select a predefined or previously saved test setup follow these steps:

Procedure 3-1 How to Select a Test Setup

Step Procedure Comments

1 Open the Select Test 
Setup dialog box.

• Open the HP E7415A application.

OR

• If the application is currently open, from the main 
menu, click File > New.

• Select New  to open an existing test setup without data. 

• Select Open  to open an existing test setup with data. 

2 Select a set of 
compliance regulations

1 From the Folder:  combo box, select a set of 
compliance regulations (folder).

2 Select the regulation to which to test.

3 Click OK.

• There are various folders under which are related 
compliance regulations, for example FCC Test Setups .

• For example, Part 15; Class B Radiated (3m) .
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Does Setup Require Modification?

Determine if the selected test setup requires modification for your particu
test equipment (receiver, transducer, cables, limiters, and so on), limit lin
definitions and ambient lists. To view the test setup, selectSetup > Show Setup .

NOTE The most common test setup modifications involve editing equipment se
information, such as the equipment used in a test and associated correc
factors. Note that the default equipment setup information contains
characteristic correction factors for common test equipment. Modifying
these correction factors or creating new ones for your specific equipmen
recommended for greatest amplitude accuracy.

If your test setupdoesrequire modification, continue to “Modify Setup”.

If your test setupdoes notrequire modification, skip to “Determining the
Receiver Settings During a Sweep” on page 3-11

The following test setup parameters are particularly important, dependin
upon your test equipment and applicable regulation:

• Limit Lines
• Equipment Corrections
• Signal Path (equipment selected and path of correction)
• Receiver Settings (for sweep and measure)
• Signal List Settings (list columns and filters)
• Graph Settings (appearance of output)
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Modify Setup

The existing test setups can be modified to meet your particular
requirements.

Modified test setups can be saved for future use (see “Saving Test Setups
page 3-10). The saved test setups are added to an existing test setup fold
into a newly created test setup folder.

As an option, you can create a new test setup by defining the required te
equipment, limit lines, and ambient list.

Steps for Modifying Test Setups

The following are the general steps for modifying an existing test setup:

1. Select a test setup (see “Select Test Setup” on page 3-7)

2. Determine if the selected test setup meets your requirements (see “D
Setup Require Modification?” on page 3-8)

3. Modify test setup as necessary (see appropriate How Do I...)

4. Save modified test setup (see “Saving Test Setups” on page 3-10)

Test Setup Parameters

The test setup includes the following testing parameters, any of which m
be modified to accommodate your testing requirements (refer to Chapte
“How Do I...?”, at the indicated page number for applicable modification
procedures):

• Limit Lines
See “Use Limit Lines” on page 5-7

• Equipment Setup
See “Add and Setup Test Equipment” on page 5-15

• Signal Path
See “Use Signal Paths” on page 5-25

• Ambient Lists
See “Use Ambient Lists” on page 5-27

• Graph Settings
See “Customize Graph and Trace Data” on page 5-57

• Signal List Settings
See “Customize Signal Lists” on page 5-46

• Sweep Settings
See “Setup and Perform Sweeps” on page 5-34
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• Measure Settings
See “Make Measurements” on page 5-40

• Report Settings
See “Generate Reports” on page 5-44

NOTE For cable characterization techniques, see “Characterize Cables” on
page 5-68.

Saving Test Setups

Procedure 3-2 How to Save a New or Modified Test Setup

Step Procedure Comments

Save the test setup. 1 From the menu bar, select 
File > Save As Setup... .

2 In the Save As Setup  dialog box, select the 
desired folder from the drop-down list or type in a 
new folder name

3 In the Setup Name:  text box, enter in a name for 
your setup. 

4 (Optional) Enter a description for your test setup 
in the Description:  text box.

5 Click Save.

• The Save Test Setup dialog box is displayed.

• Tip: Entering a new name in the folder text box will 
create a new test setup folder.

• To later access the new setup, select File > New. 
Select the folder and highlight the setup name, then 
click OK.
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Determining the Receiver Settings During a
Sweep

Before measurement sweeps can be taken with the software, the optimu
receiver settings for performing the measurements must be determined
set in the software. Several receiver parameters may be set by the user w
performing sweeps with the software. These settings, once set, may be s
within the context of a test setup for easy reuse. The sweep setting optio
are listed below:

• Detector (Peak/Quasi-Peak/Average)
• Dwell Time
• Resolution Bandwidth
• Video Bandwidth
• Reference Level
• Attenuation
• Sweep Time
• Segment Size
• Stop/Start Frequencies
• Segment Overlap

Some settings may need to be set according to a regulation’s requireme
(e.g. resolution bandwidths) and some settings may need to be set depen
on the equipment you have in the signal path you are using (e.g. start/sto
frequency may depend on an antenna’s useful frequency range).

Noise Floor to Limit
Line Separation

Prior to performing measurements sweeps, you will want to optimize the
receiver settings to obtain the best noise floor to limit line separation (how
far the noise floor is below the limit line) without encountering RF overloa

NOTE When varying attenuation and preamplification, always check to make su
that you do not encounter RF overload with the new settings. Refer to th
manual for your receiver for instructions to check for RF overload.

To do this, you will need to take a sweep with the HP E7415A software to
measure receiver’s noise floor to limit line separation using the receiver
settings that you wish to use during the EMC test. The software’s signal p
definition should be the same as the signal path that will be used during
test. With the application, the noise floor of the receiver should then be
measured with the receiver (or external preamplifier if one is defined in th
signal path) terminated in 50Ω. If the measured noise floor to limit line
separation is not adequate, then the following receiver settings may requ
modification.
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The following equipment settings can affect the noise floor limit line
separation.

• Input Attenuation
Increasing the attenuation increases the receiver noise floor and
decreases the noise floor to limit line separation.
Decreasing the attenuation decreases the receiver noise floor and
increases the noise floor to limit line separation.

• Preamplification with a low noise figure preamplifier (internal or
external)
Adding preamplification decreases the receiver corrected noise floor
increases the noise floor to limit line separation.
Removing preamplification increases the receiver corrected noise flo
and decreases the noise floor to limit line separation.

• Reference Level
Increasing the reference level in some settings can decrease the limit
to noise floor separation.
Decreasing the reference level in some settings can increase the lim
line to noise floor separation.

Procedure 3-3 How to Check for Adequate Noise Floor to Limit Separation

Step Procedure Comments

1 Setup test equipment. 1 Disconnect the RF input to your receiver.

2 Terminate the RF input on your receiver.

3 Power EUT Off.

• If the receiver has more than one input, 
select the appropriate input for the 
frequency range of interest.

• Use the appropriate 50Ω termination for 
your receiver if supplied.

2 Select the signal path. • From the Signal Path  drop down box, choose 
the signal path which includes the appropriate 
receiver, cable loss and transducer factors.

• The signal path determines which 
correction factors are used to calculate 
total correction.
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3 Set the Sweep parameters within the 
E7415A software.

1 In the side bar, click the Test  button, then click 
the Sweep  icon.

2 Modify the Start Frequency  and the 
Stop Frequency values if required.

• Alternatively, the Sweep  dialog box can 
be opened by right-clicking the graph 
area, then selecting Sweep.

• The Start and Stop frequencies are 
automatically set to the frequency range 
of the selected regulation, for example 
30 MHz and 1000 MHz 
respectively.Typically, the frequency range 
is determined by the transducer’s 
operating range, but the frequency range 
can be modified to meet your specific 
requirements.

4 Name and define the trace. 1 In the Output Trace  combo box, type a trace 
name (for example, 
Receiver Noise Floor ).

2 Click on the color bar and select a color for the 
trace. 

3 Click OK to close the color palette.

Procedure 3-3 How to Check for Adequate Noise Floor to Limit Separation (Continued

Step Procedure Comments
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5 Check noise floor. • Run the sweep by clicking Run in the Sweep 
dialog box.

If the noise floor to limit line separation is 
inadequate, go to the step “Adjusting the receiver 
settings to improve the noise floor to limit line 
separation.” on page 3-15.

If the noise floor to limit line separation is sufficient, 
go to the step “Note test configuration and receiver 
settings.” on page 3-15.

• The limit margin can be changed in the 
limit property sheet (see“Use Limit Lines” 
on page 5-7). The default margin is –6 dB. 
Or, set the margin within the Graph 
Settings dialog box (see “How to Modify 
the Graph Settings” on page 5-58.)

Procedure 3-3 How to Check for Adequate Noise Floor to Limit Separation (Continued

Step Procedure Comments
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6 Adjusting the receiver settings to 
improve the noise floor to limit line 
separation.

• If the noise floor to limit line separation is not 
adequate you may try changing the following:

Reduce attenuation

• This may be done by changing the attenuation 
setting in the Sweep  dialog box under the 
Receiver Settings  tab.

If the receiver has a built-in preamplifier, enable the 
preamplifier. 

• This may be done by checking the Receiver 
PreAmp  check box in the Sweep dialog box 
under the Receiver Settings  tab.

Reduce the receiver reference level setting.

• This may be done by changing the Ref Level  
setting in the Sweep  dialog box under the 
Receiver Settings  tab.

Add an external preamplifier.

• Run a new sweep after every change to 
determine its effect on the noise floor. 
When the noise floor to limit line 
separation is adequate, continue to step 
7.

• For example, 0 dB

• For best results, add the external 
preamplifier as close to the antenna 
output as possible. 

• If an external preamplifier is used, an 
external attenuator may be required; 
check for RF overload.

• Add the external preamplifier (with proper 
correction factors) to the active signal 
path (See “How to Add and Setup a 
Transducer (The procedure is similar for 
any other non-receiver test equipment)” 
on page 5-18).

7 Note test configuration and receiver 
settings.

Note the signal path (for example, an external 
preamplifier used) and the receiver settings 
(attenuation, reference level and internal 
preamplifier states).

• This signal path and receiver settings will 
be used in the next steps when 
previewing EUT emissions and checking 
for RF overload.

Procedure 3-3 How to Check for Adequate Noise Floor to Limit Separation (Continued

Step Procedure Comments
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Preview EUT Emissions

It is recommended that you preview the EUT emissions prior to beginning
EMI test. This allows you to determine quickly whether or not there are
obvious areas of failing emissions that may need to be addressed, and if
receiver sweep settings are set appropriately.

Previewing emissions also provides a way to vary the operating state of
EUT and EUT cable orientations to determine which states or orientation
may cause emission levels to increase.

Use the following procedures to preview EUT emissions:

1. Preview the EUT emissions

2. Detect and correct overload conditions

NOTE Refer to the appropriate User Manual for your receiver as needed.

Procedure 3-4 How to Preview Radiated EUT Emissions

Step Procedure Comments

1 Select signal path. • Choose the active signal path from the Signal 
Path  drop down box in the Receiver  tool bar.

• Click View > Tool bar > Receiver Bar  to 
enable the Receiver Bar.

2 Set up the receiver. 1 Connect receiver INPUT.

2 Set the Receiver to Local mode by clicking L on 
the Receiver Bar (top right-hand corner).

3 Set the receiver frequency range to the 
operating range of the transducer in the signal 
path.

• Clicking L sends the total signal path 
correction and the active limit lines to the 
receiver.

3 Turn on EUT and view EUT 
emissions.

1 Power ON the EUT.

2 Vary the operating state of the EUT and EUT 
cable orientations while monitoring the receiver 
display, to determine which EUT state to use for 
your test.

3 Set the receiver preamplifier state, reference 
level, and attenuation level as noted in the 
“Determining the Receiver Settings During a 
Sweep” process.
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4 Check for RF overload. 1 Check for RF overload conditions.

2 Correct for RF overload if necessary.

3 Note the receiver settings; these will be used as 
the initial receiver settings during the following 
measurements.

• See Check and Remove RF Overload on 
page 3-18 for more information on 
detecting and correcting overload 
conditions.

5 Check for obvious failing emissions. • Compare the signal levels with the limit line on 
the HP E7415A graph or directly on the receiver.

If there are obvious failing signals, go to “Generate 
Reports” on page 5-44.

If all signals are below the limit line, go to “Gather 
EUT Signals Using the Peak Detector” on 
page 3-19.

• If prescanning emissions directly on the 
receiver, it may be useful to enable 
Max Hold on the receiver trace.

Procedure 3-4 How to Preview Radiated EUT Emissions

Step Procedure Comments
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Check for and Remove
RF Overload

Since ambients are not present in a shielded room, high-level EUT emiss
are the most common cause of RF overload.

Overload Conditions

Some signals within the measured frequency span may cause an overlo
condition. Prior to making measurements, determine that the receiver is
in an RF overload condition.

RF Overload Detection and Correction

RF overload occurs when the energy level at the input mixer of the receiver
exceeds the mixer’s linear operating range. This means that the mixer is
compression, which can cause amplitude measurement errors.

NOTE Refer to the appropriate User Manual for your receiver as needed.

Recheck Noise Floor After correcting for RF overload conditions, recheck the noise floor to
ensure that the noise floor to limit line separation is adequate.

Procedure 3-5 How to Identify and Remove RF Overload Conditions

Step Procedure Comments

1 Set up the receiver. 1 Set the receiver in Local mode by clicking L on 
the receiver toolbar.

2 Set the frequency range of the receiver.

3 Set the receiver ref level, attenuation, 
preamplifier enable, etc. as noted in the 
“Determining the Receiver Settings During a 
Sweep” on page 3-11.

• The receiver is put into local mode and 
continuous sweep. The trace is corrected 
for the active signal path, and the limit line 
is displayed. This allows the user to 
interact directly with the receiver.

• Set to the frequency range of the 
regulation to which you are testing.

• Refer to appropriate hardware manual.

2 Determine if the receiver is in 
overload condition.

• Refer to receiver manual.

3 Remove the RF overload. • If an RF overload exists, remove the RF overload 
(usually by increasing the receiver’s input 
attenuation) and record the revised settings. 
Refer to receiver or analyzer manual.

 

4 Change sweep and measure receiver 
settings.

• Enter revised settings into sweep and measure 
dialog box receiver settings.

• See “How to Setup and Perform a Sweep” 
on page 5-34 and “How to Setup and 
Perform a Measurement” on page 5-40.
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Gather EUT Signals Using the Peak Detector

An EUT Signal List generated in a shielded enclosure may be the final re
in a precompliance EMI measurement process, or it may be used as the
suspect list for further compliance measurements.

In order to develop a list of EUT emissions to measure, you will need to u
the software to take sweeps with the EUT in place in the enclosure and
powered on. The list will include EUT signals discerned from the traces
resulting from these sweeps.

It is best to gather the EUT signals with the EUT oriented to several differe
turntable positions and the antenna positioned to several different height
and polarities. This improves the probability of capturing an EUT emissio

The “How to Gather EUT Signals” on page 3-21 procedure uses typical
settings to capture signals. You may want to modify these settings to
optimize your test procedure.

For this example procedure, two traces will be generated with the
HP E7415A software:

• Horizontal antenna polarization
(With various table positions)

• Vertical antenna polarization
(With various table positions)

For each trace, the following four sweeps will be performed:

• Antenna tower at 1 meter

� Table at 0 degrees

� Table at 90 degrees

� Table at 180 degrees

� Table at 270 degrees

For each trace, the maximum amplitude value from the 4 table positions
be retained (Max Hold).
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The following equipment is used in this example:

• HP E7415A EMI measurement software

• HP E7405A EMC analyzer

• HP 11966P bilog antenna

• HP 11966L 10 meter coaxial cable

• antenna tower

• turntable

NOTE The tower height will not be changed for this example. The number of
sweeps can be modified to best fit your processes. Refer Chapter 4,
“Radiated Emissions Example: Open Area Test Site” for an example usin
24 sweeps.
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Procedure 3-6 How to Gather EUT Signals

Step Procedure Comments

1 Set antenna polarity, tower, and table 
positions.

1 Position the antenna in the horizontal 
polarization.

2 Position the tower to 1 meter.

3 Position the turntable to 0 degrees.

• The antenna will be in the vertical 
polarization for the second trace.

2 Set the graph reference level. 1 Double-click in the graph area of the EMI 
measurement software to open the 
Graph Settings  dialog box.

2 Set the graph reference level, and stop 
frequencies to those determined during Preview 
EUT Emissions. Click OK to close the Graph 
Settings dialog box.

• The Graph Settings  dialog box can be 
opened from the menu bar
(Setup  > Graph Settings... ) or the 
toolbar.

• Graph Settings and Title can be modified 
after the Sweep for improved appearance.
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3 Set the Sweep parameters. 1 Power on the EUT.

2 In the side bar, click the Test  button, then click 
the Sweep  icon.

3 In the Sweep  dialog box, set the start frequency 
and the stop frequency to the range of the 
antenna you are using.

4 Select “Replace existing data” for the first of the 
4 sweeps.

5 Set Dwell for  to 3 sweeps.

• Alternately, the Sweep  dialog box can be 
opened by right-clicking the graph area, 
then selecting Sweep  (or by selecting 
Sweep  from the Test  menu).

• For this example, a bilog antenna is used 
with a frequency range of 30 MHz to 
1000 MHz. 

• More than one antenna may be needed to 
cover the frequency range of the 
regulation to which you are testing. 

• For example:
Set the start frequency to 30  MHz and 
the stop frequency to 200  MHz for a 
biconical antenna.
Set the start frequency to 200  MHz and 
the stop frequency to 1000  MHz for a log 
periodic antenna.

• Tip: Increase “Dwell for” values to capture 
intermittent signals or signals with slow 
cycle times. For example, if the EUT’s 
operating state has a 10 second cycle 
time, set Dwell for to 15 or 20 seconds.

4 Name and define the trace. 1 In the Output Trace  combo box, type a trace 
name (for example, 
Shielded Room Horizontal ).

2 Click on the color bar and select a color for the 
trace. 

3 Click OK to close the color palette.

• For example, select red for horizontal 
antenna and blue for vertical antenna 
polarization. 

Procedure 3-6 How to Gather EUT Signals (Continued)

Step Procedure Comments
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5 Set up the receiver. 1 Open the Receiver Settings  tab within the 
Sweep  dialog box.

2 Set the receiver settings (Ref Level, EUT 
Attenuation, and internal Receiver preamplifier if 
applicable) as noted in the “Preview EUT 
Emissions” on page 3-16.

3 If the receiver has more than one input, select 
the correct input.

• It may be necessary to segment the 
frequency span further to correctly 
account for overload conditions due to 
high-level signals while not masking 
low-level signals at different frequencies. 
See “Overload Conditions” on page 3-18.

• Enabling Auto RBW and VBW sets these 
values as per the CISPR 16 specification.

Procedure 3-6 How to Gather EUT Signals (Continued)

Step Procedure Comments
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6 Start the sweep. • Click Run  to start the sweep.

• The receiver is in remote mode, and the 
software is taking a sweep from 30 MHz 
to 1000 MHz comprised of several 
segments. 

• You can monitor the status of the sweep in 
the status bar of the application window; 
you also can view the trace as it is 
updated on the graph.

• The Sweep can be paused or aborted 
from the Sweep Control dialog box which 
appears during the sweep.

Procedure 3-6 How to Gather EUT Signals (Continued)

Step Procedure Comments
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7 Set the trace data to Max Hold. 1 After the software has completed the first sweep, 
open the Sweep  dialog box (click the Sweep  
icon). 

2 Within the When complete  area, select 
Add results to existing data (max hold) . 

• The resulting graph trace from multiple 
sweeps will retain and display the 
maximum value at each frequency point 
when “Add results to existing data” is 
selected.

8 Run sweeps for other table positions. 1 Adjust table position to 90 degrees.

2 Click Run  in the Sweep  dialog box.

3 Adjust table to 180 degrees.

4 Run sweep.

5 Adjust table to 270 degrees.

6 Run sweep.

• If the Sweep dialog box is closed, 
right-click the graph area and select 
Sweep .

• At this point, four sweeps will have been 
performed. the maximum points from the 
sweeps make up the “Shielded Room 
Horizontal” trace on the graph.

Procedure 3-6 How to Gather EUT Signals (Continued)

Step Procedure Comments
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9 Repeat sweep process for vertical 
antenna.

1 Position antenna with vertical polarization.

2 Repeat steps 1 through 8.

• Different reference levels may be required 
for vertical antenna polarization, see 
“Preview EUT Emissions” on page 3-16.

• Choose a different name for the vertical 
trace, for example, Shielded Room
Vertical .

• Choose a different trace color for the 
vertical trace.

• After completing steps 1 through 8, two 
traces will appear on the graph. One for 
horizontal antenna polarization, the other 
for vertical antenna polarization.

Procedure 3-6 How to Gather EUT Signals (Continued)

Step Procedure Comments
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Generate EUT Signal List

Now that you have EUT signal traces, you can identify the peaks from th
trace data and place them in the signal list table. The signal list data can
be used as a basis for future measurements and signal comparisons.
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Procedure 3-7 How to Generate EUT Frequency List

Step Procedure Comments

1 Open the Add Peaks to List dialog 
box.

• In the side bar, click on the Add Peaks to List  
icon.

• Or, right-click the graph area and select 
Add Peaks to List .

2 Select and add signals. 1 In the Add Signals from  area, select the 
Shielded Room Horizontal  and Shielded 
Room Vertical traces.

2 In the Compare to  area, choose the limit line to 
which you are testing. 

3 Optional: Check the Use Margin  box; set the 
margin to −6 dB (default setting).

4 Set Peak Excursion Criteria  to 10 dB (default 
setting).

5 Click Add .

• For example, FCC part 15; Class B (3m).

• The signals above the limit line margin 
(except duplicate signals) which meet the 
peak excursion are added to the list. The 
Trace Name column in the Signal List 
table shows the trace from which each 
signal is generated.

• The larger the peak excursion value, the 
fewer signals will be captured. The 
smaller the excursion value, the more 
signals will be captured. If the peak 
excursion is set too low, noise will be 
captured and interpreted as a signal. It is 
best to set peak excursion high enough 
not to capture noise, but low enough to 
capture the signals of interest. See Peak 
Excursion in the glossary for more 
information.

• Tip: If Limit Lines “None” is selected, then 
all peaks in the selected trace(s) meeting 
the peak excursion criteria will be added 
to the Signal List; if Peak Excursion is also 
set to 0 dB, then all the Trace points are 
added to the list.
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Maximization and Measure Process

This section is composed of two basic steps that must be performed on e
signal in the signal list sequentially. These steps are signal maximization
then measuring.

1. Maximization
In this step you will rotate the turntable and vary the antenna height a
polarization until the EUT emission is at its highest amplitude. You w
then record the turntable orientation, antenna height and polarization
the Table, Tower and Polarity columns of the list. This process is
typically repeated for each suspect EUT emission.

2. Measure
In this step you will measure the EUT emission amplitude using the
appropriate detectors (usually Peak and Quasi-Peak) and dwell time
appropriate for your emissions characteristics.

The following steps detail an example process to maximize and measure
suspect signal in the list. As you become familiar with the HP E7415
application, you may discover procedures that better fit your requiremen
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Preparation

Procedure 3-8 Preparing to Perform the Maximization and Measure Process

Step Procedure Comments

1 Add antenna height, polarity and 
table position columns to signal 
table.

1 Open the List Settings  dialog box; click 
Setup > List Settings...

2 While holding the <Ctrl>  key, highlight Table, 
Tower  and Polarity  in the Select Columns to 
Show  list.

3 Click on the right arrow key to add to the 
Selected Columns list.

4 Reorder the columns if desired.

5 Click OK.

• When you have maximized each signal, 
edit these columns with the appropriate 
information.

•

•

•

•

•

•

•

•

•

•

•

•

•

•

• Refer to “Customize Signal Lists” on 
page 5-46 for more information.
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2 Set the span for automatic tuning of 
the receiver to 2 MHz.

1 Select Tools > Options... > Tune/Demod.

2 Select the Tune  box.

3 Select Fixed Span: and set to 2 MHz.

4 Click OK.

• Other spans may be used if they are more 
useful for your application. Note that if 
Span Based on Frequency Uncertainty  
is selected that the span will vary based 
on the frequency uncertainty of the 
receiver when that specific signal was last 
measured.

• The tune function can be enabled and 
disabled quickly by selecting and 
deselecting the Tune box in the Receiver 
Bar.

Procedure 3-8 Preparing to Perform the Maximization and Measure Process

Step Procedure Comments
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Maximization The maximization process is performed to determine antenna, tower, an
turntable orientation that will find the maximum amplitude EUT signal.

In this step you will rotate the turntable and vary the antenna height and
polarization until the EUT emission is at its highest amplitude. You will hav
the opportunity to reposition the marker on the signal to update the signa
frequency if necessary. You will then record the turntable orientation,
antenna height and polarization in the Table, Tower and Polarity columns
the list.

Procedure 3-9 Maximization Process

Step Procedure Comments

1 Position the turntable, antenna height 
and polarity

• Position the turntable, antenna height and 
polarity to the position where you are most likely 
to observe the EUT emission.

2 Tune to a signal. • Highlight a signal in the signal list. (Click on the 
number column.)

• The receiver tunes to the selected signal, 
center frequency set to the signal list 
frequency, and frequency span to 2 MHz.

• The receiver goes to local mode.

3 Rotate the turntable from 0 −360 
degrees to find the maximum 
response.

1 Move the table to maximize the signal on the 
receiver.

2 Select Max Hold on the Receiver bar to assist 
you in finding the maximum response.

• Leave the table in the position with the 
maximum response.

• Clicking Max Hold on the receiver bar 
leaves Trace 1 as the active trace, and 
sets Trace 2 to Max Hold.

4 Adjust the antenna polarization and 
height to find the maximum 
response.

1 Adjust the antenna polarization and height for 
the maximum signal response.

2 Select Max Hold  on the Receiver bar to assist 
you in finding the maximum response.

• Leave the antenna polarization and height 
in the position with the maximum 
response.

5 Reposition the marker to update the 
list frequency if required for 
measurement.

1 If the marker needs to be re-centered on the 
signal before measurement, do these steps. 
Otherwise skip to the next step.

2 Use the receiver knob (or peak search) to 
position the marker on the signal. 

3 Click Get Receiver Marker  on the receiver bar 
to add the new marker position to the list.

4 Press the Delete key to delete the old signal in 
the list.

5 Click on the new signal added to the list to tune 
the receiver to the updated signal frequency.

• Sometimes the marker will need to be 
repositioned on the signal to measure due 
to EUT frequency drift or receiver 
frequency uncertainties.

• Tip: From the receiver’s front panel, the 
marker can be placed on the max held 
trace.

• The new marker frequency will be placed 
in the list just below the highlighted signal 
that you are currently tuned to.

• Make certain that the old signal is 
highlighted before pressing Delete.

• Tip: You may find it convenient to disable 
Tune on the Receiver bar prior to 
selecting and deleting old signals in the 
list.
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6 Record the turntable, antenna height 
and polarization.

1 Record the turntable orientation in the Table  
column in the list by selecting the cell and 
entering a value. 

2 Record the antenna height in the Tower  column 
in the list.

3 Record the antenna polarization in the Polarity  
column in the list.

Procedure 3-9 Maximization Process

Step Procedure Comments
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Measure In this step you will measure the EUT emission amplitude using the
appropriate detectors (usually Peak and Quasi-Peak) and dwell times
appropriate for your emissions characteristics.

During a measurement, the reference level must be adjusted such that th
signal being measured is below the top display graticule to prevent IF
overload. If the signal being measured is above the top display graticule,
increase the receiver reference level until the signal falls below the top of
graticule.
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Procedure 3-10 Measure Process

Step Procedure Comments

1 Measure the signal. 1 Open the Measure  dialog box by clicking the 
Measure  icon in the side bar.

2 In the Measure From List  area, select the 
Measure selected signals  option.

3 In the Detectors  area, select the appropriate 
detectors (for example, Peak and Quasi-Peak).

4 In the Detectors  area, set the Dwell Time  for 
each detector selected.

5 Click Run  to begin the measurement.

• The default dwell times are adequate for 
measuring most emissions. If the signal 
that you are measuring has a low 
repetition rate or is intermittent in nature 
you may need to increase the dwell time 
to capture at least two repetitions in order 
to accurately measure it. If the dwell time 
is increased for any of the detectors, you 
must also increase the Autorange 
Sweep Time  to be equal to or greater 
than the longest dwell time of the selected 
detectors. The Autorange Sweep Time 
may be set by clicking the Receiver 
Settings  tab in the Measure dialog box 
and setting in the Autorange Sweep 
Time.
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Signal

Continue with the next signal and repeat procedures 3-9 and 3-10 for ev
signal in your list.

When complete, you should have a list of only your identified, maximized
and measured EUT emissions.

If you wish to rearrange or add or delete columns in your list before creat
a report refer to “Customize Signal Lists” on page 5-46.

To create a report refer to “Generate Reports” on page 5-44.

To save your test data, refer to “Setup Tests” on page 5-2. A test file
containing a list of EUT emissions identified in a shielded enclosure can
the starting point for performing compliance tests on an OATS reducing t
overall time spent on the OATS.
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4 Radiated Emissions Example: Open Area
Test Site

In This Chapter…

• Determine Applicable Regulations, page 4-4

• Configure Test Equipment, page 4-5

• Does Setup Require Modification?, page 4-9

• Modify Setup, page 4-10

• Determine Receiver Settings, page 4-12

• Create Ambient Signal List, page 4-18

• Gather EUT+Ambient Signals Using the Peak Detector (Several
Orientations), page 4-25

• Gather EUT+Ambient Signals, page 4-31

• Reduce Data (Initial Data Reduction), page 4-33

• Signal Identification, Maximization and Measure Process, page 4-36
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Introduction

The HP E7415A software may be used on an Open Area Test Site (OATS
perform compliance tests when using an HP 8542E or HP 8546A EMI
receiver. It may also be used on an OATS to perform precompliance test
when using one of the HP E7400A-Series or HP 8590EM Series analyze

When performing tests on an OATS it is generally preferable to first gathe
list of EUT emission frequencies in a shielded room. A shielded room wil
allow you to gather emissions that are only due to your equipment under
(EUT) without having to concern yourself with the local ambient (for
example, FM or TV broadcasts) environment. Of course, not everyone w
have access to a shielded room.

This example process assumes that you do not have access to a shielde
room and are performing radiated emissions tests utilizing only an OATS
you do have access to a shielded room, you will find that a great portion
this process will still be useful to you. You will just have the added
advantage of knowing what your EUT emission frequencies are prior to
moving to the OATS.

Radiated Process Flow
Chart Example: Open
Area Test Site

Figure 4-1 on page 4-3 is a flow chart that shows an example process fo
making measurements of radiated emissions with an OATS facility. This
only an example. As you learn to use the software, you may find other
methods of testing that will better suit your specific application.
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Introduction
Figure 4-1 Example Process for Measurement of Radiated Emissions on an Open
Area Test Site (OATS)
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Determine Applicable Regulations

Determine the regulations to which you must comply. If you do not know t
applicable regulation for your product, see Appendix A, “Determining you
Regulation Requirements”.
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Configure Test Equipment

In this example, the equipment used in the test is configured to perform a
EN55022 Class B test. Refer to the applicable regulation to determine yo
specific configuration requirement. The regulation typically specifies the t
environment, receiver characteristics, and transducer characteristics for
compliance test. If you do not know what regulation is applicable for you
product, see Appendix A, “Determining your Regulation Requirements”.

During most radiated emissions tests, antenna height and polarization is
varied, and the equipment under test (EUT) is rotated to find the
configuration resulting in the maximum measured signal amplitude. The
EUT is normally exercised in a way that represents its typical usage.
Interconnect cables, if present, are oriented to maximize the amplitude o
emissions.

The basic configuration for a radiated emissions measurement consists
transducer, an internal/external preamplifier (optional), an external
attenuator (optional), an external preselector (optional), cables, and a
receiver. A PC and software such as the HP E7415A is often used to enh
measurement efficiency, and report generation.

The Open Area Test
Site

Comité International Spécial des Perturbations Radioélectriques (CISPR
has established a standard for Open Area Test Sites (OATS). (Refer to
CISPR publication 16.) An OATS must meet the standards of the applica
regulations.

It is useful to characterize the ambient signals at your OATS prior to testi
your EUT. This will greatly facilitate the identification of suspect EUT
signals. (An ambient signal list will be generated as part of the test proce
see “How to Generate Ambient Signal List” on page 4-19.)
HP E7415A Measurement Guide 4-5



Radiated Emissions Example: Open Area Test Site
Configure Test Equipment
Common Test
Equipment

Figure 4-2 illustrates the basic test configuration for radiated emissions
testing.

Equipment Type

PC with the HP E7415A software See HP E7415A Getting Started Guide or the 
readme.txt file for PC requirements.

Receiver HP 85422E

HP 8542E

HP 85462A

HP 8546A

HP 859xEM

HP E7400A Series

HP-Simulator (included with the HP E7415A 
software to simulate test data)

Preamplifier HP 11909A

Biconical Antenna HP 11966C

Log Periodic Antenna HP 11966D

Bilog Antenna HP 11966P

Antenna Tripod HP 11968C

10 Meter coax cable HP 11966L
4-6 HP E7415A Measurement Guide



Radiated Emissions Example: Open Area Test Site
Configure Test Equipment
Figure 4-2 Typical OATS Radiated-Emissions Test Setup
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Select Test Setup

Common test setups have been included with the HP E7415A applicatio
When you first open the application theNew Test: Select Test Setup dialog box
appears, allowing you to select the regulation to which you normally test
After you have selected a test setup, limit lines for the selected regulation
displayed on the graph.

Selecting a Test Setup To select a predefined or previously saved test setup follow these steps:

Procedure 4-1 How to Select a Test Setup

Step Procedure Comments

1 Open the 
Select Test Setup 
dialog box.

• Open the HP E7415A application.

OR

• If the application is currently open, from the main 
menu, click File  > New.

• Select New  to open an existing test setup without data. 

• Select Open  to open an existing test setup with data. 

2 Select a set of 
compliance 
regulations.

1 From the Folder:  combo box, select a set of 
compliance regulations (folder).

2 Select the regulation to which to test.

3 Click OK.

• There are various folders under which are related 
compliance regulations, for example EN 55022 
Test Setups .

• For example, EN 55022; Class B Radiated, (10m) 
w/Preamp .
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Does Setup Require Modification?

Determine if the selected test setup requires modification for your particu
test environment. To view the test setup, selectSetup > Show Setup .

A test setup is composed of the software settings required to perform a t
These software settings include items like limit lines, equipment to be us
correction factors, band settings and report output (see “Test Setup
Parameters” on page 4-10 for a more comprehensive list). The software
comes with several example test setups.

NOTE The most common modifications involve editing equipment setup
information, such as the equipment used in a test and associated correc
factors. Note that the default equipment setup information contains
characteristic correction factors for common test equipment. You will wan
to modify these correction factors or create new ones for your specific
equipment for greatest amplitude accuracy.

If your test setupdoesrequire modification, continue to “Modify Setup” on
page 4-10 which includes a complete list of the modifiable test setup
parameters.

If your test setupdoes notrequire modification, skip to “Configure Test
Equipment” on page 4-5.

The following test setup parameters are particularly important, dependin
upon your test equipment and applicable regulations:

• Limit Lines

• Signal Path (equipment selected including corrections)

NOTE The active signal path (including correction factors) within the HP E7415
application must correspond to your physical test equipment layout.

• Equipment Corrections

• Graph Settings

• Signal List Settings (list columns)

• Receiver Settings (for Sweep and Measure)
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Modify Setup

The HP E7415A application comes with several example test setups. Th
test setups can be modified to meet your specific test requirements. As a
option, you can create a new test setup by defining the required test
equipment, limit lines, and ambient list.

Test setups can be saved for future use (see “Saving Test Setups” on
page 4-11). Test setups may be added to an existing test setup folder or i
newly created test setup folder.

Steps for Modifying Test Setups

The following are the general steps for modifying an existing test setup:

1. Select a test setup (see “Select Test Setup” on page 4-8)

2. Determine if the selected test setup meets your requirements (see “D
Setup Require Modification?” on page 4-9)

3. Modify the test setup as necessary (see appropriate Chapter 5, “How
I...?” procedure)

4. Save the modified test setup (see “Saving Test Setups” on page 4-11

Test Setup Parameters

When creating a test setup you may change and save the following
parameters to accommodate your specific test needs or requirements (re
to Chapter 5, “How Do I...?”, at the indicated page number for applicable
“Customize Graph and Trace Data” on page 5-57modification procedure

• Limit Lines
See “Use Limit Lines” on page 5-7

• Equipment Setup
See “Add and Setup Test Equipment” on page 5-15

• Signal Path
See “Use Signal Paths” on page 5-25

• Ambient Lists
See “Use Ambient Lists” on page 5-27

• Graph Settings
See “Customize Graph and Trace Data” on page 5-57

• Signal List Settings
See “Customize Signal Lists” on page 5-46
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• Sweep Settings
See “Setup and Perform Sweeps” on page 5-34

• Measure Settings
See “Make Measurements” on page 5-40

• Report Settings
See “Generate Reports” on page 5-44

• Receiver Settings
See “How to Add and Setup a New Receiver” on page 5-16

After modification and saving of test setup parameters, these parameter
become defaults for the associated test setup.

Saving Test Setups

Procedure 4-2 How to Save a New or Modified Test Setup

Step Procedure Comments

Save the test setup. 1 From the menu bar, select 
File > Save As Setup... .

2 In the Save Test Setup  dialog box, select the 
desired folder from the drop-down list or type in a 
new folder name

3 In the Setup Name:  text box, enter in a name for 
your setup. 

4 (Optional) Enter a description for your test setup 
in the Description:  text box.

5 Click Save.

• The Save Test Setup  dialog box is displayed.

• Entering a new name in the folder test box will create a 
new folder.

• To later access the new setup, select File  > New. 
Select the folder and highlight the setup name, then 
click OK.
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Determine Receiver Settings

Before measurement sweeps can be taken with the software, the optimu
receiver settings for performing the measurements must be determined
set in the software Several receiver parameters may be set by the user w
performing sweeps with the software. These settings, once set, may be s
within the context of a test setup for easy reuse. The sweep setting optio
are listed below (refer to the How Do I... chapter for definitions):

• Resolution Bandwidth
• Video Bandwidth
• Reference Level
• Attenuation
• Sweep Time
• Segment Size
• Stop/Start Frequencies
• Segment Overlap
• Dwell Time
• Detector (Peak/Quasi-Peak/Average)

Some settings may need to be set according to a regulation’s requireme
(e.g. resolution bandwidth) and some settings may need to be set depen
on the equipment you have in the signal path you are measuring (e.g.
start/stop frequency may depend on an antenna’s useful frequency rang

Noise Floor to Limit
Line Separation

Prior to performing measurements sweeps, you will want to optimize the
receiver settings to obtain the best noise floor to limit line separation (how
far the noise floor is below the limit line) without encountering RF overloa

NOTE When varying attenuation and preamplification, always check to make su
that you do not encounter RF overload with the new settings. Refer to th
manual for your receiver for instructions to check for RF overload.

To do this, you will need to take a sweep with the HP E7415A software to
measure the receiver’s noise floor to limit line separation using the receiv
settings that you wish to use during the EMC test. The software’s signal p
definition should be the same as the signal path that will be used during
test. With the application, the noise floor of the receiver should then be
measured with the receiver (or external preamplifier if one is defined in th
signal path) terminated.
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If the measured noise floor to limit line separation is not adequate, then t
following receiver settings may require modification:

• Input Attenuation
Increasing the attenuation increases the receiver noise floor and
decreases the noise floor to limit line separation.
Decreasing the attenuation decreases the receiver noise floor and
increases the noise floor to limit line separation.

• Preamplification with a low noise figure preamplifier (internal or
external)
Adding preamplification decreases the receiver corrected noise floor
increases the noise floor to limit line separation.
Removing preamplification increases the receiver corrected noise flo
and decreases the noise floor to limit line separation.

• Reference level
Increasing the reference level in some settings can decrease the limit
to noise floor separation.
Decreasing the reference level in some settings can increase the lim
line to noise floor separation.
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Procedure 4-3 How to Check for Adequate Noise Floor to Limit Separation

Step Procedure Comments

1 Setup test equipment. 1 Disconnect the RF input to your receiver.

2 Terminate the RF input on your receiver. • Use the appropriate terminator for your 
receiver.

2 Select the signal path. •  Choose the path including all cable loss, 
transducer and receiver corrections.

3 Set the Sweep parameters within the 
HP E7415A software.

1 In the side bar, click the Test  button, then click 
the Sweep  icon.

2 Modify the Start Frequency  and the 
Stop Frequency values if required.

• The Sweep  dialog box can be opened by 
right-clicking the graph area, then 
selecting Sweep.

• The Start and Stop frequencies are 
automatically set to the frequency range 
of the selected regulation, for example 
30 MHz and 1000 MHz respectively. 
The frequency range can be modified to 
meet your specific requirements.

4 Name and define the trace. 1 In the Output Trace  combo box, type a trace 
name (for example, 
OATS_1 Noise Floor (E7405A0 ).

2 Click on the color bar and select a color for the 
trace. 

3 Click OK to close the color palette.
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5 Check noise floor. • Run sweep by clicking Run  in the Sweep  dialog 
box.

If the noise floor to limit line separation is not 
adequate go to “How to Adjust Receiver 
Settings” on page 4-16.

If the noise floor to limit line separation is 
adequate go to the next step.

6 Note test configuration and receiver 
settings.

1 Note the signal path (e.g. is external preamplifier 
used) and the receiver settings (attenuation, 
reference level and internal preamplifier states).

2 Go to “Check for and Remove RF Overload” on 
page 4-17.

• This signal path and receiver settings will 
be used in the next step when checking 
for RF overload.

Procedure 4-3 How to Check for Adequate Noise Floor to Limit Separation (Continued

Step Procedure Comments
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Procedure 4-4 How to Adjust Receiver Settings

Step Procedure Comments

1 Adjusting the receiver settings to 
improve the noise floor to limit line 
separation.

If the noise floor to limit line separation is not 
adequate you may try changing the following:

1 Reduce the receiver input attenuation.

This may be done by changing the attenuation 
setting in the Sweep  dialog box under the 
Receiver Settings  tab.

2 Turn on the internal preamplifier if the receiver 
you are using has one.

• This may be done by checking the
Receiver PreAmp  check box in the Sweep  
dialog box under the Receiver Settings  tab.

3 Lower the receiver reference level setting.

• This may be done by changing the Ref Level 
setting in the Sweep  dialog box under the 
Receiver Settings  tab.

4 Add an external preamplifier.

• Run a new sweep after every change to 
determine its effect on the noise floor. 
When the noise floor to limit line 
separation is adequate, continue to step 2

.

• For best results, add the external 
preamplifier as close to the antenna 
output as possible. 

• If an external preamplifier is used, an 
external attenuator may also be required 
to check for RF overload.

• Add the external preamplifier (with proper 
correction factors) to the active signal 
path (See “How to Add and Setup a 
Transducer (The procedure is similar for 
any other non-receiver test equipment)” 
on page 5-18).

2 Note test configuration and receiver 
settings.

• Note the signal path (for example, is external 
preamplifier used) and the receiver settings 
(attenuation, reference level and internal 
preamplifier states).

• This signal path and receiver settings will 
be used in the next step when checking 
for RF overload.
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Check for and Remove
RF Overload

On an OATS, strong ambients are the most common cause of overload.

Overload Conditions

Some signals within the measured frequency span may cause an overlo
condition. Prior to making measurements, determine that the receiver is
in an RF overload condition.

RF Overload Detection and Correction

RF overload occurs when the energy level at the input mixer of the receiver
exceeds the mixer’s linear operating range. This means that the mixer is
compression, which can cause amplitude measurement errors.

NOTE Refer to the appropriate User Manual for your receiver as needed.

Recheck Noise Floor After correcting for RF overload conditions, recheck the noise floor to
ensure that the noise floor to limit line separation is adequate.

Procedure 4-5 How to Identify and Remove RF Overload Conditions

Step Procedure Comments

1 Set up the receiver. 1 Set the receiver in Local mode by clicking L on 
the receiver toolbar.

2 Set the frequency range of the receiver.

3 Set the receiver ref level, attenuation, 
preamplifier enable, and so on. as noted in the 
“Determine Receiver Settings” on page 4-12.

• This allows user interface directly with the 
receiver.

• Set to the frequency range of the 
regulation to which you are testing.

• Refer to appropriate receiver manual.

2 Determine if the receiver is in 
overload condition.

• Refer to receiver manual.

3 Remove the RF overload. • If an RF overload exists, remove the RF overload 
and record the revised settings. Refer to receiver 
manual.

 

4 Change sweep and measure receiver 
settings.

• Enter revised settings into Sweep and Measure 
dialog box Receiver Settings.

• See “How to Setup and Perform a Sweep” 
on page 5-34 and “How to Setup and 
Perform a Measurement” on page 5-40.
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Create Ambient Signal List

For OATS testing it is useful to generate a list of ambient signals for your
OATS location. This list can then be used to compare against ambient+E
scans to help determine what signals are due to the EUT alone.

For this procedure, a single trace will be generated from sweeps with the
antenna in horizontal and vertical polarizations. Only the highest value fr
either polarization will be retained in the trace. The regulation for the
example is EN55022 Class B.

The following equipment is used in this example:

• HP E7415A EMI measurement software

• HP E7405A EMC Analyzer (receiver)

• HP 11966P bilog antenna

• HP 11968C antenna tower

• Turntable

• HP 11966L 10 meter coaxial cable
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Procedure 4-6 How to Generate Ambient Signal List

1 Set antenna position. 1 Position the antenna in the horizontal 
polarization.

2 Position the tower to 2.5 meters.

• The antenna will be in the vertical position 
for the second sweep.

• The tower height will not be changed for 
this process.

2 Set the Sweep parameters. 1 In the side bar, click the Test  button, then click 
the Sweep  icon.

2 In the Sweep  dialog box, set the start frequency 
and the stop frequency to the range of the 
antenna you are using.

3 Set Dwell for  to 3 sweeps.

• Alternately, the Sweep  dialog box can be 
opened by right-clicking the graph area, 
then selecting Sweep .

• For this example, a bilog antenna is used 
with a frequency range of 30 MHz to 
1000 MHz. 

• More than one antenna may be needed to 
cover the radiated frequency range of the 
regulation to which you are testing. 

• For example:
Set the start frequency to 30  MHz and 
the stop frequency to 200  MHz for a 
biconical antenna.
Set the start frequency to 200  MHz and 
the stop frequency to 1000  MHz for a log 
periodic antenna.

• Three sweeps are used in this example to 
help capture intermittent ambients. Other 
dwell times may be used as desired.

3 Name and define the trace. 1 In the Output Trace  combo box, type a trace 
name (for example, OATS_1 Ambients ).

2 Click on the color bar and select a color for the 
trace. 

3 Click OK to close the color palette.
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4 Set up the receiver. 1 Open the Receiver Settings  tab within the 
Sweep  dialog box.

2 If the reference and attenuator levels from 
“Determine Receiver Settings” on page 4-12 are 
different from the Ref Level Auto and Attenuation 
Auto settings, clear the Ref Level and 
Attenuation Auto check boxes and enter the 
appropriate levels.

• It may be necessary to segment the 
frequency span further to correctly 
account for overload conditions due to 
high-level signals while not masking 
low-level signals at different frequencies. 
See “Determine Receiver Settings” on 
page 4-12.

5 Start the sweep. • Click Run  to start the sweep. • The receiver is in remote mode, and the 
software is taking a sweep from 30 MHz 
to 1000 MHz. 

• You can monitor the status of the sweep in 
the status bar of the application window; 
you also can view the trace as it is 
updated on the graph.

Procedure 4-6 How to Generate Ambient Signal List (Continued)
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6 Adjust the graph reference level. 1 Double click the graph to open the 
Graph Settings  dialog box.

2 Set the dB/Div , Amplitude Divisions , and 
Frequency Scale  as needed to view the trace.

3 Click OK.

• For this example,
Ref Level = 60 dBuV/m
dB/Div = 5
Amplitude Divisions = 10
Frequency Scale = Linear

7 Reorient the antenna for vertical 
polarization.

• Set antenna to vertical.

Procedure 4-6 How to Generate Ambient Signal List (Continued)
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8 Set the trace data to Max Hold. 1 Open the Sweep  dialog box (click the Sweep 
icon). 

2 Within the When complete  area, select 
Add results to existing data (max hold) . • The resulting graph trace from multiple 

sweeps will keep and display the 
maximum value at each frequency point.

9 Run sweep for vertical antenna 
polarization.

1 Set the Dwell for  to 3 sweeps.

2 Click Run .

• This is to capture intermittent ambient 
signals.

• Two sweeps have been performed; the 
maximum points form the trace 
OATS_1Ambients. (You could also create 
two separate traces with two names if you 
wanted to generate separate ambient lists 
for each polarization).

Procedure 4-6 How to Generate Ambient Signal List (Continued)
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10 Generate Signal List. 1 Click Add Peaks to List in the Side Bar.

2 Set the Peak Excursion  level.

3 Click Add . • In general, the larger the excursion value, 
the fewer signals will be generated. The 
smaller the excursion value, the more 
signals will be generated. If the peak 
excursion value is set too low, noise will 
be captured as a signal. It is best to select 
peak excursion values >10dB to prevent 
capturing noise. For the purpose of 
capturing ambients 10 to 15 dB is 
reasonable. See “Peak Excursion” in 
Glossary for Peak Excusions algorithms.

Procedure 4-6 How to Generate Ambient Signal List (Continued)
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11 Add Signals to Active Ambient List. 1 Highlight entire list.

2 Right click the signal list and select 
Save to Ambient List .

3 Verify ambient list under 
Setup > Ambient Lists .

• Click in upper left corner of list.

• Saves signals to active (checked) ambient 
list. If no list is active, an ambient list 
(Untitled Ambient List) is created and the 
ambient signals are placed within that list. 
The list is then activated.

• Rename the ambient list if desired by right 
clicking on the name and select Rename .

• The graph displays the highlight markers 
for the signals in the list. To turn off the 
markers, select 
View  > Highlight Markers .

Procedure 4-6 How to Generate Ambient Signal List (Continued)
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Gather EUT+Ambient Signals Using the Peak
Detector (Several Orientations)

The most efficient method for performing OATS measurements is to first
develop an EUT signal list in a shielded room and to then take this signal
out to an open site for measurement. In this way, you do not need to be a
concerned about finding your EUT emissions in a crowded OATS ambien
environment because you know the EUT emission frequencies. If you do
have access to a shielded room, the following process will help you find y
EUT emissions using only an OATS.

In order to develop a list of EUT emissions to measure, you will use the
software to take sweeps with the EUT in place on the open site and turne
on. These sweeps will be composed of EUT and Ambient (EUT+Ambien
signals. After the EUT+Ambient sweeps have been created, you will then
compare their content to the Ambient sweeps. In this way, you will be able
determine if individual signals are due to your EUT and should be measu
or if the signal is an Ambient and can be ignored.

It is best to gather EUT+Ambient signals with the antenna positioned clo
to the EUT than is specified by the regulation (for example, 3 meters inste
of 10 meters). This will generally cause the emission signal strength to
measure higher and aid in capturing EUT emission frequencies. When th
final measurement is performed, the EUT to antenna spacing should be
moved back to the distance specified by the regulation. Of course, if you
prefer, you can always leave the antenna to EUT spacing as specified by
regulation to gather the EUT+Ambient signals.

It is best to gather the EUT+Ambient signals with the EUT oriented to
several different turntable positions and the antenna positioned to severa
different heights and polarities. This improves the probability of capturing
an EUT emission.

For this example procedure, 16 traces will be generated with the HP E741
software:

• Antenna to EUT spacing is 3 meters

• Horizontal antenna polarization
With antenna tower at 1 meter, 1.9 meters with the following table
positions for each tower settings

� Table at 0 degrees

� Table at 90 degrees

� Table at 180 degrees

� Table at 270 degrees
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• Vertical antenna polarization
With antenna tower at 1 meter, 1.9 meters with the following table
positions for each tower settings

� Table at 0 degrees

� Table at 90 degrees

� Table at 180 degrees

� Table at 270 degrees

The following equipment is used in this example:

• HP E7415A EMI measurement software

• HP E7405A EMC Analyzer (receiver)

• HP 11966P bilog antenna

• HP 11968C antenna tower

• Turntable

• HP 11966L 10 meter coaxial cable
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Procedure 4-7 How to Generate EUT+Ambient Traces Using the Peak Detector

1 Place EUT near antenna. Place the EUT 3 meters from the antenna. • Placing the EUT closer to the antenna 
than specified in the regulation, results in 
enhancing the probability of capturing 
EUT emissions.

2 Set antenna, tower, and table 
positions.

1 Position the antenna in the horizontal 
polarization.

2 Position the tower to 1 meter.

3 Position the turntable to 0 degrees.

3 Set the Sweep parameters. 1 In the side bar, click the Test  button, then click 
the Sweep  icon.

2 In the Sweep  dialog box, set the start frequency 
and the stop frequency to the range of the 
antenna you are using.

3 Set Dwell for  to 3 sweeps.

4 Set When complete  to Replace existing data .”

• Alternately, the Sweep  dialog box can be 
opened by right-clicking the graph area, 
then selecting Sweep  (or from the menu 
bar).

• For this example, a bilog antenna is used 
with a frequency range of 30 MHz to 
1000 MHz. 

• More than one antenna may be needed to 
cover the frequency range of the 
regulation to which you are testing. 

• For example:
Set the start frequency to 30  MHz and 
the stop frequency to 200  MHz for a 
biconical antenna.
Set the start frequency to 200  MHz and 
the stop frequency to 1000  MHz for a log 
periodic antenna.

• This is to capture intermittent EUT 
signals. The dwell time may be set to 
meet your EUT needs.

4 Name and define the trace. 1 In the Output Trace  combo box, type a trace 
name (for example, EUT_H_100cm_0deg).

2 Click on the color bar and select a color for the 
trace. 

3 Click OK to close the color palette.

• Use a different color for each trace.
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5 Set up the receiver. 1 Open the Receiver Settings  tab within the 
Sweep  dialog box.

2 Set the receiver settings as noted in the 
“Determine Receiver Settings”.

• It may be necessary to segment the 
frequency span further to correctly 
account for overload conditions due to 
high-level signals while not masking 
low-level signals at different frequencies. 
See “Determine Receiver Settings” on 
page 4-12.

6 Start the sweep. Click Run  to start the sweep.

• The receiver is in remote mode, and the 
software is taking a sweep from 30 MHz 
to 1000 MHz. 

• You can monitor the status of the sweep in 
the status bar of the application window; 
you also can view the trace as it is 
updated on the graph.

Procedure 4-7 How to Generate EUT+Ambient Traces Using the Peak Detector
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7 Adjust the graph reference level. 1 Double click the graph to open the 
Graph Settings  dialog box.

2 Set the Ref Level  as appropriate (usually the 
same as the receiver reference level) to view the 
complete trace.

3 Clear the ambient trace check box if you do not 
want to view it on the graph.

8 Run sweeps for other tower/table 
position combinations.

1 Adjust table position to 90 degrees.

2 Repeat steps 3 and 4.

3 Click Run .

4 Adjust table to 180 degrees.

5 Repeat steps 3 and 4.

6 Run sweep.

7 Adjust table to 270 degrees.

8 Repeat steps 3 and 4.

9 Run sweep.

10Adjust tower to 1.9 meters and run sweeps for all 
four table positions.

• Name the trace 
EUT_H_100cm_90deg.

• Name the trace 
EUT_H_100cm_180deg .

• Name the trace 
EUT_H_100cm_270deg .

• Name the traces 
EUT_H_190cm_xxxdeg .

Procedure 4-7 How to Generate EUT+Ambient Traces Using the Peak Detector
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9 Repeat sweep process for vertical 
antenna.

1 Position antenna with vertical polarization.

2 Repeat steps 1 through 8.

• Different reference levels may be required 
for vertical antenna polarization.

• Choose a different name for each vertical 
trace, for example, 
EUT_V_100cm_0deg.

• Choose a different trace color for each 
vertical trace.

• After completing steps 1 through 9, 
sixteen traces will appear on the graph. 
Eight for horizontal antenna polarization, 
and eight for vertical antenna polarization. 
(Four traces, generated with the tower 
height = 1 meter, are shown on the graph 
below).

10 Save your results 1 Select File, Save As, then enter a file name. • Periodically saving your results can 
prevent inadvertent data loss.

Procedure 4-7 How to Generate EUT+Ambient Traces Using the Peak Detector
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Gather EUT+Ambient Signals

Now that you have EUT+Ambient signal traces, you can extract the sign
from the trace data and place them in the signal list table. The signal list d
can then be reduced and used as a basis for future measurements.

Procedure 4-8 How to Generate EUT Signal List

Step Procedure Comments

1 Open the Add Peaks to List dialog 
box.

In the side bar, click on the Add Peaks to List  icon. • Or, right-click the graph area and select 
Add Peaks to List .
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2 Select and add signals. 1 In the Add Signals from area, select all traces 
except the ambients.

2 In the Compare to  area, choose the limit line to 
which you are testing. 

3 Check the Use Margin  box; set the margin to the 
desired level (−6 dB is the default setting).

4 Set Peak Excursion  to the desired level (10 dB 
is the default setting).

5 Click Add .

• For example, EN 55022; Class B 
Radiated (10 m) w/preamp. The signals 
above the limit line margin are added to 
the list. The Trace Name column in the 
Signal List table shows the trace from 
which each signal is generated.

• The larger the excursion value, the fewer 
signal will be captured. The smaller the 
excursion value, the more signals will be 
captured. If the peak excursion value is 
set too low, noise will be captured and 
interpreted as a signal. It is best to select 
peak excursion values high enough not to 
capture noise but low enough to still 
capture the signals of interest.

Procedure 4-8 How to Generate EUT Signal List

Step Procedure Comments
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Reduce Data
(Initial Data Reduction)

The signal list contains ambient signals and EUT emissions.

The initial data reduction process consists of two steps:

1. Delete all known ambients

2. Hide all lower duplicates

NOTE Further data reduction will be performed during the “Reduce Data (Initial
Data Reduction)” process on page 4-33.

Procedure 4-9 How to Reduce Data

Step Procedure Comments

1 Activate Ambient List 1 Select Setup, Ambient List . Check the ambient 
list you want to be active.

• Choose the ambient list that corresponds 
to your test site.
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2 Add signal attributes to the signal 
list.

1 Open the List Settings  dialog box; 
Setup > List Settings... .

2 Use the right and left arrow buttons to move 
highlighted attributes from one side to the other.

3 Highlight Potential  Ambient , Ambient , and 
Duplicate  in the Select Columns to Show  list 
and click the right arrow button. (Remove Avg .)

4 Reorder as desired.

5 Click OK.

• Alternatively, double-click to move 
highlighted attributes from one side to the 
other.

• The left-hand list (Select Columns to 
Show ) holds attributes that are available 
for listing, but will not be included in the 
list.

• The right-hand list (Selected Columns ) 
hold attributes that will be displayed in the 
signal list table. Use the up and down 
button to arrange the columns in the list.

• For a Potential Ambient, a Yes is placed in 
the signal row if the signal matches (within 
the frequency uncertainty) an ambient in 
the active ambient list. The ambient list 
was created in a previous step.

Procedure 4-9 How to Reduce Data

Step Procedure Comments
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3 Sort and filter signals. 1 Open the List Settings  dialog box.; 
Setup  > List Settings....

2 Click on the Signal Filter  tab.

3 Clear (uncheck) the No Filter  check box.

4 Check Show Higher Duplicates .

5 Set % of Frequency Uncertainty .

6 Clear Show Ambients .

7 Click the Over radio button in the Display 
Signals  area.
Select the limit line, set margin to −6dB, and use 
the Peak  detector.

8 Check the Sort Signals by  check box.
Choose Peak and Descending .

9 Click OK.

• Only the highest amplitude duplicate 
signals are displayed in the signal list.

• Default = 20%. The higher the percentage 
setting, the more likely signals will match 
as duplicates. Therefore, the higher the 
setting, the greater the data reduction with 
increased risk of masking an EUT signal. 
See Signal Matching Criteria in the 
glossary for more information.

• The signal list is reduced to show only 
suspect EUT signals and to hide lower 
duplicates.

Procedure 4-9 How to Reduce Data

Step Procedure Comments
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Signal Identification, Maximization and Measure
Process

This section is composed of three basic steps that must be performed on
signal in the signal list sequentially. These steps are signal identification,
maximization and then measuring.

1. Signal Identification
In this step you will use various means to attempt to identify if the sign
in the list is an ambient or is an emission from your EUT. If this signal
an ambient, of course you can choose to ignore it, but if it is a signal
from your EUT you will want to maximize and measure it. The basic
techniques to identify a signal are turning the EUT power on and off,
listening to the signal using the demodulation capabilities of the receiver
and rotating the turntable to see if table rotation changes the behavio
the emission.

2. Maximization
In this step you will rotate the turntable and vary the antenna height a
polarization until the EUT emission is at its highest amplitude. You w
then record the turntable orientation, antenna height and polarization
the Table, Tower and Polarity columns of the list.

3. Measure
In this step you will measure the EUT emission amplitude using the
appropriate detectors (usually Peak and Quasi-Peak) and dwell time
appropriate for your emissions characteristics.

Each signal in the list should go through each of these steps using the
following procedure.
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Preparation

Procedure 4-10 Preparing to Perform the Signal Identification, Maximization and
Measure Process

Step Procedure Comments

1 Move the EUT to the distance 
specified by the regulation.

Move the EUT to the distance specified by the 
regulation.

2 Add antenna height, polarity and 
table position columns to signal 
table.

1 Open the List Settings  dialog box; click 
Setup > List Settings...

2 While holding the <Ctrl>  key, highlight Table, 
Tower  and Polarity  in the Select Columns to 
Show  list.

3 Click on the right arrow key to add to the 
Selected Columns list.

4 Reorder the columns if desired.

5 Click OK.

• When you have maximized each signal, 
edit these columns with the appropriate 
information.
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3 Set the span for automatic tuning of 
the receiver to 2 MHz.

1 Select Tools > Options... > Tune/Demod.

2 Select Fixed Span: and set to 2 MHz.

3 Click OK.

• Other spans may be used if they are 
better for your application. Note that if 
Span Based on Frequency Uncertainty  
is selected that the span will vary based 
on the frequency uncertainty of the 
receiver when that specific signal was last 
measured.

Procedure 4-10 Preparing to Perform the Signal Identification, Maximization and
Measure Process

Step Procedure Comments
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Signal Identification The following process outlines three basic steps that may be used to iden
if the signal in your list is an ambient or if it is an EUT emission. If the signa
is an ambient it may simply be deleted. If it is an EUT emission, you will
want to proceed on to the maximization process.

Procedure 4-11 Signal Identification Process

Step Procedure Comments

1 Enable automatic tuning in the 
application.

Check the Tune box. • When the Tune  box is checked, if you 
click on a signal in the list, the receiver will 
automatically be tuned to that signal.

2 Position the turntable, antenna height 
and polarity.

Position the turntable, antenna height and polarity 
to the position where you are most likely to observe 
the EUT emission.

The next three steps are optional steps what will 
help you identify whether the signal is an ambient 
or an EUT emission.

• If you have used the trace naming 
convention suggested in these examples, 
the turntable angle, antenna height and 
polarity where the maximum emissions 
was observed will be captured in the trace 
name.

3 Turn the EUT Off then On. 1 Turn the EUT off then on while observing the 
signal. If the signal is an EUT emission it should 
disappear when the unit is off and reappear 
when the unit is on.

2 If the signal is an EUT emission go to procedure 
4-12 Maximization Process.

• Note that this technique may not be 
possible to use if the device that you are 
testing has a long power up time or if the 
emission is due to a specific instrument 
state that is not repeatable upon power 
up.

4 Listen to the signal by activation 
Demod.

1 Check the Demod  box on the receiver.

2 Click on the signal in the list to activate the 
Demod function (click on the column number). 

3 Listen to the signal to determine if it is a local TV 
or radio signal.

4 If the signal is an EUT emission go to procedure 
4-12 Maximization Process.

• You may turn demod off by unchecking 
the Demod box and clicking on the signal 
in the list.

• You may need to turn the volume knob up 
on the receiver.

5 Vary the turntable orientation 1 Vary the turntable angle while observing the 
amplitude of the signal.

2 If the signal is and EUT emission go to 
procedure 4-12 Maximization Process.

• If the signal is an emission from the EUT 
and the radiation pattern exhibits lobes, 
the amplitude of the signal will vary in a 
way that correlates to the turntable angle.

6 If the signal is an ambient, add it to 
the ambient list or delete it.

To add the signal to the active ambient list: 
Highlight the signal in the list. Right click  and 
choose Save to Ambient List.

If you simply wish to delete the signal: Highlight the 
signal in the list then press the Delete key.

If the signal is an ambient, continue to next 
signal.
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Maximization In this step you will rotate the turntable and vary the antenna height and
polarization until the EUT emission is at its highest amplitude. You will hav
the opportunity to reposition the marker on the signal to update the signa
frequency if necessary. You will then record the turntable orientation,
antenna height and polarization in the Table, Tower and Polarity columns
the list.

Procedure 4-12 Maximization Process

Step Procedure Comments

1 Position the turntable, antenna height 
and polarity

1 Position the turntable, antenna height and 
polarity to the position where you are most likely 
to observe the EUT emission.

• If you have used the trace naming 
convention suggested in these examples, 
the turntable angle, antenna height and 
polarity where the maximum emission 
was observed will be captured in the trace 
name.

2 Rotate the turntable from 0 −360 
degrees to find the maximum 
response.

1 Move the table to maximize the signal on the 
receiver.

2 You may use Max Hold  on the receiver bar as an 
aid to find the maximum response.

• Leave the table in the position with the 
maximum response.

3 Adjust the antenna polarization and 
height to find the maximum 
response.

1 Adjust the antenna polarization and height for 
the maximum signal response.

2 You may use Max Hold  on the receiver bar as an 
aid to find the maximum response.

• Leave the antenna polarization and height 
in the position with the maximum 
response.

4 Reposition the marker to update the 
list frequency if required for 
measurement.

1 If the marker needs to be re-centered on the 
signal before measurement, do these steps. 
Otherwise skip to the next step.

2 Use the receiver knob to position the marker on 
the signal. 

3 Click Get Receiver Marker  on the receiver bar 
to add the new marker position to the list.

4 Press the Delete key to delete the old signal in 
the list.

5 Click on the new signal added to the list to tune 
the receiver to the updated signal frequency.

• Sometimes the marker will need to be 
repositioned on the signal to measure due 
to EUT frequency drift or receiver 
frequency uncertainties.

• The new marker frequency will be placed 
in the list just below the highlighted signal 
that you are currently tuned to.

5 Record the turntable, antenna height 
and polarization.

1 Record the turntable orientation in the Table  
column in the list. 

2 Record the antenna height in the Tower  column 
in the list.

3 Record the antenna polarization in the Polarity  
column in the list.
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Measure In this step you will measure the EUT emission amplitude using the
appropriate detectors (usually Peak and Quasi-Peak) and dwell times
appropriate for your emissions characteristics.

Procedure 4-13 Measure Process

Step Procedure Comments

1 Measure the signal. 1 Open the Measure  dialog box by clicking the 
Measure  icon in the side bar.

2 In the Measure From List  area, select the 
Measure selected signals  option.

3 in the Detectors  area, check the Peak and 
Quasi-Peak  detectors.

4 In the Detectors  area, set the Dwell Time  for 
each detector selected.

5 Click Run  to begin the measurement.

• The default dwell time will be adequate of 
measuring most emissions. If the signal 
that you are measuring has a low 
repetition rate or is intermittent in nature 
you may need to increase the dwell time 
to capture at least two repetitions in order 
to accurately measure it. If the dwell time 
is increased for any of the detectors, you 
must also increase the autorange Sweep 
Time  to be equal to or greater than the 
longest dwell time of the selected 
detectors. The Autorange Sweep Time  
may be set by clicking the Receiver 
Settings  tab in the Measure dialog box 
and setting in the Autorange Sweep 
Time.
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for
Continue to Next
Signal

Continue with the next signal and repeat procedures 4-11, 4-12, and 4-13
every signal in your list.

When complete, you should have a list of only your identified, maximized
and measured EUT emissions. If you wish to rearrange or add or delete
columns in your list before creating a report refer to How Do I...”Customize
Signal Lists, page 5-46”

To create a report refer toGenerate Reports, page 5-44.
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In This Chapter…

• Setup Tests, page 5 -2

� Enter Test Header Information, page 5 -6

� Use Limit Lines, page 5 -7

� Add and Setup Test Equipment, page 5 -15

� Use Signal Paths, page 5 -25

� Use Ambient Lists, page 5 -27

• Use the Sweep, Add Peaks to List and Measure Functions, page 5 -33

� Setup and Perform Sweeps, page 5 -34

� Add Signals to the Signal List, page 5 -38

� Make Measurements, page 5 -40

• Generate Reports, page 5 -44

• Customize Signal Lists, page 5 -46

• Customize Graph and Trace Data, page 5 -57

• Use Receiver Functions, page 5 -65

� Retrieve Information from the Receiver, page 5 -66

� Use Command Logger, page 5 -67

• Characterize Cables, page 5 -68
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Open and Save Test
Setups

Test setups contain the operational test parameters. Several test setups
included with HP E7415A application. Additional test setups can be crea
(or existing test setups modified) to meet your particular requirements.

Test Setups include:

• Limit Lines

• Equipment Setup

• Signal Path

• Ambient Lists

• Graph Settings

• Signal List Settings

• Sweep Settings

• Measure Settings

• Report Settings

• Receiver Settings
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Procedure 5-1 How to Open a Test Setup

Step Procedure Comments

1 Open the Select Test 
Setup dialog box.

Open the HP E7415A application.

OR

If the application is currently open, from the main 
menu, click File > New.

OR

If the application is currently open, from the main 
menu, click File  > Open.

• Select New  to open an existing test setup without data. 
(Use the test setup only.)

• Select Open  to open an existing test setup with data. 
(Use the test setup and data from a previous test.)

2 Select a set of 
compliance regulations

1 From the Folder:  combo box, select a set of 
compliance regulations (folder).

2 Select the regulation to which to test.

3 Click OK. See list of attributes “Test Setups 
include:” on page 5-4.

• There are various folders under which are related 
compliance regulations, for example VCCI Setups .

• For example, VCCI; Conducted Cl ass 1 .

• The applicable limit lines will display on the graph.
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Procedure 5-2 How to Save a Test Setup

Step Procedure Comments

1 Save the test setup. 1 From the menu bar, select File > Save As 
Setup... .

2 In the Save Test Setup  dialog box, select the 
desired folder from the drop-down list or type in a 
new folder name

3 In the Setup Name : text box, enter a new name 
for your test setup or select a test setup from the 
list, then press Save.

Test Setups include:

• Limit Lines

• Equipment Setup

• Signal Path

• Ambient Lists

• Graph Settings

• Signal List Settings

• Sweep Settings

• Measure Settings

• Report Settings

• Receiver Settings

• The Save Test Setup  dialog box displays.

• To later access the new setup, select File > New . 
Select the folder and highlight the setup name, then 
click OK.

• Use Save As Setup...  to save test-setup without data. 
Setup parameters include: limit lines, equipment, signal 
path definitions, ambient lists (if any), graph and signal 
list settings, and sweep and measure settings 
associated with the test setup.

• Use Save As...  to save the current test, which includes 
the test data and the test setup.
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Procedure 5-3 How to Maintain Test Setups

1 Open Test Setup 
Maintenance Window.

From the Menu bar choose
File  > Test Setup Maintenance .

2 Perform maintenance 
tasks.

 Arrange test setups 

Delete test setups.

Delete setup folders.

Add a description in the Description: text box 
(optional).

• Highlight a test setup name then use the up and down 
arrow buttons to reposition the highlighted test name.

• Highlight the desired test setup name then click the 
Delete Setup button (the second button from the right).

• Highlight the desired folder in the Folder drop-down list 
box then click the Delete Folder button (the first button 
from the right).
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Enter Test Header
Information

Test header information is saved with a test and can be included in repor

Procedure 5-4 How to Create a Test Header

Step Procedure Comments

1 Open the Test Header 
window.

In the side bar, click the Setup  button then the 
Header  icon.

• The header information can be included in a report and 
saved with a test.

2 Fill in the test header 
fields.

Place the cursor in each header field and type.

Fields include:

Customer Name

Project Number

Operator Name

EUT Name

Date Created

Date Modified

Description

• Name of the customer for whom measurements are 
being performed

• Number for tracking tests associated with a particular 
EUT (Equipment Under Test)

• Name of the person conducting the test

• A description of the EUT

• The date on which the test was started or first saved 
(non-editable)

• The date on which the test was last modified 
(non-editable)

• Any information you choose to associate with the test

3 Verify header settings. Click on Show Setup  in the side bar to verify header 
settings.
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Use Limit Lines Limit lines provide the capability to compare measured signal data to a
specified limit and determine if the signals pass or fail. Limit lines (or limi
line margins) can also be used as thresholds to eliminate unwanted nois
signals that are below a particular amplitude.

A library of the most common limit lines is provided with the measureme
application; however, you can create your own custom limit lines that bes
suit your needs.

NOTE Limit lines are associated with test setups. Associated limit lines are load
when a test setup is selected.

Procedure 5-5 How to Select Limit Lines

Step Procedure Comments

1 Open the Limit Lines 
folder.

In the side bar click the Setup  button then click the 
Limit Lines  icon.

• The left pane contains subfolders that are named for 
the different regulations (for example, EN55011 Limits). 
Inside each subfolder are the limit lines supplied with 
the application. You can create new subfolders for 
additional limit lines. In addition, you can add new limit 
lines under new or existing subfolders.

• The right pane is the property sheet for the limit line 
highlighted in the left pane. You can view the 
parameters of an existing limit line, copy and modify 
applicable parameters of an existing limit line to create 
a new limit line, or define a new limit line starting with a 
blank property sheet.

2 Select limit lines. Click the boxes proceeding each limit line to check 
(include) or clear (do not include) the limit line within 
the current test setup.

• See “How to Create a New Limit Line” on page 5-8 for 
information on adding or modifying limit lines.
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Procedure 5-6 How to Create a New Limit Line

Step Procedure Comments

1 Open the Limit Lines 
folder.

In the side bar click the Setup  button then click the 
Limit Lines  icon.

• The left pane contains subfolders that are named for 
the different regulations (for example, FCC Part 15 
Limits). Inside each subfolder are the limit line names 
supplied with the application. You can create new 
subfolders for additional limit line names and add new 
limit line names under new or existing subfolders.

• The right pane is the property sheet for the limit line 
highlighted in the left pane. You can view the 
parameters of an existing limit line, modify applicable 
parameters of an existing limit line to create a new limit 
line, or define a new limit line starting with a blank 
property sheet.

2 (Optional) Create a new 
Limit Line subfolder.

1 Highlight the Limit Lines  folder, then right-click 
and select New Folder .

2 Right-click Untitled Folder and select Rename .

3 Type a name for the new subfolder.

4 Press [Enter] .

• A new folder (Untitled Folder) is added under the Limit 
Lines  folder.

• Or, click once to enter edit mode.

• For example, Custom Limit Lines . 
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3 Create and name the 
new limit line.

1 Right-click the subfolder to add a new limit line 
and select New Limit Line .

2 Right-click Untitled Limit Line and select 
Rename .

3 Type a name for the new limit line then press 
[Enter] .

4 In the Name on graph  text box, replace Untitled 
Limit Line with a name for the new limit line name.

5 Press [Enter] . 

• An “Untitled Limit Line” placeholder is added under the 
selected subfolder and a blank limit line property sheet 
appears in the right pane.

• Or, click once to enter edit mode.

• For example, Measurement System
Threshold .

• The title of the property sheet changes to reflect the 
new limit line name. This name appears on the graph.

• Newly created limit lines are automatically checked.

4 Define the new limit line 
in the property sheet.

1 Under Interpolation , select the appropriate 
frequency and amplitude scale (Linear  or Log ) 
for your limit line (Log  is the default). 

2 In the Frequency Units drop-down list, select the 
appropriate units (MHz is the default).

3 In the Amplitude Units  drop-down list, select the 
appropriate units (dBµV is the default).

4 In the Default Margin  text box, enter the limit line 
margin (–6 dB is the default value).

• See glossary for interpolation information.

• Enter a negative value to set the margin below the limit 
line. Enter a positive to set the margin above the limit 
line.

• The margin displays on the graph with the limit line.

5 Enter start and stop 
frequency and amplitude 
for each limit line 
segment.

1 Click in the Start Frequency table cell in row 1 
and enter the start frequency (for example 30 ).

2 Use [Tab]  to move the cursor to the Start 
Amplitude  table cell and enter the start 
frequency amplitude (for example, 39 ).

3 Tab to the Stop Frequency  table cell and enter 
the stop frequency for this limit line segment (for 
example, 88 ).

4 Tab to the Stop Amplitude  table cell and enter 
the stop frequency amplitude (for example, 39 ).

5 Press the Enter  key after each limit line segment 
is added to save the limit line segment.

• Limit lines are constructed in the following manner:

1 Each point is defined by a frequency value and 
amplitude value (called the frequency/amplitude pair).

2 Two points define a line segment.
NOTE: The Start Frequency value must be smaller 
than the Stop Frequency  value.

3 One or more line segments placed in sequence define 
a limit line.
Therefore, one or more start/stop frequency pairs 
define a limit line.

• Editing the frequency and amplitude values of the 
displayed limit lines will update the graphs to reflect the 
limit line edits.

Procedure 5-6 How to Create a New Limit Line (Continued)

Step Procedure Comments
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Limit Lines

Procedure 5-7 How to Import a Limit Line

Step Procedure Comments

1 Set the appropriate 
delimiter type for the 
import file.

1 From the Menu bar select Tools  > Options .

2 Select the General  tab.

3 Set the delimiter type.

• Before you can import limit line segments, the file must 
meet five conditions:
• Correction factors must contain only ASCII data.
• Correction factors must be entered as frequency and 
amplitude pairs.
• Frequency and amplitude pairs must be separated by 
commas, tabs, spaces, or semicolons.
• [DATA} must be included as a header (see step 2).
• The file name extension must be “lim”.

• It is recommended that you first export an existing Limit 
Line, then edit the file as required. The file can then be 
saved with a different name and imported as needed. 
Use WordPad  to edit the file. See “How to Export a 
Limit Line” on page 5-12.
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2 Edit Limit Line file. 1 [DATA] must be included as a header immediately 
above the first frequency/amplitude pair.
Other headings are optional.

2 Save file with a lim  extension.

• To view the Limit Line file layout, export an existing 
Limit Line and open with WordPad.

• Enter descriptive notes under [DESCRIPTION].

• Enter Header information such as units, interpolation, 
margin, and delimiter type under [HEADER].

• Enter data under [DATA] with the appropriate delimiter. 
Place each limit line segment per row.

• Use WordPad  rather than NotePad when editing limit 
lines.

• The limit line file can include interpolation and units 
information; see figure.

• It may be necessary to change the extension of the 
saved file from txt  to lim  using the system file manager 
(such as Windows Explorer).

Procedure 5-7 How to Import a Limit Line (Continued)

Step Procedure Comments
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3 Importing Limit Line 
data.

1 From the side bar, click on the Setup  bar.

2 Click on the Limit Line  icon.

3 Choose a Limit Line title (or create a new limit line 
name, see “How to Create a New Limit Line” on 
page 5-8).

4 In the Interpolation area, specify either a Linear  
or Log  frequency axis.

5 In the Units  area select the Frequency  and 
Amplitude  units.

6 Click the Import  button. Find and open the limit 
line file to import. 

7 Verify start/stop amplitude/frequency values in the 
new limit line property sheet.

• The Limit Line file can contain header information 
which includes Limit Line title, interpolation type, units, 
and delimiter type (see the figure in step 2). Use the 
property sheet to overwrite fields as desired.

Procedure 5-7 How to Import a Limit Line (Continued)

Step Procedure Comments

Procedure 5-8 How to Export a Limit Line

Step Procedure Comments

1 Set the appropriate 
delimiter type for the 
export file.

1 From the Menu bar select Tools  > Options .

2 Select the General  tab.

3 Set the delimiter type.

4 Click OK.

• The export file will include three conditions:
• Correction factors will contain only ASCII data.
• Correction factors will be saved as frequency and 
amplitude pairs.
• Frequency and amplitude pairs will be separated by 
the selected delimiter.
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2 Export Limit Line data. 1 Click on Setup  folder.

2 Click on the Limit Line  icon.

3 Choose a Limit Line title.

4 Click on the Export  button.

5 In the Export Limit Line window enter a 
descriptive file name in the File Name  area then 
click Save .

• The Limit Line data and header information (Limit Line 
title, interpolation type, units, and delimiter type) are 
saved to the file.

Procedure 5-8 How to Export a Limit Line

Step Procedure Comments
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3 Verify the Limit Line 
data.

Open the Limit Line file in WordPad and verify the 
data and header information.

Procedure 5-8 How to Export a Limit Line

Step Procedure Comments
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Add and Setup Test
Equipment

Test equipment is used to test EMI emissions. The equipment available
testing is listed under theEquipment folder. Additional equipment can be
added and setup for use.

Each signal path uses a selection of available test equipment and calcul
total path correction (see “Use Signal Paths” on page 5-25).

Test equipment setup data includes the following:

• Make

• Model

• Last calibration date

• Calibration due date

• Serial number

• Communication interface (receivers only)

• Bus address (receivers only)

• Communication library (all equipment with the exception of receivers
only)

• Corrections (except receivers)

• Notes
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Procedure 5-9 How to Add and Setup a New Receiver

Step Procedure Comments

1 Open the Equipment 
folder.

In the side bar, click the Setup  button then click the 
Equipment  icon.

• Notice that the left pane displays a list of equipment 
subfolders.

2 (Optional) Add a 
receiver.

1 Highlight the Receiver  subfolder.

2 In the right pane, click on the receiver to add.

3 Click Add .

• Notice that the right pane displays the receiver drivers 
available for configuration and the left pane displays the 
receivers already configured for use.

• Adds receiver to receiver folder.

• The receivers listed under the Receiver  subfolder have 
already been configured for use in a test setup. 
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3 Locate the receiver to 
configure.

1 Double-click the Receiver  subfolder to open it.

2 In the Receiver  subfolder, click on the receiver 
you want to edit.

• Or click + next to receiver subfolder.

• Notice that the right pane contains the property sheet 
for the selected receiver.

4 (Optional) Copy and 
rename the receiver.

1 Right-click on a receiver and choose Duplicate .

2 Right click on the copy of the chosen receiver and 
choose Rename.

3 Type in the name for your modified receiver.

4 Press Enter.

• The duplicated receiver has the same properties as the 
copied receiver.

• Make sure you select the copy of the receiver.

5 Configure the receiver. Make any changes necessary to the property sheet 
for your specific receiver.

• For example, calibration dates, bus address, and 
communication interface.

• The Serial Number  will update automatically in 
“Connect the receiver.”

6 Connect the r eceiver. 1 Connect the receiver to your PC via an interface 
cable.

2 Click the Check Device  button to verify that the 
receiver is properly connected and configured.

• If the communication fields have been correctly entered 
and the interface cable properly installed between the 
PC and the receiver, then device communication 
should be successfully verified.

• The Serial Number  will be updated if the field is left 
blank.

Procedure 5-9 How to Add and Setup a New Receiver (Continued)

Step Procedure Comments
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Procedure 5-10 How to Add and Setup a Transducer (The procedure is similar for any
other non-receiver test equipment)

Step Procedure Comments

1 Open the Equipment 
folder.

In the side bar, click the Setup  button then click the 
Equipment  icon.

• Notice that the left pane displays list of equipment 
subfolders.

2 (Optional) Create a new 
transducer.

1 Double-click the Transducers  subfolder to open 
it.

2 Highlight the Transducer subfolder, then 
right-click and select New Transducer .

3 Right click the new transducer and select 
Rename . Enter a name for the new transducer 
(for example, SN 4564 Log Periodic ). 

4 Press [Enter] to accept the changes.

• The transducers listed in the Transducer  subfolder 
have been supplied with the application. They contain 
correction factors that are typical for that type of 
transducer. 

• If you have the same device as one supplied with the 
application, (for example, a log periodic antenna) you 
can modify the existing property sheet with the specific 
data for your device. Click on the applicable transducer 
name within the left pane to highlight it, then right-click 
and select Duplicate . A copy of the transducer is 
added to the bottom of the subfolder. Enter a new name 
for the device (by right clicking the new Transducer and 
selecting Rename ), then edit the appropriate fields of 
the property sheet.

• The title on the property sheet shows the new 
transducer name.

3 Edit the transducer 
parameters in the 
property sheet.

Make any changes necessary to the property sheet 
for your specific transducer. (See next step for 
entering correction factors.)

• Use the data sheet supplied with your transducer to edit 
the appropriate fields (for example: make, model, serial 
number, calibration dates).
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4 Enter the correction 
factors using either of 
two methods: importing 
from a file or entering 
factors manually.

Importing correction factors:

Use the procedure “How to Import Correction 
Factors” on page 5-20.

Entering correction factors manually:

1 In the Interpolation area, specify either a Linear  
or Log  frequency axis.

2 In the Units area select the Frequency  and 
Amplitude  units.

3 In the Corrections  table, click on the first 
frequency column and enter the first frequency on 
the data sheet. (For example, 30 (MHz) would 
most likely be the first frequency entered for a 
Biconical antenna).

4 Use the [Tab]  key to move the cursor to the 
amplitude column and enter the corresponding 
amplitude. (For example, 14.65  (dB)).

5 Press [Enter]  to get to the next row 
(frequency/amplitude pair).

6 Repeat steps 3 through 5 for each frequency 
amplitude pair.

• Make these selections based on the parameters used 
in the data sheet. See Interpolation in the Glossary for 
more information. 

• Make these selections based on the parameters used 
in the data sheet.

• Corrections for loss should be positive values and 
corrections for gain should be negative values.

• Once you have entered all of the correction factors, you 
may want to save the data to a text file for external use. 
To do this, click the Export  button. You can select the 
separator (comma, tab, space, or semicolon) used for 
the table data in the Tools  > Options  menu under the 
General  tab. See “How to Export Correction Factors” 
on page 5-22.

Procedure 5-10 How to Add and Setup a Transducer (The procedure is similar for any
other non-receiver test equipment) (Continued)

Step Procedure Comments
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Import and Export Corrections

Corrections (correction factors) are a set of frequency/amplitude pairs th
characterize a device over frequency. The amplitudes are negative for ga
(at an associated frequency) and positive for loss (at an associated
frequency). Signal paths add the corrections of all equipment active in th
path and provide the total correction to the receiver.

Procedure 5-11 How to Import Correction Factors

Step Procedure Comments

1 Set the appropriate 
delimiter type for the 
import file.

1 From the Menu bar select Tools  > Options .

2 Select the General  tab.

3 Set the delimiter type.

• Before you can import correction factors, the file must 
meet five conditions:
• Correction factors must contain only ASCII data.
• Correction factors must be entered as frequency and 
amplitude pairs.
• Frequency and amplitude pairs must be separated by 
commas, tabs, spaces, or semicolons.
• [DATA] must be included as a header (see step 2).
• The file name extension must be “ant” for transducer 
correction factors and “cbl” for all other equipment.

• It is recommended that you first export an existing 
correction factors file, then edit the file as required. The 
file can then be saved with a different name and 
imported as needed. Use WordPad  to edit the file. See 
“How to Export Correction Factors” on page 5-22.
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2 Edit correction factor 
file.

1 [DATA] must be included as a header immediately 
above the first frequency/amplitude pair.

2 Save file with an ant  or cbl  extension.

• Enter notes under description.

• Enter Header information such as device name, serial 
number, make, and model under [HEADER].

• Enter data under [DATA] with the appropriate delimiter. 
Place each correction factor per row.

• Use WordPad  rather than NotePad when editing limit 
lines.

• The correction factor file can include interpolation and 
units information; see figure below.

•

•

• It may be necessary to change the extension of the 
saved file from txt  to ant or cbl using the system file 
manager (such as Explore).

3 Select the equipment 
and import corrections.

1 In the side bar, select Setup  and then click the 
Equipment  icon.

2 Choose the appropriate equipment subfolder and 
highlight the equipment for which you want to 
import correction factors.

3 In the right panel, click Import . Find and open the 
appropriate corrections file to import. 

• Receivers do not have any correction factors.

Procedure 5-11 How to Import Correction Factors (Continued)

Step Procedure Comments
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Procedure 5-12 How to Export Correction Factors

Step Procedure Comments

1 Set the delimiters. 1 From the Menu Bar select Tools  > Options .

2 Select the General  tab.

3 Choose the delimiter to use.

• The export file will include three conditions:
• Correction factors will contain only ASCII data.
• Correction factors will be saved as frequency and 
amplitude pairs.
• Frequency and amplitude pairs will be separated by 
commas, tabs, spaces, or semicolons.
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2 Export Corrections data. 1 Click on Setup  folder.

2 Click on the Equipment  icon.

3 Choose the desired equipment.

4 Click on the Export  button.

5 In the Export Correction Factor window enter a 
descriptive file name in the File Name  area. • The Corrections data and header information (title, 

interpolation type, units, and delimiter type) are saved 
to the file.

Procedure 5-12 How to Export Correction Factors (Continued)

Step Procedure Comments
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3 Verify the correction 
factor data.

Open the correction factor file in WordPad and verify 
the data and header information.

Procedure 5-12 How to Export Correction Factors (Continued)

Step Procedure Comments
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Use Signal Paths Signal paths contain the equipment used in the test process.
The signal path calculates the total path correction as the sum of the
equipment corrections defined and active (checked) in the signal path. T
total path correction is sent to the receiver.

Procedure 5-13 How to Select Signal Paths

Step Procedure Comments

1 Open the Signal Path 
folder.

In the side bar, click the Setup  button then click the 
Signal Paths  icon.

• The left pane is the resource list, which lists the signal 
paths that are defined and available for use. The right 
pane is the property sheet, which lists all of the defined 
equipment available for creating a signal path. (The 
right pane displays a property sheet when a device is 
highlighted under the signal path in the left pane.)

• The signal paths with w/Preamp  in the name contain 
an external preamplifier in the signal path.

2 Select signal paths. Click the boxes preceding each signal path to check 
(include) or clear (do not include) the signal path.

• Checked signal paths are included in the receiver bar 
Signal Path  pull-down list.

• See “How to Create a New Signal Path” on page 5-26 
for information on adding or modifying signal paths.
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Procedure 5-14 How to Create a New Signal Path

Step Procedure Comments

1 Open the Signal Path 
folder.

In the side bar, click the Setup  button then click the 
Signal Paths  icon.

• The left pane is the resource list, which lists the signal 
paths that are defined and available for use. The right 
pane is the property sheet, which lists all of the defined 
equipment available for creating a signal path. (The 
right pane displays a property sheet when device is 
highlighted under the signal path in the left pane.)

2 Create a new signal 
path.

1 In the left pane, highlight the Signal Paths 
subfolder, then right-click it and select New 
Signal Path .

2 Right click on Untitled Signal Path and select 
Rename . Enter a descriptive signal path name 
(for example, E7415 bicon with
preamp ).

3 Press [Enter] to accept the changes.

• An Untitled Signal Path subfolder is added under the 
Signal Paths subfolder. 

• The new signal path is automatically checked for use 
within test setups.

3 Add receivers and other 
components to the new 
signal path.

1 In the right pane, double click the Receiver  folder 
to display the defined receivers. 

2 Highlight the desired receiver, then click Add .

3 Highlight and add each component needed to 
create your signal path. 

• The devices added to signal paths are automatically 
checked for use within the signal path.
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Use Ambient Lists When making conducted and radiated measurements, you may encount
ambient signals that mask the EUT emissions. This masking may yield
erroneous test results, lengthen test time, and lead you to mistakenly reco
high-level ambient signal as a worst-case emission.

During conducted emission tests, if ambient signals appear above the lim
line on the display, try using a shorter interconnecting power cord, or try
shielding the power cord. Do not use a ferrite core around the power cord
this may attenuate common mode signals coming from the EUT and thu
give false readings.

In most cases, you will not be able to eliminate all of the ambient signals
reconfiguring your test setup. You can create an ambient list that lets you
compare ambient signals against the EUT emissions by sweeping the
frequency range of interest with the EUT turned off. To correctly identify
signal as an ambient or as an emission, it is important to record ambient
signals with good frequencyaccuracy. (The better the frequency accuracy,
the less chance that two signals close together will be identified as one
signal.)

Because the Sweep function provides better frequency accuracy (that is
reduced frequency uncertainty) than the Get Receiver Trace function, use
Sweep function to measure the ambient signals.

NOTE Many ambient signals are intermittent and can fluctuate greatly in
amplitude. Therefore, an ambient signal list is only 100% accurate in the
instance at which it is generated. Over time, as you encounter other amb
signals, you may add them to the ambient list.
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Procedure 5-15 How to Select an Ambient List

Step Procedure Comments

1 Open the Ambients List 
folder.

In the side bar, click the Setup  button then click the 
Ambient Lists  icon.

2 Select ambient list. Click the box preceding the ambient list to check (to 
activate) or clear (to deactivate) the ambient list.

• When an ambient list is selected, it will be displayed in 
the signal list.

• See “How to Create a New Ambient List” on page 5-29 
for information on adding or modifying ambient lists.
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Procedure 5-16 How to Create a New Ambient List

Step Procedure Comments

1 Open the Ambients List 
folder.

In the side bar, click the Setup  button then click the 
Ambient Lists  icon.

2 Create and name the 
new ambient list.

1 Highlight the Ambients List folder and right-click 
and select New Ambient List .

2 Click on the new ambients list and enter a new list 
name (for example, OATS_1 Ambients ).

• An Untitled Ambients List is added under the Ambient 
Lists folder.

• This ambient list is active.
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3 Sweep for Ambients. 1 In the side bar, click the Test  button then click the 
Sweep  icon.

2 In the Sweep dialog box, set the start frequency 
and stop frequencies as outlined in the regulation 
to which you are testing and the transducer used. 

3 Enter 3 for number of sweeps to capture 
intermittent ambients.

4 Enter a trace name in the Output Trace text box.

5 Click Run . 

6 Make certain that the receiver is not in an 
overload condition (see your instrument’s user 
manual).

• For example, for measurements made with a biconical 
antenna the start frequency would be 30  MHz and the 
stop frequency may be 300  MHz.

• For example, OATS_1 Ambients .

Procedure 5-16 How to Create a New Ambient List (Continued)

Step Procedure Comments
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4 Define the peak 
parameters for 
ambients.

1 In the side bar, click the Add Peaks to List  icon. 

2 In the Add Peaks to List dialog box, increase the 
Peak Excursion criteria to 20  dB (default = 10). 

3 Clear (uncheck) Use Margin  and then click Add .

• All signals that rise and fall 20 dB above the noise floor 
will be added to the signal list.

5 Add signals to active 
ambient list.

1 In the Signal List table, double-click on the Peak 
column header to sort the signal list by highest 
peak amplitude. 

2 In the numbered column, click and drag on the 
first 20 signals to highlight them.

3 Right-click in the Signal List Table and select 
Save to Ambient List .

• Double-clicking on a column header sorts the list table 
by toggling between ascending or descending order.

• You must decide how many signals to add to the 
ambient list. One method is to select signals that are 
within a certain amplitude of the limit line (for example, 
10 dB). For this example we will add the first 20 signals 
with the highest amplitude.

• The selected signals are saved to the active ambient 
list.

• Ambient signals are displayed in blue print in the signal 
list.

• Review the contents of the active ambient list by 
clicking on the Setup  button, then the Ambient List  
icon. Highlight the ambient list name to view the 
contents in the property sheet.

• If there is not an ambient list enabled in the test setup, 
the application automatically creates an Untitled 
Ambient List and places the signals within this 
ambient list.

Procedure 5-16 How to Create a New Ambient List (Continued)

Step Procedure Comments
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Procedure 5-17 How to Add/Remove a Signal to/from the Active Ambient List

Step Procedure Comments

1 Add signals to ambient 
list.

1 Highlight the desired signal(s) in the signal list.

2 Right-click in the Signal List Table and select 
Save to Ambient List .

• The selected signals are saved to the active ambient 
list.

• Ambient signals are displayed in blue print in the signal 
list.

• Review the contents of the active ambient list by 
clicking on the Setup  button, then the Ambient List  
icon. Highlight the ambient list name to view the 
contents in the property sheet.

• If there is not an ambient list enabled in the test setup, 
the application automatically creates an Untitled 
Ambient List and places the signals within this 
ambient list.

2 Remove from ambient 
list.

1 Highlight the desired ambient signal(s) in the 
signal list.

2 Right-click in the Signal List Table and select 
Remove from Ambient List .

• The selected signals are removed from the active 
ambient list, leaving them in the signal list. 
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ll
Use the Sweep, Add Peaks to List and Measure
Functions

The Sweep, Add Peaks to List, and Measure functions can be used for a
your testing needs. With the versatility of the HP E7415A measurement
software, you can make an automated measurement beginning with the
initial sweep to final measurement using the detector called out in your
regulation.

The following procedures will show you how to customize and use these
functions to best suit your testing needs.
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swept
on
Setup and Perform
Sweeps

The Sweep function sets up the receiver to sweep the frequency range s
the sweep dialog box. The sweep function is comprised of multiplereceiver
sweeps, that is, the frequency range is segmented, and each segment is
in turn by the receiver. The composite of all receiver sweeps is displayed
the HP E7415A graph as a single trace.

Procedure 5-18 How to Setup and Perform a Sweep

Step Procedure Comments

1 Set the Sweep 
parameters.

1 In the side bar, click the Test button, then click the 
Sweep  icon.
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2 Place the cursor in each field and type.

Fields include:

Start Frequency

Start Frequency

Output Trace

Detector

Segment Overlap%

Signal Path

When Complete

Dwell for:

• The Start Frequency  and the Stop Frequency  define 
the frequency range that will be swept by the receiver.

• Set the start and stop frequencies to the range of the 
antenna which you are testing. More than one antenna 
may be needed to cover the radiated frequency range 
of the regulation to which you are using to perform the 
test. 
For example:
Set the start frequency to 30 MHz and the stop 
frequency to 200 MHz for a biconical antenna.
Set the start frequency to 200 MHz and the stop 
frequency to 1000 MHz for a log periodic antenna.

• Trace Name

• Detector used for sweep; Peak, Quasi-Peak, or 
Average. Use the Peak detector for initial scans.

• The percent overlap (% of uncertainty) between 
segments during the sweep process.

• Select the signal path to use from the active signal 
paths.

• Replace existing data  overwrites all data selected for 
the trace in the Output Trace  box.

• Add results to existing data (max hold) overwrites data 
for the selected trace only if data point is higher than 
existing data point.

• Increase dwell to capture intermediate signals.
Number of Sweeps : The application will sweep each 
segment the number of times set in the box before 
sweeping the next segment.
sec :The application will continue to sweep each 
segment for the amount of time set in the box before 
sweeping the next segment.
Video Average : Click the check box to perform.

3 Name and define the 
trace.

1 In the Output Trace  combo box, type a trace 
name.

2 Click on the color bar and select a color for the 
trace. 

3 Click OK to close the color palette.

Procedure 5-18 How to Setup and Perform a Sweep (Continued)

Step Procedure Comments
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4 Set up the receiver. 1 Open the Receiver Settings  tab within the 
Sweep dialog box.

2 Place the cursor in each field and type.

Fields include:

Auto All

RBW

VBW

Ref Level

Attenuation

Sweep Time

• Auto All sets the receiver as outlined in CISPR 
requirements.

• Resolution BandWidth. If set to Auto the application 
sets the RBW value as follows:
For measurements below 1 GHz the RBW is set to 120 
kHz. For measurements above 1 GHz the RBW is set 
to 1 MHz.
You can manually set the RBW as desired; decreasing 
the RBW will increase the resolution of signals close in 
frequency. (The sweep time will increase with decrease 
RBW.)

• Video BandWidth. If set to Auto the application sets the 
VBW value as follows:
For measurements below 1 GHz the VBW is set to 300 
kHz. For measurements above 1 GHz the VBW is set to 
3 MHz.
You can manually set the VBW as desired; decreasing 
the VBW smooths the trace display by filtering the 
higher frequency components.

• Amplitude of top gradient for the receiver. If the 
reference level value is different from the Ref Level 
Auto setting, clear the Ref Level Auto check box and 
enter that reference level.

• Increasing the attenuation decreases the noise floor, 
but also decreases the dynamic range, see “Determine 
Receiver Settings” on page 2-13.

• Amount of time for each receiver sweep. Can be 
increased to capture intermittent signals. The minimum 
is a function of frequency range and bandwidth 
settings.

Procedure 5-18 How to Setup and Perform a Sweep (Continued)

Step Procedure Comments
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Segment Size

Input

Receiver PreAmp

• Frequency span of the receiver for each receiver 
sweep. (The Sweep  function performs multiple receiver 
sweeps to cover the frequency range.

• Some receivers have more than one input (for example, 
Input 1 and Input 2 on the 854x series receivers). If 
there is more than one receiver input, the input to use 
can be selected. Selected input is used for the 
particular set of measurements.
NOTE: The inputs on the receiver support very specific 
frequency ranges. After the selection of input, all the 
signals to be measured are compared to the frequency 
range of the receiver input. The signals that do not fall 
within the supported frequency range of the input are 
removed from the measure list. The user is then 
prompted with the list of signals that will not be 
measured with the selected input.

• This check box is displayed only if the receiver has a 
built-in PreAmp (or there are no defined signal paths). 
Check the box to enable the receiver PreAmp.

5 Perform sweep. Click Run  in the Sweep dialog box to start the 
sweep.

• You can monitor the status of the sweep in the status 
bar of the application window; you also can view the 
trace as it is updated on the graph.

Procedure 5-18 How to Setup and Perform a Sweep (Continued)

Step Procedure Comments
HP E7415A Measurement Guide 5-37



How Do I...?
Use the Sweep, Add Peaks to List and Measure Functions

nal
Add Signals to the
Signal List

You can extract the signals from the trace data and place them in the sig
list table. The signal list data can then be used as a basis for future
measurements.

Procedure 5-19 How to Add Peak Signals from the Graph to the Signal List

Step Procedure Comments

1 Open the Add Peaks to 
List dialog box.

1 In the side bar, click the Add Peaks to List  icon. • OR, right-click the graph area and select Add Peaks to 
List .

• Peak signals are added from the trace data; therefore, 
trace data must exist before adding peaks to list.

2 Select and add signals. 1 In the Add Signals from area, select the OATS_1 
Ambients and OATS_1 EUT On traces.

2 In the Compare to  area, choose the limit line to 
which you are testing. 

3 Check the Use Margin  box; set the margin as 
desired (−6 dB is the default setting).

4 Set Peak Excursion Criteria as desired.

5 Click Add .

• For example, FCC part 15; Class A (3m).

• The signals above the limit line margin (except 
duplicate signals) are added to the list. The Trace 
Name column in the Signal List table shows the trace 
from which each signal is generated.

• The larger the excursion value, the fewer signal will be 
captured. The smaller the excursion value, the more 
signals will be captured with decreased chance of 
masked emissions and an increase in the number of 
duplicate signals.
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Procedure 5-20 How to Add a Data Point from the Graph to the Signal List

Step Procedure Comments

1 Add a graph data point 
to the Signal List Table.

1 Position the mouse pointer over the desired trace 
data point on the graph area.

2 With a hand symbol displayed, click to move the 
trace selection marker (that is, little black box) to 
the current trace position.

OR

Use the buttons on the Marker bar to move the 
marker to the desired signal. See “How to Use 
Graph Markers” on page 5-61 for more information.

3 Right click on the mouse to select Add Data 
Point to List .

• Notice that the mouse pointer turns into a hand symbol 
when it is placed on a data point of the graph. 

• Sometimes it is difficult to place the marker on a trace 
data point if the trace is close to the limit line or margin. 
In this case, click and drag the desired portion of the 
graph (either above or below the trace) to zoom in. This 
will improve the resolution of the graph data and make 
it easier to pick the desired data point.

• The amplitude and frequency location of the trace 
selection marker is added to the end of the Signal List 
Table.

Note : The mouse pointer can also be positioned on the 
limit line or limit line margin. If you have inadvertently 
positioned the trace selection marker on the limit line, the 
Add Data Point to List function will not function (greyed 
out) This is so that you will not inadvertently add the limit 
line location to the frequency list.
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ignals
Make Measurements The measure process uses the selected receiver detectors to measure s
from the signal list. The measure process can one or more detectors to
measure each signal to be measured. The results of the measure are
displayed in the signal list.

The peak measure process measures signals with lower frequency
uncertainty than the sweep process.

Procedure 5-21 How to Setup and Perform a Measurement

Step Procedure Comments

1 Open the Measure 
dialog box.

From the menu bar, click Test > Measure

OR

In the side bar under Test  click the Measure  icon.
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2 Set measurement 
options

Go through the three tab sheets in the Measurement 
Dialog Box and fill out the necessary information in 
each field.

Select Signals and Detectors  tab fields include:

Signal Path

Measure from List

Detectors

• This combo box displays all the paths that are enabled 
in the Test  setup. The default path selected is the path 
active on the Receiver Bar . Changing to another path 
updates the signal path on the Receiver Bar . 
Measurements cannot be performed without any 
entries in this box. 
NOTE: If there are no paths listed, at least one signal 
path needs to be defined in the Test Setup  before 
measurements can be performed.

• Select one of the three options (only one selection is 
active at one time).
Measure All Displayed Signals  measures the 
complete list of signals within the signal list.
Measure Selected Signals  measures only the 
selected (highlighted) signals from the signal list. The 
signals need to be selected before the Measure dialog 
box is opened.
From  measures the signals from the signal list that fall 
between the set frequency range.

• Select any combination (1 or more) detectors to use for 
signal measurement. For each detector, define the 
dwell time.
Peak measures the signals using the peak detector.
Quasi-peak  measures the signals using the 
quasi-peak (QP) detector.
Average measures the signals using the average (Avg) 
detector.
Dwell Time  for each of the selected detector can be 
specified in the adjacent box. Tip :. Intermittent signals 
may require a longer dwell time. 

Procedure 5-21 How to Setup and Perform a Measurement (Continued)

Step Procedure Comments
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For Each Signal  tab fields include:

Before Measuring...

• Frequency Search

• Tune and Listen

• Prompt Before Measure

• Enter Text Message

After Measuring, Update Signals...

• Always Update Signal

• Only if Larger

• Prompt for OK or Skip

• Uses the frequency uncertainty of the signal to set the 
receiver span. The receiver span is set from 
(frequency of signal being measured) - (frequency 
uncertainty) to (frequency of signal being measured) 
+(frequency uncertainty).
After setting the span, the receiver finds the highest 
peak in that span. The frequency at the highest peak is 
used to perform the measurement on the signal.
If this check box is not enabled, the frequency of the 
listed signal is used to set the center frequency of the 
receiver. This frequency is used to perform the 
measurement on the signal.

• Tunes the receiver to the selected signal frequency to 
enable you to perform an acoustic identification to 
distinguish ambient transmissions, such as radio 
signals, and from noise generated by the EUT.

• Before measuring each signal the application prompts 
you with a message box.

• Enter text to display before measuring each signal.

• Enables updating of the appropriate signal amplitude 
values, depending on the detectors selected.
If peak detector is used, the peak amplitude value of 
the signal is updated, and likewise with the QP and Avg 
detectors.

• Enables comparison of the resulting measured 
amplitudes with the listed signal amplitudes (depending 
on the detectors used). The application updates the 
signal amplitudes only if the measurement result is 
higher than the previously listed amplitudes of the 
signal.
If peak detector is used, the application compares 
measured peak amplitude of the signal with the listed 
peak amplitude, and likewise with QP and Avg values.

• After the measurement is completed, this option 
prompts you with a dialog box asking to update the 
signal or skip the update. If the choice is Skip  update, 
the amplitudes of the signal are not modified. If the OK, 
the amplitudes of the signal are updated from the 
results of the measurements.

Procedure 5-21 How to Setup and Perform a Measurement (Continued)

Step Procedure Comments
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Receiver Settings  tab fields include:

Receiver PreAmp

Input

Auto-range Sweep Time

RBW

VBW

Attenuation

• This check box is displayed only if the receiver has a 
built-in PreAmp (or there are no defined signal paths). 
Check the box to enable the receiver PreAmp.

• Some receivers have more than one input (for example, 
Input 1 and Input 2 on the 854x series receivers). If 
there is more than one receiver input, the input to use 
can be selected. Selected input is used for the 
particular set of measurements.
NOTE: The inputs on the receiver support very specific 
frequency ranges. After the selection of input, all the 
signals to be measured are compared to the frequency 
range of the receiver input. The signals that do not fall 
within the supported frequency range of the input are 
removed from the measure list. The user is then 
prompted with the list of signals that will not be 
measured with the selected input.

• Sets the sweep time for the measurement.

• Resolution Bandwidth. When Auto is cleared, coupling 
between sweep time and resolution bandwidth is 
disabled. A resolution bandwidth can be chosen for the 
measurement depending on the bandwidth range 
implemented in the hardware receiver. Check Auto to 
reestablish coupling. 

• . (The sweep time will increase with decrease RBW.)

• Video Bandwidth. When Auto is cleared, the VBW 
uncouples video bandwidth fro resolution bandwidth. 
Check Auto to reestablish coupling. You can manually 
set the VBW as desired; decreasing the VBW smooths 
the trace display by filtering the higher frequency 
components.

•

Specifies the input attenuation. Increasing the 
attenuation decreases the noise floor, but also 
decreases the dynamic range, see “Determine 
Receiver Settings” on page 2-13.

3 Run the measurement Click Run  to begin the measurement. • Each signal is remeasured using the peak and 
quasi-peak detectors. The Peak column is updated with 
new values acquired with greater frequency accuracy 
(lower frequency uncertainty). The QP (Quasi-Peak) 
column and data are added to the signal list table.

• The Delta Pk-Limit and Delta QP-Limit columns are 
updated with data.

Procedure 5-21 How to Setup and Perform a Measurement (Continued)

Step Procedure Comments
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Generate Reports

Two types of reports can be generated with the HP E7415A application:

• Snapshot report
A quick report comprised of the graph and/or signal list

• Custom report
A comprehensive report that can contain varied and extensive
information about the test

Procedure 5-22 How to Create a Snapshot Report

Step Procedure Comments

1 Open the Snapshots 
dialog box.

From the main toolbar, click on the Snapshot icon.

2 Take the snapshot. 1 In the Snapshots dialog box, enter a name to 
identify the current graph and signal list state.

2 To capture both the graph and list data, make 
sure both the Graph View and List View boxes are 
checked, then click Create .

• Use “Snapshot” in the snapshot name. This will make it 
easier to identify if you wish to include snapshots later 
in a report.

• Notice that the new snapshot is listed in the Stored 
Snapshots area. 

3 View the snapshot. Highlight the new snapshot title in the Stored 
Snapshots area, then click View... .

• This is ideal for comparing before and after fix data 
when a potential EMI improvement has been made to 
the EUT. 

• The Snapshot will be added to the Report items. See 
“How to Create a Custom Report” on page 5-45.
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Procedure 5-23 How to Create a Custom Report

Step Procedure Comments

1 Open the Report 
window.

In the side bar, click the Output button, then click the 
Report  icon.

2 Enter a title for the 
report.

In the Report dialog box, enter a Report Title .

3 Select report options. 1 In the Select Items To Report  area, hold down 
the [Ctrl] key while clicking on report items to 
include, for example:
• Header
• Current Graph
• Current List
• Limit Lines
• Title of Snapshots

2 Click on the right arrow button to move the 
highlighted items into the Selected Items  box.

• These items will now be included in your report. You 
can change the order of the report items by highlighting 
an item and then using the up and down arrow buttons 
to move the report item up or down in the list.

• To deselect a report item, select the item in the 
Selected Items list and click the left arrow button.

4 Add comments. Highlight a selected report item, then enter 
comments into the Item Description  area of the 
Report dialog box.

• Comments will show on report.

5 View and print the 
report.

1 Click on the Preview  button to view the report.

2 Use the scroll bar on the right side of the window 
to scroll through the contents of the report.

3 Print  the report

4 Click Close  to exit the Preview window.

• A print preview of the report will appear in the window.

• Note that by using the buttons at the bottom of the 
Report Preview, you may print and manipulate the page 
setup.

6 Save the report. Select Report To File  to save the report as an *.rtf 
file Then enter a file name.

• RTF files can be used in other applications such as MS 
Word.

7 Close the report. Select Close  to exit the Report dialog box.
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ined
on
Customize Signal Lists

The signal list contains the signals from the trace data that meet user-def
criteria. The signal list can be sorted and filtered to facilitate data reducti
and reporting.

Procedure 5-24 How to Import a Signal List

Step Procedure Comments

1 Open Signal List. From the Menu bar choose 
File  > Import  > Signal List...

2 Choose file and import. 1 Highlight desired file.

2 Click Open .

• As with exporting, set appropriate delimiter type.

Procedure 5-25 How to Export a Signal List

Step Procedure Comments

1 Copy the spreadsheet 
into the clipboard.

Highlight Signal  (click upper left box) or section of 
signal list.

2 Paste into an 
application.

Select Edit > Copy  from menu bar. • Signal lists can be pasted into a spreadsheet program 
(for example, Excel) or into a text editor (for example, 
Word or WordPad).
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Procedure 5-26 How to Insert (Broadband or Narrowband) Signals into the Signal List

Step Procedure Comments

1 Open the Insert Signals 
dialog box.

From the Menu Bar select Test  > Insert Signals... .
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2 Fill out the broadband or 
narrowband signal 
parameters.

Narrowband parameters include: 

Fundamental

# of Harmonics

Uncertainty of Fundamental

Broadband parameters include:

Start Frequency

Stop Frequency

Step Size

• Fundamental frequency of the signal to be inserted.

• The harmonic number of the fundamental frequency to 
insert. The fundamental signal plus the harmonic 
signals up to and including the harmonic number 
entered as # of Harmonics will be inserted into the 
signal list. 
For example, if 30 MHz is the Fundamental  frequency 
and the # of Harmonics  = 5, then the signals that will 
be inserted into the signal list have the frequencies as 
follows:
30 MHz (fundamental)
30 MHz X 2 = 60 MHz (2nd harmonic)
30 MHz X 3 = 90 MHz (3rd harmonic)

• Uncertainty of the fundamental frequency. The 
uncertainty of each harmonic is a factor of the 
fundamental uncertainty. For example, the uncertainty 
of the second harmonic is the uncertainty of the 
fundamental frequency times 2.

• Start frequency for the broadband signal.

• Stop frequency for the broadband signal.

• The value between frequency points for the frequencies 
between start and stop. The frequency uncertainty 
defaults to 2 times the Step Size .
The Step Size  value determines the number of signals 
that are inserted in the signal table and the frequency 
uncertainty. For example, if the Start Frequency  = 30 
MHz, the Stop Frequency  = 90 MHz, and the Step 
Size  = 5 MHz, then the signals are inserted from 30 to 
90 MHz at intervals of 5 MHz. The frequency 
uncertainty of these signals defaults to 10 MHz.

3 Insert signals. Click Insert . • The signals will be inserted into the signal list with the 
Trace Name “User Created”.

• The amplitude values will be blank.

Procedure 5-26 How to Insert (Broadband or Narrowband) Signals into the Signal List
(Continued)

Step Procedure Comments
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Procedure 5-27 How to Re-Arrange List columns

Step Procedure Comments

1 Arrange Signal List 
columns.

Method 1:

1 Select Setup  > List Settings...  from the menu 
bar. This will bring up the List Settings window. 

2 In the Signal Columns page you will see a left 
pane (Select Columns to Show) and a right pane 
(Selected Columns). Highlight a signal item in the 
right pane to be moved and then click on the up or 
down arrow buttons to rearrange the item.

3 When you have arranged the columns as desired, 
click OK.

Method 2:

1 Place the mouse curser over the column header 
to be moved (notice that the curser becomes a 
arrow pointing down). 

2 Left click to highlight the column and release.

3 Left click and the mouse curser now has a 
rectangle box. Drag the box (and associated red 
line) to the desired new location of the column.

• OR double click on a row number; OR click the red 
checked icon in the tool bar.

• The column will be placed to the right of the red line.
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Procedure 5-28 How to Add Signal Attributes (List Columns) to the Signal List

Step Procedure Comments

1 Open the Signal 
Attributes dialog box.

1 From the Menu Bar select Setup  > List Settings .

2 Choose the Select Columns  tab.

• OR double click on a row number; OR click the red 
checked icon in the tool bar.
5-50 HP E7415A Measurement Guide



How Do I...?
Customize Signal Lists
2 Select the attributes to 
list.

Use the right and left arrow buttons (or double-click) 
to move highlighted attributes from one side to the 
other.

Signal Attributes Available for Listing:

Frequency

Frequency Uncert

Peak

Peak Uncorrected

QP

QP Uncorrected

Avg

Avg Uncorrected

A-B

RBW

VBW

Correction

Transducer Correction

Cable Correction

Trace Name

Comment

Date/Time

• The left-hand list (Select Columns to Show ) holds 
attributes that are available for listing, but will not be 
included in the list

• The right-hand list (Selected Columns ) hold attributes 
that will be listed.

• Frequency of the signal.

• Uncertainty of the signal (obtained from the receiver 
trace).

• The corrected peak amplitude corresponding to each 
frequency point in the signal list.

• The uncorrected peak amplitude corresponding to each 
frequency point in the signal list.

• The corrected quasi-peak amplitude corresponding to 
each frequency point in the signal list.

• The uncorrected quasi-peak amplitude corresponding 
to each frequency point in the signal list.

• The corrected average amplitude corresponding to 
each frequency point in the signal list.

• The uncorrected average amplitude corresponding to 
each frequency point in the signal list.

• The amplitude in dB from an A-B trace corresponding 
to each frequency point in the signal list. 
NOTE: This data can be generated only from an A-B 
trace; therefore, an A-B trace must be previously 
defined.

• The Resolution Bandwidth used to obtain trace data at 
the corresponding frequency.

• The Video Bandwidth used to obtain trace data at the 
corresponding frequency.

• The sum of Transducer Correction + Cable 
Correction .

• The sum of all the transducer corrections that are used 
in the signal path.

• The sum of the cable corrections + preamp corrections 
+ corrections for other devices in the signal path.

• The name of the trace from which the signal (frequency 
and amplitude pair) was generated.

• A placeholder for any comment that a user wishes to 
associate with a signal.

• The date and time stamp from the trace data. Each 
trace that is obtained from the receiver is date and time 
stamped by the application. 
NOTE: All signals generated from the same trace have 
the same Date/Time  stamp.

Procedure 5-28 How to Add Signal Attributes (List Columns) to the Signal List
(Continued)

Step Procedure Comments
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Ambient

Potential Ambient

Duplicate

• Displays a Yes if the listed signal is an ambient signal. 
DIsplays No if not an ambient signal. 
NOTE: The ambient signals within each selected 
(checked) ambient signal list is automatically listed 
within the signal list. Ambient signal lists are 
selected/deselected in the test setup. See “Setting Up a 
Test” for information on selecting ambient signal lists.

• Displays a Yes if the listed signal is obtained from the 
receiver trace and is a duplicate of a signal found within 
an ambient signal list. Displays No if not a potential 
ambient. 
NOTE: The user can choose to override the application 
comparison by selecting User set Yes  or User set No . 
Signals that are marked with User set Yes  or a User 
set No  do not participate in ambient matching. Set the 
cell value to Auto  to allow the application to perform the 
comparison. Cell values are edited by using the left 
mouse button.

• Displays a Yes if the listed signal is obtained from the 
receiver trace and is a duplicate of a previously 
obtained receiver. That is, there exists a duplicate 
signal not from an ambient list. Displays No if not a 
duplicate signal.
Signals in the signal list are considered to be duplicate 
signals is the signals are within the uncertainty range of 
one another. See Show Higher Duplicates  for more 
information on Duplicate  definitions.
Each time a signal is added to the signal list, the 
application searches the complete signal list to locate 
duplicate signals.
NOTE: The user can choose to override the application 
comparison by selecting User set Yes or User set No. 
Signals that are marked with User set Yes  or a User 
set No  do not participate in ambient matching. Set the 
cell value to Auto  to allow the application to perform the 
comparison. Cell values are edited by using the left 
mouse button.

3 Create the list. Click OK or Apply . • New column headers will be generated using the 
modified signal list attributes.

Procedure 5-28 How to Add Signal Attributes (List Columns) to the Signal List
(Continued)

Step Procedure Comments
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Procedure 5-29 How to Sort Signal List Data

Step Procedure Comments

1 Sort signal list data. 1 Place mouse arrow curser on the column header 
of the data to be sorted and right click the mouse. 

2 Double click the column header to toggle the data 
in ascending or descending order.

Procedure 5-30 How to Filter Signal List Data

Step Procedure Comments

Do not filter signal list data.
(Default)

1 From the menu bar select Setup > List Setting .

2 Select the Signal Filter tab.

3 Click to select the No Filter box (default).

• OR double click on a row number; OR click the red 
checked icon in the tool bar.

• By choosing No Filter , you will not apply the filtering 
criteria defined in the Signal Filter  page.
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Filter signal list data. 1 From the menu bar select Setup > List Setting .

2 Select the Signal Filter tab.

3 Click to clear the No Filter box.

4 Select the filtering criteria for the signal listing 
from the options presented in the filtering criteria.

Filter fields include:

Show Higher Duplicates

Signal Matching Criteria (% of Frequency 
Uncertainty)

Show Ambients

From Trace

All Signals

Top

Over

Sort Signals by

• To filter signals based on the filtering criteria, the No 
Filter  check box must be cleared (unchecked).

• Check this box to display all duplicate signals within the 
signal list. 
If this box is not checked, all duplicate signals are 
compared with each other and only the signal that has 
the highest peak amplitude is displayed. The remaining 
duplicate signals are not deleted, but they are removed 
from the view.
As a signal is added to the signal list, it is compared to 
each existing signal within the signal list. If the new 
signal falls within the duplicate comparison boundaries, 
it is considered a duplicate signal of an existing signal.
The equations for the comparison boundaries are as 
follows:
Upper Boundary: (Existing Signal Frequency) + 
(Frequency Uncertainty * Percentage)
Lower Boundary: (Existing Signal Frequency) - 
(Frequency Uncertainty * Percentage)
NOTE: Increasing the setting within the % of 
Frequency Uncertainty  field will increase the number 
of duplicates in the signal list.

• Enter the percentage for the application to use in the 
duplicate signal boundaries. See Show Higher 
Duplicates  for more information.

• Check this box to display all ambient signals. Uncheck 
the box to not display ambient signals.

• Check this box to display only those signals with the 
trace name matching the trace name selected in the 
pull-down menu. Uncheck the box to not filter based on 
trace name.

• Select the All Signals  button to apply the filter criteria 
to all signals within the signal list.

• Select the Top  button to apply the filter criteria to the 
top (largest) n signals only. Click the button, enter a 
number for n in the first field. Select the detector to use

• Select the Over button to apply the filter criteria to the 
signals with an amplitude higher than the selected limit 
line or limit line with margin. Click the button, select a 
(Optional) Add margin signals within the signal list 
(check Use Margin , enter the margin in the Over  field, 
select the detector to use).

• Check this box to select a column by which the signals 
within the list will be sorted. Click the box, select a 
column heading, select ascending or descending.

Procedure 5-30 How to Filter Signal List Data

Step Procedure Comments
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Procedure 5-31 How to Define and Add Limit Columns

Step Procedure Comments

1 Open List Settings. 1 From the menu bar select Setup > List Settings .

2 Select Define Limit Columns Tab.

2 Define Limit Column. 1 Enter a name for the column header into the 
Column Header  text box. 

2 Select the detector to use from the Detectors  
drop-down list.

3 Select the limit line to use for comparison from the 
Limit Line  drop down list.

4 Click Add  to add the new column to the signal list.

5 Click OK.

• Enter the name or title of the column displayed in the 
signal list. There is not a predefined name for this 
column, it is user-specified.

• The signal comparison will use the values measured 
with the selected detector with the selected limit at the 
frequency point. The comparison values entered in to 
the signal list columns are the difference between the 
measured value with the signal detector and the limit 
value at the measured signal’s frequency.
The following selections are available:
<none> No comparison is performed. The values within 
the column are the amplitude of the selected limit at the 
signal frequency.
Peak: The values within the column are the difference 
between the Peak amplitude of each signal and the 
limit value at the signal frequency.
Quasi-Peak : The values within the column are the 
difference between the Quasi-Peak amplitude of each 
signal and the limit value at the signal frequency.
Average : The values within the column are the 
difference between the Average amplitude of each 
signal and the limit value at the signal frequency.

• Use Replace to edit an existing limit column.

• The limit columns will be added to the list.
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e
Procedure 5-32 How to Change the Color of the Ambient Signals/Change the Font of th
Signal List

Step Procedure Comments

1 Open List Settings. 1 From the menu bar select Setup > List Settings .

2 Select Colors/Font tab.

2 Select Color and Font. 1 Select the signal list color for the Ambient Signal 
from the Ambient Color  drop-down list.

2 Select a font from the Fonts  drop-down list.

3 Select a font size from the Size  drop-down list.

3 Apply the changes. Click OK or Apply .
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Customize Graph and Trace Data

The HP E7415A graph maybe comprised of multiple traces. Each trace m
be comprised of multiple receiver sweeps.

The HP E7415A application includes useful tools to manipulate trace da
such as Max Hold and A-B comparison. In addition, the graph can be se
facilitate trace identification and readability.

Procedure 5-33 How to Export Graph Data

Step Procedure Comments

1 Open Export Graph 
dialog box.

Select File  > Export  > Graph... • Both the graph and zoom graph (if open) are exported.

2 Name and Save file. 1 Select folder.

2 Enter name of graph file.

3 Click Save. • Saves as an RTF file.
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Procedure 5-34 How to Modify the Graph Settings

Step Procedure Comments

1 Define Trace and 
Annotation Settings.

1 From the sidebar, click on the Test button to 
display the graph and signal list table.

2 Double-click in the graph area to open the 
Graph Settings  dialog box.

Set the Traces and Annotation. 

Fields Include:

Start Frequency

Stop Frequency

Reference Level

dB/Div

Amplitude Divisions

Frequency Scale

Graph Notes/Title

Show Traces

• Affects only the composite graph.

• Affects only the composite graph.

• Defined as the uppermost grid line on the graph. 
Editing affects both the composite and zoom graphs.

• Spacing between each grid line. Editing affects both the 
composite and zoom graphs.

• Total number of divisions on the vertical axis. Editing 
affects both the composite and zoom graphs.

• Linear or Log scale. Editing affects both the composite 
and zoom graphs.

• Text will display at the top left of the composite graph, 
not on the zoom graph.

• Displays the complete list of traces generated during 
the measurements or captured from receiver traces. 
Check the traces to display in the graphs.
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2 Select Limit Lines to 
display.

Set the Limit Line Display fields as follows: • The Limit Lines Display page lists the limit lines 
selected under Setup.

3 Select trace, limit line, 
and other colors.

Select a color for each trace on graph.

Select a color for each limit line on graph.

Select colors for the graph background, grid, and 
text.

• Each can have a different color.

• Each limit line can have a different color.

Procedure 5-34 How to Modify the Graph Settings (Continued)

Step Procedure Comments
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4 Select the graph font 
size.

Select Large Font , Medium Font , or Small Font.

5 Apply the graph 
settings.

Click OK or Apply .

Procedure 5-34 How to Modify the Graph Settings (Continued)

Step Procedure Comments

Procedure 5-35 How to Delete a Trace

Step Procedure Comments

1 Activate trace to delete. Click on trace to place marker anywhere on trace to 
delete.

2 Delete trace. Right click and select Delete Trace .

Procedure 5-36 How to Change a Trace Name

Step Procedure Comments

1 Activate trace to 
rename.

Click on trace to place marker anywhere on trace to 
rename.
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2 Rename trace. 1 Right click and select Rename Trace .

2 Enter name.

3 Click OK.

Procedure 5-36 How to Change a Trace Name

Step Procedure Comments

Procedure 5-37 How to Use Graph Markers

Step Procedure Comments

1 Display the Marker Bar. View  > Toolbar  > Marker Bar . • The frequency and amplitude (shown in the upper left 
corner of the screen) of the marker is displayed when 
the mouse icon is placed on the marker.

2 Use the Marker Bar to 
move the marker on the 
graph.

Highest Peak

Next Highest Peak

Next Lowest Peak

Lowest Peak

Next Peak Left

Next Data Point Left

Next Data Point Right

Next Peak Right

Add Data Point to List

• Data point is the marker point.
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Procedure 5-38 How to Zoom a Region of the Graph

Step Procedure Comments

1 Select the portion of the 
graph desired for zoom.

1 Place the mouse pointer on a starting frequency 
of the composite graph.

2 Click the left mouse button and drag the mouse 
pointer to the desired stop frequency on the 
composite graph.

3 Release the mouse button at the stop frequency.

• The data displayed on the zoom graph is the same as 
the data on the graph, only at a higher resolution.

• The mouse icon changes to a magnifying glass when 
zoom is large enough.

• The zoom graph is displayed below the graph.
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Procedure 5-39 How to Perform A−B Operations

Step Procedure Comments

1 Open the Trace 
Properties dialog box.

1 Select Test  > Trace Operations… from the menu 
bar.

2 Check the A – B  check box. 

3 Enter a name in the Trace Name text box. 

4 Select a color for the A-B trace.

5 Select the trace for Trace A and the trace for Trace 
B.

6 Click OK.

• For example, EUT 34588 RevA-RevB .

• In this example the A-B trace will show positive values 
for decreases in emission for rev B compared to rev A.
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Procedure 5-40 How to Perform Max. Hold and Min. Hold Operations

Step Procedure Comments

1 Max hold trace math. 1 Open the Trace Operations dialog box from the 
Menu Bar by selecting Test > Trace Operations.

2 Check the Max  check box.

3 Enter a name for the Max  trace within the name 
edit box.

4 Select a color.

5 Select the trace to Max hold.

6 Click OK.

Max  holds the maximum value while performing sweeps.

• A Max  trace is created and displayed on the graph and 
zoom graph.

• The trace points from each sweep are compared with 
each other and the maximum value is saved and 
displayed (The Max  trace is the resulting trace 
comprised of the maximum values at each frequency 
point from one or more sweep traces.) Therefore, the 
Max  trace graphically indicates the maximum value 
measured at each frequency point.

2 Min hold trace math. 1 Open the Trace Operations dialog box from the 
Menu Bar by selecting Test > Trace Operations.

2 Check the Min  check box.

3 Enter a name for the Min  trace within the name 
edit box.

4 Select a color.

5 Select the trace to Min hold.

6 Click OK.

• Min  holds the minimum value while performing sweeps.

• A Min  trace is created and displayed on the graph and 
zoom graph.

• The trace points from each sweep are compared with 
each other and the minimum value is saved and 
displayed (The Min  trace is the resulting trace 
comprised of the minimum values at each frequency 
point from one or more sweep traces.) Therefore, the 
Min  trace graphically indicates the minimum value 
measured at each frequency point.
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Use Receiver Functions

The receiver can accept information from and send information to the
HP E7415A application.

In addition, the receiver can be set in local mode allowing you to directly
control the receiver.

Send Information to
the Receiver

Procedure 5-41 How to Set Receiver in Local or Remote Mode

Step Procedure Comments

Select local mode. On the Receiver Bar, click on the L. • The receiver will accept commands from the receiver 
front panel and not from the application.

• The selected limit lines and signal path corrections will 
be sent to the receiver.

Select remote mode. On the Receiver Bar, click on the R. • The receiver will accept commands from the application 
and not directly from the receiver front panel.

Procedure 5-42 How to Display the Selected Limit Lines on the Receiver

Step Procedure Comments

Set to local mode. On the Receiver Bar, click on the L. • Limit lines are sent automatically to the receiver.

Procedure 5-43 How to Send Signal Path Corrections to the Receiver

Step Procedure Comments

Set to local mode. On the Receiver Bar, click on the L. • Signal path corrections are set automatically to the 
receiver.
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Retrieve Information
from the Receiver

Procedure 5-44 How to Insert the Signal at the Receiver Marker into the Signal List

Step Procedure Comments

1 Set receiver to Local 
Mode.

On the Receiver Bar, click on the L.

2 Select signal to insert Place the receiver marker on the signal you want to 
insert into the signal list.

3 Get Receiver Marker. On the Receiver Bar, click on the Get Receiver 
Marker  icon.

• The signal at the receiver marker position is inserted 
into the signal list.

Procedure 5-45 How to Tune the Receiver to a Selected Signal

Step Procedure Comments

1 Tune on a signal. 1 On the Receiver Bar, click the box proceeding 
Tune .

2 Highlight the desired signal on the signal list.

• The receiver is tuned to the active signal (the receiver 
center frequency is set to selected signal frequency) 
whenever you move the cursor around on the signal 
list.

• The receiver is set to zero span.

2 Tune on a signal span. 1 On the Receiver Bar, click the box proceeding 
Tune .

2 Zoom the desired portion of the graph.

• When the graph is zoomed, the receiver is tuned to the 
span of the zoom graph. Span is defined under 
Tools > Options  >Tune/Demod .

Procedure 5-46 How to Demodulate a Selected Signal (FM Demodulation)

Step Procedure Comments

Select demodulate. Click the Tune  box on the Receiver Bar.

Click the Demod  box on the Receiver Bar.

• Demod  only works if the Tune box is checked.

• FM demodulation is turned on for the chosen receiver 
by default. For AM demodulation, see your receiver 
manual.

• To listen to signals with reduced interruption, increase 
the sweep time on the receiver.

Procedure 5-47 How to Enable Receiver Preamp

Step Procedure Comments

For Sweeps. 1 Sweep  > Receiver Settings  tab.

2 Check Receiver PreAmp  check box.

For Measurements. 1 Measure  > Receiver Settings  tab.

2 Check Receiver PreAmp  check box.
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Use Command Logger The command logger function allows you to monitor the receiver commands
sent to the receiver by the HP E7415A application. The command logger
particularly useful when troubleshooting test problems and when validati
test steps.

Procedure 5-48 How to Use the Command Logger Feature

Step Procedure Comments

1 Open the command 
logger.

From the Menu bar choose 
Tools  > Command  Logger .

• Commands sent to and received from the receiver are 
logged here. The logger starts logging commands after 
the command logger window is open.

2 (optional) Save the log. 1 Click on Stop .

2 Choose Save As.. .

• To restart the logger click on Start .

• Saved log files may be opened in WordPad.
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Characterize Cables

Cable correction factors can be generated with the HP E7415A applicati
As with other devices, the correction factors are a set of frequency/amplit
pairs. The following process measures cable loss and generates the
frequency/amplitude pair list.

The cable characterization process contains four main steps:

1. Calibrate the EMI receiver

2. Setup the HP E7415A application to capture cable loss data

3. Measure cable loss

a. Setup receiver for measurements

b. Measure with thru cable only

c. Measure with thru cable plus cable to characterize

d. Create a list with amplitude differences verses frequency (correct
factors)

4. Import cable correction factors into HP E7415A application(see
Procedure 4-56 in the next section)

For this example, since the spectrum analyzer has 401 trace points and
frequency span will be set from 30 MHz to 2.03 GHz, a cable loss factor w
generated every 5 MHz.

This example uses an HP 8546A receiver in local mode. For other receiv
the steps are similar.

NOTE A tracking generator is necessary to perform these steps.
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Procedure 5-49 How to Calibrate the EMI Receiver (for the HP 8546A)

Step Procedure Comments

1 Calibrate the receiver 
(spectrum analyzer).

1 On the spectrum analyzer, select 
[CALIBRATE ] > {CAL ALL } > (CAL ALL }. 

2 After the routine is done, press {CAL STORE}. 
After a few seconds, you should see ‘CAL: Stored’ 
on the display.

• Hardkeys are within [brackets ], softkeys within 
{braces }.

• CAL ALL does not calibrate the tracking generator, 
which must be calibrated separately.

2 Calibrate the tracking 
generator.

1 Connect a short low-loss 50-Ω RF cable from the 
receiver's TRACKING GENERATOR OUTPUT on 
the RF Filter Section to INPUT 2.

2 Calibrate the tracking generator; select 
[CALIBRATE ] > {More} > {More} > {CAL TRK 
GEN}.

3 After the routine is done, press {CAL STORE}. 
After a few seconds, you should see ‘CAL: Stored’ 
on the display.

• You will observe the receiver mode changes to Signal 
Analysis, and several messages will briefly be 
displayed including 'SRC POWER -10dBm', 'peaking', 
and 'SPAN 2.8 GHz'. 

• Calibrating the tracking generator takes about 40-60 
seconds.

Procedure 5-50 How to Capture Cable Loss Data

Step Procedure Comments

1 Check the equipment list 
for your receiver. 

1 In the sidebar, select the Equipment  icon under 
the Setup  folder.

2 Expand the Receivers  subfolder by clicking the 
plus sign next to it. 

3 Check to ensure that the receiver that will be used 
to perform the cable calibration is present in the 
Receiver  subfolder. (Verify receiver model 
number and serial number.)

4 If the receiver used is not within the list, add the 
appropriate receiver. 

• Click and highlight on a receiver to view its property 
sheet in the left pane.

• Refer to “How to Add and Setup a New Receiver” on 
page 5-16 for more information on adding receivers.
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2 Create a signal path for 
the cable measurement.

1 In the sidebar, select the Signal Paths icon under 
the Setup  folder.

2 Right-click the Signal Paths folder and select 
New Signal Path . 

3 Right-click on ‘Untitled Signal Path’, select 
Rename . Enter a descriptive name for the signal 
path and press <Enter >. 

4 From the Select Equipment From Resources list 
in the right pane, click the plus sign next to the 
Receivers folder to expand the list of available 
receivers. 

5 Select the receiver to be used for the cable loss 
measurement and click Add  to add it to the new 
signal path. 

• The new signal path will contain the receiver only.

• ‘“Untitled Signal Path” should appear at the bottom of 
the defined Signal Paths.

• For example, 8546A closed loop . 

• Click the plus sign to the left of the new signal path to 
expand it and verify the receiver has been added to the 
signal path.

• The new signal path will be automatically checked, 
making it available for testing.

• Refer to “How to Create a New Signal Path” on 
page 5-26 for more information on creating signal 
paths.

3 Display the receiver 
toolbar.

1  If the receiver bar is not displayed, from the menu 
bar, select View  > Toolbar  > Receiver Bar .

• The receiver toolbar appears to the right of the main 
toolbar.

4 Set the amplitude units. 1 Open the Options dialog box by selecting Tools  > 
Options...  from the menu bar.

2 Open the General page by clicking the General  
tab.

3 Within the Default Units  area, select dBm  from 
the Amplitude: pull-down list.

4 Click OK.

• Verify that Frequency: Default Units  is set to MHz.

5 Define the graph 
settings.

1 Display the graph and signal list window by 
selecting the Test  folder from the sidebar.

2 Double-click in the graph area to open the 
Graph Settings  dialog box.

Set the graph setting fields as follows:

• Start Frequency = 30 MHz

• Stop Frequency = 2030 MHz

• Ref Level = -10 dBm

• dB/Div = 2

3 Click OK. 

6 Define the signal list 
settings.

1 Open the List Settings  dialog box by selecting 
Setup  > List Settings...  from the menu bar.

2 Highlight Frequency  and A - B within the Signal 
Columns list and click the right arrow button.

• This moves the Frequency and A-B signal attributes to 
the Selected Columns list, to be displayed on the signal 
list. (One or both of these attributes may already reside 
within the Selected columns list.)

Procedure 5-50 How to Capture Cable Loss Data (Continued)

Step Procedure Comments
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Procedure 5-51 How to Measure Cable Loss with Receiver

Step Procedure Comments

1 Setup the receiver and 
measure thru cable.

1 Connect a short low-loss 50 ohm RF cable (thru 
cable) from receiver's TRACKING GENERATOR 
OUTPUT on the RF Filter Section to INPUT 2.

2 Set receiver frequency range, start 30 MHz, stop 
2.03 GHz.

3 Adjust reference level and change amplitude units 
to dBm by selecting [AMPLITUDE ] > {REF LVL} > 
{dBm}  > {More} > {Amptd Units } > {dBm }. 

4 Turn on the tracking generator and set power to 
-10 dBm by selecting [TRACK GEN ], press {SRC 
PWR ON OFF} until ON is underlined.

5 Couple the sweep time for stimulus-response 
mode: [TRACK GEN ] > {More} > 
{SWP CPLG SR RECV}.

6 Reduce the RBW to increase sensitivity (10 kHz), 
and narrow the AVG BW (1 kHz) to smooth the 
noise by selecting [BW ] > {IF BW} > 10 kHz > 
{AVG BW } > 1 kHz.

7 Change the Amplitude Scale to 2 dB/Div by 
selecting [AMPLITUDE ] > {SCALE } > enter 2 dB.

8 Clear-write Trace A by selecting [TRACE] > 
{CLEAR WRITE A }.

•  Use the same cable as used for receiver calibration.

• You should see RL = -7 dBm.

• In the stimulus-response mode, the Q (reactance vs. 
resistance of the EUT (cable) determines the fastest 
rate at which the receiver can be swept. To determine 
whether the receiver is sweeping too fast, increase the 
sweep time by selecting [SWEEP] > {SWP TIME AUTO 
MAN} , press the up arrow several times. Note whether 
there is a frequency or amplitude shift of the trace. 
Continue increasing the sweep time until there is no 
observable frequency or amplitude shift. (For this 
example 30MHz - 2.03GHz, a sweep time of 2 seconds 
was required with the thru cable connected.)

2 Send receiver trace to 
HP E7415A application.

1 In HP E7415A application receiver toolbar, select 
the signal path created in the application setup 
(from the pull-down list).

2 Click the Get Receiver Trace  icon on the receiver 
toolbar. 

3 Enter the name thru  for the trace in the Trace 
Properties dialog box. 

4 Click OK.

• Signal paths are selected from the Signal Path  field of 
the receiver toolbar.

3 Measure with thru cable 
plus cable under test.

1 Insert the cable-under-test between the thru 
cable, and INPUT 2.

2 Clear-write Trace A by selecting [TRACE] > 
CLEAR WRITE A .

3 Increase the sweep time until there is no 
observed change in the trace. 

• Longer cables will require longer sweep times to ensure 
the cable-under-test is not being 'overswept'. Sweep 
times of 10 to 20 seconds are not unusual. 

4 Send receiver trace to 
HP E7415A application.

1 Click the Get Receiver Trace  icon on the receiver 
toolbar. 

2 Enter the name thru + RF cable  for the 
trace in the Trace Properties dialog box. 

• The graph (on the HP E7415A application) will display 
two traces; “thru” and “thru + RF cable.”
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5 Graph the difference 
between the two traces.

1 Open the Trace Operation dialog box by selecting 
Test  > Trace Operations… from the menu bar.

2 Check the A – B  check box. 

3 Enter a name in the Trace Name text box. 

4 Select the trace for the thru only measurement for 
Trace A.

5 Select the trace for thru + cable-under-test for 
Trace B. 

6 Click OK.

• For example, RF cable loss .

• The order of A – B is important because cable loss 
factors must be entered into the HP E7415A cable 
correction table as positive values.

• You should see the resultant ‘RF cable loss’ trace 
appear as a trace generally sloping upwards to the right 
with positive values reflecting the cable loss. 

• The A-B result is the RF cable + thru measurement 
normalized to the thru only measurement.

Procedure 5-51 How to Measure Cable Loss with Receiver (Continued)

Step Procedure Comments
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A - B

An A - B trace is the resultant trace calculated by subtracting the amplitu
values of one trace from another at each frequency point. The difference
stated in dB. A dB scale is added to the right side of the graph when the
A - B resultant trace is displayed.

For example, if the amplitude of trace A at 30 MHz = 10 dBµV and trace B
at 30 MHz = 25 dBµV; A-B at 30 MHz =−15 dB.

Add Peaks to List

The Add Peaks to List function adds all signals from the selected trace(s
the signal list that meet the signal criteria. Criteria are set in the Add Peak
List dialog box and include comparison to limit lines with or without margi
and peak excursion (See Peak Excursion).

Ambient (Signal)

An ambient signal is a radiated or conducted signal existing at a specific
location and time when the test sample is not activated. Each signal is
defined as an amplitude/frequency pair.

Ambient Level

Ambient level is the value of radiated and conducted signals and noise
existing at a specified test location and time when the test sample is
inoperative. Atmospheric noise, interference from other sources, circuit
noise, or other interference generated within the measuring set compose
ambient level.

Ambient List

An ambient list is a list of ambient signals (amplitude/frequency pairs) th
exist for a specific test location. The ambient list usually includes known
man-made source such as radio, television stations, cellular phones, and
on.

AMN (Artificial Mains Network)

See LISN.
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Amplitude/Frequency Pair

See Frequency/Amplitude Pair.

Amplitude Modulation

1. In a signal transmission system, the process, or the result of the proc
whereby the amplitude of one electrical quantity is varied in accordan
with some selected characteristic of a second quantity, which need n
be electrical in nature.

2. The process by which the amplitude of a carrier wave is varied followi
a specified law.

Anechoic Chamber

An anechoic chamber is an enclosure for making electro-magnetic
measurements. The interior surfaces of the enclosure absorb electromag
radiation which reduces reflection and room resonance. Fully lined anech
chambers (FLAC) have such material on all internal surfaces to absorb
incident waves on walls, ceiling, and floor. It is also called a fully anechoi
chamber. A semi-anechoic chamber is a shielded room which has absor
material on all surfaces except the floor.

Antenna (Aerial)

1. An antenna is a means for radiating or receiving radio waves.

2. A transducer which either emits radio frequency energy into space fr
a signal source or intercepts an arriving electromagnetic field,
converting it into an electrical signal.

Antenna Effective Length

The antenna effective length is the ratio of the antenna induced
(open-circuit) voltage to the intensity of the field component being
measured. See Antenna Induced Voltage.

Antenna Factor

The antenna factor is the factor which, when properly applied to the volta
at the input terminals of the measuring instrument, yields the electric fiel
strength in volts per meter (volts/meter) and the magnetic field strength i
amperes per meter (amperes/meter). This factor includes the effects of
antenna effective length, mismatch, and transmission losses.

Antenna Induced Voltage

Antenna induced voltage is the voltage which is measured at, or calculate
exist across, the open-circuited antenna terminals.
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Average (Detector)

The peak-detected signal is passed through a filter (with bandwidth muc
less than the RBW). The filter integrates (averages) the higher frequency
components such as noise. Average detection is used for measurement
narrowband signals to overcome problems associated with either modula
content or the presence of broadband noise.

Balun

A balun is a device which provides impedance matching between a
transmission line (unbalanced) and antenna (balanced).

Broadband Response

Broadband response is displayed on the receiver when its bandwidth is w
than the discrete frequency components of the received impulsive signal. In
this mode, each displayed response represents more than one frequenc
component. This occurs, for example, when the receiver bandwidth is wi
than the repetition frequency (PRF) of a pulsed transmission.

To check for broadband response, vary the receiver bandwidth, sweep ti
or span width. Broadband response has three characteristics. First, ampl
varies directly with the receiver bandwidth; doubling the bandwidth
increases the displayed amplitude 6 dB. Second, line spacing depends o
sweep time; increasing the sweep time decreases the line spacing. Third
span width does not affect line spacing. See Narrowband Response.

BSI

British Standards Institute.

Bus Address

The bus address is the GPIB (or HPIB) interface address. The receiver b
address and the bus address within the receiver property sheet must ma

Cable Loss

Cable loss is the insertion loss in the signal path which is attributed to the
cable(ing). Cable loss is frequency dependent, therefore, cable loss
correction factors are typically defined as a set of frequency/amplitude p
(see Correction Factors).
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CEN

Comité European de Normalisation.

CENELEC

Comité European de Normalisation Electronique.

CISPR

Comité International Spécial des Perturbations Radioélectriques.

Close Field Probes

1. Close field probes are small, hand-held, electromagnetic field senso
that provide repeatable, absolute, magnetic field measurements ove
wide frequency range.

2. When attached to a source, the probes generate a localized magnet
field for electromagnetic susceptibility (EMS) testing.

Communication Interface

Communication interface is the type of communication port used for
communication between the HP E7415A application and the receiver. The
interface may be GPIB or HPIB. The communication interface type must
match between the I/O card and driver and the receiver property sheet.

Communication Library

The communication interface library of commands. The library may be H
VISA or National Instruments VISA. The communication library type mus
match between the I/O card and driver and the receiver property sheet.

Conducted Emission

Conducted emission is the desired or undesired electromagnetic energy
which is propagated along a conductor. Such an emission is called
“conducted interference” if it is undesired. Conducted emissions are
measured on the power mains and the signal lines connected to the EUT

Conducted Interference

Conducted interference is interference resulting from conducted radio no
or unwanted signals entering a transducer by direct coupling.

Correction Factors

Correction factors are a set of frequency/amplitude pairs that characteriz
device over frequency. The amplitudes are negative for gain (at an associ
frequency) and positive for loss (at an associated frequency). Correction
factors are added to the measured data to produce corrected results.
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Corrections

See Correction Factors.

Counterpoise

1. Counterpoise is the reference-plane portion (grounded or ungrounde
of an unbalanced antenna.

2. A system of conductors of an antenna.
Note: The purpose of a counterpoise is to provide a relatively high
capacitance and thus a relatively low impedance path to earth. The
counterpoise is sometimes used in low frequency and medium freque
applications where it would be more difficult to provide an effective
ground connection.

Cross-coupling

Cross-coupling is an undesired signal coupling between two or more
separate communication channels, circuit components, or paths.

Cross-modulation

Cross modulation is modulation of a desired signal by an undesired sign
This is a special case of intermodulation.

Crosstalk

Crosstalk is an undesired signal disturbance introduced in a transmissio
circuit by mutual electronic or magnetic coupling with other transmission
circuits.

Current Probe

A current probe is the transducer used for most military-conducted
emissions tests. It measures the magnetic field produced by current in w
when clamped around the wire. Output voltage of a current probe is
proportional to the current level, frequency, and probe characteristics.
Transfer impedance of a probe must be known to calculate the current le
in a wire.

I(dBµA) = V(dBµV) - Z(dBohm)

Continuous Wave (CW)

A continuous wave signal is an electromagnetic wave that varies sinusoid
in amplitude and remains constant in frequency.
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Decibel (dB)

A decibel is a unit used as a measure of the ration of two power levels:

or, assuming that measured values of electric potential or current have th
same impedance:

Decoupling Network

A decoupling network is an electrical circuit for preventing test-signals
which are applied to the EUT from affecting other devices, equipment, or
systems that are not under test. IEC 801-6 states that the coupling and
decoupling network systems can be integrated in one box (commonly ca
direct injection) or they can be in separate networks (commonly called
clamp injection).

Degradation

Degradation is an unwanted change in the operational performance of a
EUT. This does not necessarily mean malfunction or catastrophic failure
The EMC test specification generally requires stating the criteria for
degradation of performance.

Demod

The Demod function is used to demodulate signals to assist in acoustica
identify signals such as ambient or EUT-generated (the demodulated sig
may be heard through the receiver’s speaker).

Dipole

1. An antenna consisting of a straight conductor (usually not more than
half-wavelength long), divided at its electrical center for connection to
transmission line.

2. Any one of a class of antennas producing a radiation pattern
approximating that of an elementary electric dipole.

Note: Common usage considers the dipole antenna to be a metal radiati
structure which supports a line current distribution similar to that of a thin
straight wire so energized that the current has a node only at each end.

Dwell Time

The dwell time setting is the amount of time the receiver will spend either
sweeping each segment or measuring each list signal. Dwell time can be
increased to capture intermittent or slow cycle signals (minimum dwell tim
is a function of frequency span and RBW).

dB 10
W1
W2
---------log⋅=

dB 20
V1
V2
-------log⋅ 20

A1
A2
-------log⋅= =
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Dynamic Range

Dynamic range is the maximum power ratio of two signals simultaneousl
present at the input that may be measured within the limits of specified
accuracy, sensitivity, and distortion: >70 dB.

Electromagnetic Compatibility (EMC)

1. Electromagnetic capability is the ability of electronic equipment or
systems to operate in, and not overly contribute to, and environment
electromagnetic radiation.

2. EMC is the ability of equipment to function satisfactorily in its
electromagnetic environment without introducing intolerable
disturbances into that environment or into other equipment.

3. The capability of electronic equipment or systems to be operated in t
intended operational electromagnetic environment at designed levels
efficiency.

Electromagnetic Interference

Electromagnetic interference is the electromagnetic energy emanating fr
one device which causes another device to have degraded performance

Electromagnetic Wave

An electromagnetic wave is the radiant energy produced by the oscillation
an electric charge characterized by oscillation of the electric and magnet
fields.

EMC

See Electromagnetic Compatibility.

Emission

Emission is the electromagnetic energy propagated from a source by
radiation or conduction.

Equipment

Equipment is any electrical, electronic, electromechanical device, or
collection of items, intended to operate as an individual unit and perform
singular function. As used herein, equipment includes, but is not limited
the following: receivers, preamplifiers, transducers, LISNs, cables, and o
test devices.

ETSI

European Telecommunications Standards Institute.
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EUT

Equipment Under Test. The device, equipment, subsystem, or system to
tested for EMI compliance. For example, a computer system including
monitor.

External Attenuation

External attenuation is an attenuator that is located outside of the receive
before the receiver’s input.

External Installation

External installation is an equipment location on a platform which is
exposed to the external electromagnetic environment, such as an aircraf
cockpit which does not use electrically conductive treatments on the can
or windscreen.

Far Field

1. Far field is the region where |E| and H are inversely proportional to r,
distance from the source.

2. That region of the field of an antenna where the angular field distributi
is essentially independent of the distance from the antenna region.

Field Strength

The term “field strength” shall be applied only to measurements made in
“far field”. The measurement may be the magnitude of either the electric
the magnetic component of the field, and may be expressed as V/m, A/m
W/m: any one of these may be converted to the others.

Flight-line Equipment

Flight-line equipment is any support equipment that is attached to or use
next to an aircraft during pre-flight or post-flight operations, such as
uploading or downloading data, maintenance diagnostics, or equipment
functional testing.

Frequency/Amplitude Pair

Frequency and amplitude pairs are typically formatted as tabular or list d
The amplitude and associated frequency comprise the amplitude/freque
pair. For example, 10 dµV/m 30 MHz = an amplitude of 10 dµV/m at the
30 MHz frequency point.
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GPIB

General Purpose Interface Bus is a general name for the communication
interface system defined in the ANSI/IEEE Standard 488.1-1987 and
ANSI/IEEE Standard 488.2-1987. See HP-IB.

Ground Plane

A ground plane is a conducting surface or plate used as a common refer
point for circuit returns and electric or signal potentials.

Harmonic Distortion

Harmonic distortion occurs when the input signal is of sufficient amplitud
to drive the mixer into non-linear operation. When this occurs, harmonics
the input signals may be generated in the mixer. These harmonics are ca
harmonic distortion.

Harmonic Mixing

Harmonic mixing is a technique that extends the frequency range of the
receiver. A response is displayed when the input signal satisfies the
following equation:

Fin = nFLO ± FIF

where

Fin is frequency of input signal,

FLO is frequency of the receiver local oscillator

n is the harmonic number of the receiver local oscillator

HP-IB

HP-IB is an acronym for the Hewlett-Packard Interface Bus
(Hewlett-Packard’s implementation of GPIB). It supports IEEE-488 and
IEC-645, which are worldwide standards for instrument interfaces. The
HP-IB is accessed at the rear panel of the computer and all HP-IB contro
peripherals (printer, plotter, receiver, and so on). See GPIB.

IF Feedthrough

Since the spectrum analyzer is a heterodyne receiver, a signal equal in
frequency to the first IF lifts the entire display baseline, regardless of the
frequency control settings. This phenomenon is known as IF feedthrough
Lifting the baseline obscures the display and may completely submerge
other signals present. Thus, to eliminate any gap in the spectrum analyz
frequency coverage, an alternate IF must be available and the two IFs m
not be harmonically related. A preselector also eliminates IF feedthrough
HP E7415A Measurement Guide -9



Glossary

d

e

,
e

um
.

ion
ratio
Image Responses

An image responses is a false response which appears at 2 * Fif above or
below the applied signal. This can occur for any IF within the receiver.

Immunity

1. Immunity is the ability of a receiver or any other equipment or system
enabling it to tolerate electromagnetic energy.

2. The ability of electronic equipment to withstand radiated or conducte
electromagnetic energy without exhibiting performance degradation.

Impedance

Impedance is the nominal input impedance of the spectrum analyzer. 50Ω 
and 75Ω are most widely used.

Impulse

1. Impulse is an electrical pulse of short duration relative to a cycle at th
highest frequency being considered.

2. Mathematically, it is a pulse of infinite amplitude, infinitesimal duration
and finite area. Its spectral energy density is proportional to its volt tim
area, and is uniformly and continuously distributed through the spectr
up to the highest frequency at which it may be considered an impulse
Regularly repeated impulses of uniform level will generate a uniform
spectrum of discrete frequencies (Fourier components) separated in
frequency by an amount equal to the repetition frequency.

Impulse Bandwidth (BWi)

The impulse bandwidth (BWi) of a filter is the bandwidth of a rectangular
filter having the same peak-voltage response as the filter in question.
Impulse bandwidth (BWi) = 1.6 times resolution bandwidth (BW3dB).

Impulse Emission

An impulse emission is that produced by impulses having a repetition
frequency not exceeding the impulse bandwidth of the receiver in use.

Insertion Loss

Insertion loss is the reduction in power which occurs at the load on insert
of a network between the source and load. It is generally expressed as a
in dB.

Interconnecting Leads

Interconnecting leads are control and signal lines which interface with
equipment or subsystems not being supplied under the same contract.
-10 HP E7415A Measurement Guide
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Control leads use AC or DC power for control of such devices as relays,
solenoids, valves, machinery control sensors, and synchros; whereas si
leads send or receive such signals as clock, IF, RF, audio, and digital.

Interference Emission

Interference emission is any undesirable electromagnetic emission.

Intermodulation (IM) Distortion

Intermodulation (IM) distortion occurs when two strong and closely-spaced
signals are fed into the receiver input mixer. The two signals drive the mi
into non-linear operation. This causes the two signals to interact and prod
several mixing products. For example, if two signals,f1 andf2 are fed into
the input mixer, then 2f1 ± f2 ,2f2 ± f1,2(f1 ± f2), 3(f1 ± f2), and so on, are
some of the intermodulation distortion products that may be seen on the
display. 2f1 - f2 and2f2 - f1 are called third order IM products and are the
most critical distortion products. They are the most critical because they
located close to
f1 andf2; the rest of the IM products are farther from the spectrum of intere

Internal Attenuation

Internal attenuation is the attenuator inside the receiver. See External
Attenuation.

Internal Installation

Internal installation is an equipment location on a platform which is totall
inside an electrically conductive structure, such as a typical avionics bay
an aluminum skin aircraft.

Interpolation

Interpolation is the method by which values for frequency and amplitude
approximated between frequency/amplitude pairs. Interpolation may be
done on a log or linear scale.

Limit (Line) Margin

Limit line margin is the confidence interval for EUT emissions
measurements relative to the applicable limit (denoted as negative dB).

Limit Line

A limit line is the line on the HP E7415A graph or the receiver display tha
represents the associated regulation limits.

LISN

Line Impedence Stabilization Network.
HP E7415A Measurement Guide -11
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Local

Local is the receiver state in which commands can be entered directly on
receiver panel.

Magnetic Field Strength

Magnetic field strength is the magnitude of the magnetic field, commonly
expressed in amperes per meter and notated as |H|.

Margin

See Limit (Line) Margin.

Monopole

A monopole antenna is an antenna consisting of a straight conductor (usu
not more than one-quarter wavelength long) mounted immediately above
and normal to, an imaging (ground) plane. It is connected to a transmiss
line at its base and behaves, with its image, like a dipole.

Narrowband Response

A narrowband response is displayed on an EMC receiver when the receiver
bandwidth is narrow enough to resolve the discrete frequency componen
the received signal. For example, since the individual spectral componen
a pulsed RF transmission are spaced at the pulse repetition frequency (PRF),
the receiver displays a narrowband response when its bandwidth is narro
than the PRF. (To be sure that all components are resolved, regardless o
their relative amplitudes, receiver bandwidth should be less than 0.3 time
the PRF.)

To check for narrowband response, vary the receiver bandwidth, span wi
or sweep time. The amplitude of a narrowband response should not cha
as the bandwidth is varied. Widening the span width decreases spacing
between spectral lines; sweep time changes do not affect spectral line
spacing. See Broadband Response.

Near Field

Near field is the region of the field of a source between the source and the
field region where the angular field distribution is dependent upon distan
from the source.

Non-critical Area

A non-critical area is the location in a ground installation where EMI will
not result in failure or abortion of a mission or degradation of the overall
system performance. Examples of areas which may be considered
non-critical are office buildings, recreational areas, laundry areas, food
servicing areas, drafting rooms, and woodworking shops.
-12 HP E7415A Measurement Guide
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Non-developmental Item

A non-developmental item is a broad, generic term that covers material
available from a wide variety of sources with little or no development effo
required by the Government.

Open Area Test Site (OATS)

An open area test site is a test site for radiated electromagnetic interfere
measurements which is an open flat terrain at a distance far enough awa
from buildings, electric lines, fences, trees, underground cables, and pip
lines so that effects due to such are negligible. This site should have a
sufficiently low level of ambient interference to permit testing to the require
limits. In IEEE documentation, this is referred to simply as the “test site”.
Refer to CISPR publications for OATS requirements.

Peak (Detector)

A peak detector detects the peak value of the signal (worst-case). The
receiver has an envelope detector in the IF chain that has a time constan
such that the voltage at the detector output follows the peak value of the
signal at all times.

Peak Excursion

Peak excursion is the criteria by which a trace peak is considered to be a
signal. The signal must rise and then fall by the peak excursion value to
considered a peak signal. Higher values lead to fewer signals being
discerned. Lower values lead to more signals being discerned. For exam
if the peak excursion is set too low, the peaks in the noise floor may be
discerned as signals and stored in the signal list. In contrast, if the peak
excursion is set too high, many legitimate peaks will not be discerned as
signals.

Polarization

Polarization is a term used to describe the orientation of the field vector o
radiated field.

Preamp

A preamplifier either internal or external to the receiver. A high gain, low
noise preamp will usually improve the receiver’s noise figure and increas
the dynamic range, especially when placed close to the antenna.

QPD

See Quasi-Peak Detector.
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Glossary

rate
hed

the

rom

rm

en
y

the

n
ase

cts
Quasi-Peak Detector

1. Quasi-peak detection is a weighted form of peak detection. During
quasi-peak detection, the displayed response drops as the repetition
of the measured signal decreases This signal weighting is accomplis
by circuitry with specific charge (1 millisecond) and discharge
(600 milliseconds) time constants.

2. The QPD is a way of measuring the “annoyance factor” of a signal.

Note: For continuous wave signals, the peak and quasi-peak values are
same.

Radiated Emission

A radiated emission is electromagnetic energy propagated into space.

Radiated Interference

Radio interference is undesired electromagnetic energy that is radiated f
any unit, antenna, cable, or interconnecting wiring. Compare to Radio
Frequency Interference (RFI).

Radiation

1. Radiation is the propagation of a signal or interference from a source
other than by conduction.

2. The emission of energy in the form of electromagnetic waves. The te
is also used to describe the radiated energy.

Radio Frequency Interference (RFI)

RFI is a high frequency interference with radio reception. This occurs wh
undesired electromagnetic oscillations find entrance to the high frequenc
input channel of a receiver or antenna system. These oscillations may be
received (along with the desired signal) by the antenna, and will degrade
reception of the desired signal. Compare to Radiated Interference.

Radio Interference Power

Radio interference power is the power measured on the conductor with a
absorbing clamp and a radio interference measuring receiver. As in the c
of radio interference voltage, it can be measured as a quasi-peak or
non-weighted quantity.

Receiver

A receiver is a measurement device, such as an EMC receiver, that dete
and measures electromagnetic energy levels.
-14 HP E7415A Measurement Guide
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Receiver Settings

Measurement settings within the receiver (can be set with the E7415A
application) that determine the frequency span, RBW, VBW, Ref Level,
Sweep Time, Attenuation, and so on. CISPR defines receiver settings to
while performing emission measurements.

Note: the E7415A application default receiver settings are as defined by
CISPR.

Remote

Remote is the receiver state in which commands can be entered through
application user interface. When in remote mode, the receiver is controll
by an external controller, such as a PC.

Repetition Rate

Repetition rate is the number of periodic switching and discharge proces
per time unit. The repetition rate can be measured, for example, at the
intermediate frequency (IF) output of the radio interference measuring
receiver by means of an oscilloscope.

Resolution Bandwidth (RBW)

Resolution bandwidth is the 3 dB bandwidth of the receiver IF stage. (CIS
specified bandwidths, that is, 200 Hz, 9 kHz, 120 kHz, and 1 MHz use a
dB bandwidth.) It is called the resolution bandwidth because two
closely-spaced equal amplitude signals are just resolved if they are sepa
by an amount equal to the receiver 3 dB bandwidth. For example, a final
bandwidth of 100 Hz just resolves two equal amplitude signals 100 Hz ap
However, if the two signals are less than 100 Hz apart, they are within the
bandwidth at the same time and, therefore, appear as one signal.

RFI - Click, Continuous, and Discontinuous

Click RFI (or disturbance) is short duration interference with a duration th
does not exceed a specified period. Click RFI is counted, measured, and
judged only if its amplitude is above the limits applicable for continuous
RFI. Continuous RFI is interference with a duration that exceeds a speci
period. In VDE 0875, continuous RFI is identified as an indicated value (f
example, meter reading) as observed on the RFI meter which does not
immediately decrease after reaching a maximum. Discontinuous RFI is
interference which is not continuous RFI. The meter reading decreases a
reaching a maximum.
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RFI Field Strength

RFI field strength is the field strength measured with an antenna and a ra
interference measuring receiver. As in the case of radio interference volta
it can be measured as a quasi-peak or non-weighted quantity.

RFI Sources

RFI sources are equipment and systems as well as their components wh
can cause RFI.

RFI Suppression

RFI suppression is the technique to reduce high frequency electromagne
oscillations of electrical equipment and systems which can cause RFI.

RFI Voltage

1. RFI voltage is the voltage measured across defined reference resista
(equivalent resistances) with a radio interference measuring receiver
can be measured as a weighted (quasi-peak) or non-weighted quant
The reference resistances (equivalent resistances) can be part of a p
mains network or a probe.

2. Weighted RFI voltage (quasi-peak) is the measured radio interferenc
voltage corresponding to the physiological impression of interference
(acoustic or visual).

Segment

The frequency range scanned during a Sweep operation is divided into
multiple segments when necessary. These segments are swept to ensur
proper frequency accuracy. See Segment Size.

Segment Overlap

The segment overlap is the percent overlap (% of frequency uncertainty)
between segments during the sweep process. This value specifies the
segment overlap as a % (percentage) of the receiver’s specified frequen
uncertainty. For example, segment overlap = 100% will provide segment
(span) overlap equal to 100% of the receiver’s specified frequency
uncertainty, or actually 1 to 3 % frequency overlap of adjacent segments
depending on the actual receiver. See Segment.

Segment Size

The segment size is the frequency span setting used by the receiver.
Typically, unless the sweep frequency range is narrow, the receiver will s
multiple segments during a Sweep operation. The trace displayed on the
graph is a composite of all the segments scanned during a Sweep.
-16 HP E7415A Measurement Guide



Glossary

e

for

rom

nts
e

ks
ng

eet

ath
s,

s
ected
If Auto Segment is selected, (under the Sweep, Frequency Range tab) th
number of segments is dependent on the receiver (number of points and
RBW) and the actual measurement frequency range. If Auto Segment is
disabled, the user can enter a segment size, which defines the maximum
frequency span used by the receiver during a sweep.

Shielded Room/Enclosure

A shielded room is a screened or solid metal housing designed expressly
the purpose of isolating the internal from the external electromagnetic
environment. The purpose is to prevent outside ambient electromagnetic
fields from causing performance degradation and to prevent emissions f
causing interference to outside activities.

Signal

A signal is a frequency point (with corresponding amplitude) that represe
a peak on the HP E7415A trace. For a peak to be considered a signal, th
peak excursion criteria must be met. See Peak Excursion.

Signal List

A signal list is a table of signals. Signals are generated from the Add Pea
to List process, or from the Add Data Point to List process, or from inserti
signals through the Insert Signals dialog box. Signal lists can be filtered,
sorted, and otherwise customized to display various signal attributes to m
specific requirements.

Signal Path

The signal path is the interconnected equipment that defines the signal p
from transducer to receiver. It may include transducers, limiters, preamp
cables, LISNs, receivers, and other devices. Corrections are included for
each device in the signal path to account for signal amplification and
attenuation with respect to frequency. Correction factors from the device
comprising the Signal Path are added to measured data to generate corr
measurement results during the Sweep and Measure processes.

Snapshot

A Snapshot is a method for generating a quick report showing the graph
traces and/or the signal list.

Source Electromotive Force (EMF)

1. Twice the voltage of the matched output value (IEEE).

2. The voltage of the terminals of the ideal voltage source in the
representation of an active element (IEV).
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Stripline

A stripline is a parallel plate transmission line to generate an electromagn
field for testing purposes.

Subsystem

For the purpose of EMC equipment and techniques, the definition in one
the two subsections below shall be considered as a subsystem. In either
the devices or equipment may be physically separated when in operation
will be installed in fixed or mobile stations, vehicles, or systems.

a. A collection of equipment designed and integrated to function as
single entry, but wherein any device or equipment is not required
function as an individual equipment, as defined herein.

b. A collection of equipment and subsystems, as defined above,
designed and integrated to function as major subdivision of a syst
and to perform an operational function, or functions, therein.

Susceptibility

Susceptibility is the characteristic of electronic equipment that permits
undesirable responses when subjected to electromagnetic energy.

Sweep

1. The sweep function sets up the receiver to sweep the frequency rang
in the sweep dialog box. The sweep function creates a single
(composite) trace on the HP E7415A graph comprised of multiple
receiver spans, that is, the frequency range is segmented, and each
segment is swept in turn by the receiver.

2. A sweep performed by the receiver over the frequency span set on th
receiver.

System

A system is comprised of equipment, subsystems, skills, and techniques
capable of performing or supporting an operational role. A complete syst
includes related facilities, equipment, subsystems, materials, services, a
personnel required for its operation to the degree that it can be considere
self-sufficient within its operational or support environment. EMC
requirements for “systems” are normally included in such documents.

Test Generator

A generator (RF-generator, modulation source, attenuators, broadband
power amplifier and filters) capable of generating the required signal.
-18 HP E7415A Measurement Guide
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Trace

1. A trace is the graphical representation of one or more receiver sweep
the HP E7415A. Also see Sweep.

2. The sweep trace displayed on the receiver created from a single rece
sweep or continuous sweeps.

Transducer

A transducer is a device used to emit radio frequency energy into space f
a signal source or intercept an arriving electromagnetic field, converting
into an electrical signal. In EMC applications, a transducer is typically an
antenna or field probe for radiated measurements, or a current probe or
LISN for conducted measurements.

Transfer Impedance

Transfer impedance is the magnitude of the current sensed by a current
probe divided by the voltage across the output terminals of the probe (wh
properly terminated). Commonly express in decibels referenced to one o
(dbohm):

Zt = V – I

where

Zt is transfer impedance (dBohm)

V is magnitude of voltage across probe (dBµV)

I is magnitude of current measured (dBµA)

Tune

With the Tune box checked (within the Receiver bar):

1. The receiver is set to center frequency equal to the selected list sign
The frequency span sets to the frequency uncertainty unless otherwi
set in the options dialog box (Tools > Options ; selectFixed Span: ).

2. The receiver is set to the span of the zoom graph as the zoom region
selected.

Tune and Listen

Tune and Listen is the process of tuning to a signal, demodulating the sig
then listening to the demodulated signal to acoustically determine if the
signal is an ambient, such as a radio station, or noise generated by the E

VCCI

Japanese Voluntary Control Council for Interference by Information
Technology Equipment.
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Video Bandwidth (VBW)

The video bandwidth determines the amount of video filtering. See Video
Filter.

Video Filter

A video filter is a post-detection averaging device which averages the no
present in the receiver. A noise averaging filter is a low-pass filter whose
bandwidth should be much narrower than the resolution bandwidth of the
receiver. However, since the video filter is located after the IF bandwidth,
does not affect frequency resolution.

In some measurements, like AM, FM, and pulse RF demodulation, the vid
filter bandwidth should be equal to or greater than the IF bandwidth to pa
the demodulated waveform without distortion.

Zoom Graph

The zoom graph is a region of the graph that, when created, is displayed
below the graph. The zoom graph displays the zoom region with greater
resolution. The start/stop frequencies of the zoom graph are selected with
mouse (click and drag within the graph area), and are denoted in the gra
with vertical lines.

The zoom graph displays the actual uncompressed data as taken with th
receiver. The original frequency resolution is retained.
-20 HP E7415A Measurement Guide
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Introduction

In this chapter the regulations that govern EMC emissions, and theref
your product design, will be discussed.

Regulations are one of the primary (though not the only) reasons why
products are tested for EMC emissions. In many cases, it is simply a
requirement imposed by a government law or contract. Compliance to
local EMC regulations often are required by other nations to whom yo
may wish to export your products. Failing to comply with these
requirements can result in forced removal of a product from the
marketplace, confiscation of non-compliant equipment, monetary fine
and, in extreme cases, imprisonment.

Even at the precompliance level of testing, you need to be aware of th
types of regulations to which your product must conform so that your
design reflects the appropriate EMC emissions levels when you are re
to have the final compliance testing performed.

You can find a list of all current EMC regulatory standards at:

http://europa.eu.int/comm/dg03/directs/dg3b/newapproa/eurstd/harmstds/reflist/emc.
html.
A-2 HP E7415A Measurement Guide



Determining your Regulation Requirements
What Products are Covered?

d

What Products are Covered?

EMC regulations cover the entire spectrum of electrical products, from
computing equipment to microwave ovens to aircraft. As shown in the
following figure, the frequency ranges of interest for EMC testing exten
from dc to over 40 GHz, depending on the agency and the type of
measurement.

While individual EMC requirements vary widely from one another, one
common aspect is the goal of achieving valid, repeatable results.
Therefore, most regulations specify the test environment, receiver
characteristics, and transducer characteristics. In the case of radiated
emissions, antenna height and polarization are usually varied, and the
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equipment under test (EUT) is rotated to find the maximum response fro
the device. The EUT is normally exercised in a way that represents its
typical usage, and interconnect cables, if they are present, are oriented t
maximize emissions. All these actions help insure that the worst-case
emissions are found.

Table 1-1 provides an overview of some common emission regulations a
what products they cover

Table 1-2 provides the commensurate European standards.

Table 1-1 Industrial emissions regulations summary and comparison

CISPR FCC EN's Description

11 Part 18 EN 55011 Industrial, scientific, and medical

12 (SAE) ------ Automotives

13 Part 15 EN 55013 Broadcast, receivers

14 ------ EN 55014 Household appliances/tools

15 ------ EN 55015 Fluorescent lights/luminaries

16 ------ ------ Measurement apparatus/methods

22 Part 15 EN 55022 Information technology equipment

------ ------ EN 500081-1,2 Generic, emissions standards

Table 1-2 European Norms

Equipment Type Regulation

Generic Equipment

• Residential

• Light Industrial

EN 50081-1

Industrial EN 50081-2

Information Technology Equipment (ITE)· EN 55022

Industrial, Scientific Medical Products (ISM)                       EN 55011
A-4 HP E7415A Measurement Guide
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To assist you in keeping current with the changing regulations, below are
some regulatory agency and EMC information web sites:

FCC: http://www/fcc.gov

IEC: http://www.iec.ch

ANSI: http://www.ansi.org/docs/home.html

IEEE EMC Society: http://www.emclab.umr.edu/ieee_emc

ITU: http://www.itu.ch

ETSI: http://www.etsi.fr

VCCI: http://www1a.meshnet.or.jp/vcci
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What to Consider when Choosing a Standard

Before measurements can be performed on a product, some preliminary
questions must be answered.

• Where will the product be sold (that is, United States, Japan, Europe
and so on)?

• What is the classification of the product (that is, information technolog
equipment (ITE) devices; industrial, scientific, medical (ISM) devices
automotive or communications)?

• What is the use environment for the product (that is, home, commerc
light industry or heavy industry)?

With the answers to the above questions, you can determine which testin
requirements apply to your product. For example, if you have determined
that your product is an information technology (ITE) device and you will se
it in the U.S. then you need to test the product to FCC part 15 regulation
The tables below may be useful to help you choose the appropriate
requirement(s) for your product. Contact the appropriate agency for final
confirmation of the applicable requirements.
A-6 HP E7415A Measurement Guide
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European Norms Detailed Description

EN55011 (CISPR 11) Industrial, Scientific, and Medical Products 

• Class A: Used in establishments other than domestic areas.

• Class B: Suitable for use in domestic establishments.

Group 1, Laboratory, medical, and scientific equipment. (For Example,
signal generators, measuring receivers, frequency counters, spectrum
analyzers, switching mode power supplies, weighing machines, and
electronic microscopes.)

Group 2, Industrial induction heating equipment, dielectric heating
equipment, industrial microwave heating equipment, domestic microwav
ovens, medical apparatus, spark erosion equipment and spot welders. (F
example, metal melting, billet heating, component heating, soldering and
brazing, wood gluing, plastic welding, food processing, food thawing, pap
drying, and microwave therapy equipment.)

EN55014 (CISPR 14) Electric motor-operated and thermal appliances for household and simila
purposes, electric tools, and electric apparatus. Depending on the powe
rating of the item being tested, use one of the following limits.

NOTE The conducted range is 150 kHz to 30 MHz and the radiated range is 30
MHz to 1 GHz.

EN55022 (CISPR 22) Information Technology Equipment

Equipment with the primary function of data entry, storage, displaying,
retrieval, transmission, processing, switching, or controlling. (For examp
data processing equipment, office machines electronic business equipm
and telecommunications equipment.)

Class A ITE: Not intended for domestic use.
Class B ITE: Intended for domestic use.

Household and similar appliances (conducted) EN014-HL

Household and similar appliances (radiated) EN014-HH

Motors <700Watts (conducted) EN14-P1

Motors <700Watts (radiated) EN14-P4

Motors <1000Watts (conducted) EN14-P2

Motors <1000Watts (radiated) EN14-P5

Motors >1000Watts (conducted) EN14-P3

Motors >1000Watts (radiated) EN14-P6
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US (FCC) Norms Detailed Description

FCC Part 15 Radio frequency devices - unintentional radiators (For example, TV
broadcast receivers, FM broadcast receivers, CB receivers, scanning
receivers, TV interface device, cable system terminal device, Class B
personal computers and peripherals, Class B digital devices, Class A dig
devices and peripherals, external switching power supplies.)

Class A digital devices are marketed for use in a commercial industrial, o
business environment.

Class B digital devices are marketed for use in a residential environment

One of the most important standards setting organizations for commerci
EMC standards is CISPR. It is an international group with members from
many different countries which develops recommended EMC test limits a
test procedures. CISPR has no regulatory authority of its own. It is up to
regulatory agencies of each country to adopt their own EMC requiremen
However, most countries use the CISPR standards, perhaps with some
modifications, as the basis for their own national regulations.

Because most countries use CISPR standards as the basis for their own
regulations, you can often find correlation between the myriad of
regulations. The list below shows the various Federal Communications
Commission (FCC) in the US and European EuroNorms (EN's) and their
relation to the CISPR standards.

Table 1-3 FCC (Federal Communications Commission)

Equipment Type Regulation

Broadcast receivers Part 15

Household appliances/tools

Fluorescent lights/luminaries

Information Technology Equipment (ITE)

Industrial, Scientific, Medical Products (ISM) Part 18

Conducted measurements: 450 kHz to 30 MHz

Radiated measurements: 30 MHz -1000 MHz, 
40 GHz
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• CEN - European Committee for Standardization
• CENELEC - European Committee for Electrotechnical Standardizati
• ISO - International Standards Organization
• IEC - International Electrotechnical Commission
• CISPR - International Special Committee on Radio Interference
• EU - European Union (formerly European Community)
• EFTA - European Free Trade Association
• EEA - European Economic Association (from 1 Jan. 94)

Some History and Background

Role of European
Norms

One of the results of the formation of the European Union (EU) has been
develop a common set of EMC requirements. These are collectively kno
as the EuroNorms (EN's). By having one common set of standards, good
can flow freely from one country to another. Countries of the European F
Trade Association (EFTA) will likely adopt these same EMC standards.

Therefore, products which pass the EN requirements will haveaccess to a
huge, unified market.

Starting January 1, 1996, the older country specific EMC requirements w
dropped completely and all products must fulfill the EMC Directive
requirements. The easiest and most common way to show fulfillment of t
directive is compliance with the new EMC EuroNorms.

The European Norms are quite encompassing, and apply to nearly all ty
of electronic equipment. You must first determine if there is a product
specific category for the product. If there is not a product specific catego
the product must be tested to the generic requirement for the environme
is to be used in.

FCC Regulations The FCC part 15 and part 18 regulations cover a variety of products. Par
classifies products in three general categories - intentional, incidental, an
unintentional radiators. Information technology equipment, which include
computers, is an example of an unintentional radiator. Unintentional
radiators fall in two further subcategories - Class A devices intended for
commercial, industrial, or business use, and Class B devices intended fo
residential environments.
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For intentional radiators, such as wireless communications devices or fie
disturbance sensors, the FCC requires you to test to the 10th harmonic o
GHz, whichever is lower.

As advances in digital technology push clock frequencies higher and hig
the potential for undesirable emissions at higher frequencies increases.
this reason, the FCC now requires testing to 2 GHz if the highest frequen
generated or used in an EUT is in the 108 to 500 MHz range and up to 5
GHz if the device generates or uses signals in the 500 to 1000 MHz rang

A product must pass the applicable FCC EMI requirements to be legally s
in the United States. To achieve this certification, EMI test data must be
submitted to the FCC. Upon approval of the application, the manufacture
must place an identification label on the equipment and a notice in the
operating manual stating that the product meets the FCC requirements.

On August 31, 1993 the FCC issued a report number DC-2484 which
represents a significant step toward the harmonization of EMC Standard
This document allows manufacturers to use the limits contained in CISP
Publications 22 as an alternative to those in Part 15 of the FCC rules wh
testing digital devices for compliance.

The FCC has deregulated the filing requirement for personal computers
their peripherals in order to allow manufacturers to meet market
requirements. Testing must still be performed but the certification, filing,
and review process is omitted. The person placing the product on the ma
can self-declare. This was docket No. 95, FCC 96-208, 14 May 1996.

EMC testing must still be performed and the testing should be performed
an accredited test lab as defined by the FCC. At this time, the authorized
organizations for accrediting labs are the National Voluntary Accreditation
Program (NVLAP) or the American Association for Laboratory
Accreditation (A2LA).

Note that testing of the CPU boards and power supplies is now required.
However, mandatory compliance and labeling has been delayed to 19 Ju
1997. A statement verifying compliance must be in literature provided wi
the product.

Personal computers constructed using modular components (separately
authorized) must be authorized under the D of C process.

Some classes of products are specifically exempted from FCC part 15 ru
However, it is important to remember that even though these products m
not need to pass a government requirement, they usually need good EM
performance to operate properly in their intended environment. An EMC
malfunction in a car, a medical device, or an industrial process control
device could be dangerous or even life-threatening. For this reason, man
products are tested for EMC whether a regulation exists for it or not.
A-10 HP E7415A Measurement Guide
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The first EMI requirements were effective for new products placed on the
AS/NZ market 1 Jan 1997. The requirements will be mandatory for all
products (old and new) starting 1 Jan 1999.
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